
Instruction Manual

Video Display

•	Before use, be sure to read this guide, including the 
safety and handling precautions.

•	Reading this guide will help you learn to use the video 
display properly.

•	Store this guide safely so that you can use it in the future. English



2 Table of Content

Table of Content

Introduction................................................................................................................................... 4
About this manual..................................................................................................................................... 4

Trademarks............................................................................................................................................... 4

Supplied Accessories................................................................................................................................ 4

Important Usage Instructions........................................................................................................ 5

Safety Instructions and Handling Precautions.............................................................................. 6

Features....................................................................................................................................... 11

Nomenclature.............................................................................................................................. 12

Installation/Connection............................................................................................................... 15
How to Carry the Main Unit..................................................................................................................... 15

Procedures to attach the protection panel............................................................................................... 15

Procedures to attach/detach stands........................................................................................................ 16

Preventing from Tipping.......................................................................................................................... 17

Mounting the Main Unit on a Stand or Wall.............................................................................................. 18

Connecting the Main Unit to Input Devices.............................................................................................. 19

Turning on the Power.................................................................................................................. 21
Turning on the Power of the Main Unit..................................................................................................... 21

Installing the AC power cord clamp HC-01 (Included).............................................................................. 21

Operating the Video Display........................................................................................................ 22
Operating the jog dial.............................................................................................................................. 22

Basic operations to use the OSD menu................................................................................................... 22

Adjusting Image Quality While Viewing the Entire Image.......................................................................... 24

Temporarily Saving Parameters (Anchor Point Setting)............................................................................. 25

Enlarging the display (Zoom function)...................................................................................................... 25

Changing Image Quality Automatically According to Input Signal............................................................. 26

Adjust image quality on left/right side of screen (image comparison mode).............................................. 27

Calibration without a PC.......................................................................................................................... 27

Export/Import.......................................................................................................................................... 29

Set Date/Time......................................................................................................................................... 31

Inputting Characters................................................................................................................................ 32

Using the Function (F) Buttons................................................................................................................ 33

Using the Channel (CH) Button................................................................................................................ 33

Checking Signal Information and Status of the Main Unit......................................................................... 35

Operating the video display using an external device [LAN terminal]........................................................ 35

Operating the video display using an external device [USB terminal: Wi-Fi connection]............................ 36

Use a web browser to remotely operate the video display....................................................................... 38



3Table of Content

OSD Menu................................................................................................................................... 41
OSD Menu Index..................................................................................................................................... 41

Adjustment.............................................................................................................................................. 49

Channel Settings..................................................................................................................................... 64

Display Settings....................................................................................................................................... 71

Audio Settings......................................................................................................................................... 75

Marker Settings....................................................................................................................................... 76

Function Settings.................................................................................................................................... 81

Picture Function Settings......................................................................................................................... 94

Network/IMD Settings............................................................................................................................. 99

System Settings.................................................................................................................................... 101

Signal Information.................................................................................................................................. 108

System Information............................................................................................................................... 108

Main specifications/Performance.............................................................................................. 109
Dimensions........................................................................................................................................... 111

Appendix................................................................................................................................... 112
Supported Signal Format...................................................................................................................... 112

Image/Frame Display............................................................................................................................. 127

Error Messages......................................................................................................................... 130

Troubleshooting......................................................................................................................... 133

Software Used in This Product.................................................................................................. 135

Index.......................................................................................................................................... 140



4 Introduction

Introduction
Thank you for purchasing the Video Display DP-V2420 / DP-V2421.
The On Screen Display (thereafter referred to OSD) default language setting is English. To change the OSD menu 
language setting, please refer to p. 101.

About this manual

The illustrations used in this document are for the DP-V2420. Some of the illustrations used in the manual have been 
simplified for clarity.

Conventions used in this manual

: Indicates a reference page.
 Note: Indicates a note.
 Reference: Indicates reference information.
 CAUTION: Indicates an item you must observe.

Trademarks

•	 HDMI, HDMI logo, and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI 
Licensing Administrator, Inc. in the U.S. and other countries.

•	 VESA is a registered trademark or trademark of Video Electronics Standards Association in the U.S. and other 
countries.

•	 Wi-Fi, WPA, and WPA2 are registered trademarks of the Wi-Fi Alliance.

•	 Apple and Safari are trademarks of Apple Inc. registered in the United States and other countries.

•	 Google and Google Chrome are trademarks or registered trademarks of Google LLC.

•	 Other product and company names herein are trademarks or registered trademarks of their respective owners.

Supplied Accessories

The following items are supplied with this product. Please check before using.

AC Power Cord HT-21 AC Power Cord clamp
HC-01

Instruction Manual	
(this document)
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Important Usage Instructions
For the customers in the U.S.A.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of 
the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes 
or modifications should be made, you could be required to stop operation of the equipment.
Use of shielded cable is required to comply with class A limits in Subpart B of Part 15 of FCC Rules.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including interference 
that may cause undesired operation.

Canon U.S.A Inc. 
One Canon Park, Melville, NY 11747, U.S.A.
Tel No. (631)330-5000

For the customers in Canada
CAN ICES-3 (A) / NMB-3 (A)

For the customers in Europe
Warning;
This is a class A product. In a domestic environment this product may cause radio interference in which case the user 
may be required to take adequate measures.

CANON INC.
30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan

CANON EUROPA N.V.
Bovenkerkerweg 59, 1185 XB Amstelveen, The Netherlands

Only for European Union and EEA (Norway, Iceland and Liechtenstein)
This symbol indicates that this product is not to be disposed of with your household waste, 
according to the WEEE Directive (2012/19/EU) and national legislation. This product should 
be handed over to a designated collection point, e.g., on an authorized one-for-one basis 
when you buy a new similar product or to an authorized collection site for recycling waste 
electrical and electronic equipment (EEE). Improper handling of this type of waste could have 
a possible negative impact on the environment and human health due to potentially hazardous 
substances that are generally associated with EEE. At the same time, your cooperation in the 
correct disposal of this product will contribute to the effective usage of natural resources. For 
more information about where you can drop off your waste equipment for recycling, please 
contact your local city office, waste authority, approved WEEE scheme or your household waste 
disposal service. For more information regarding return and recycling of WEEE products, please 
visit 
www.canon-europe.com/weee.
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Safety Instructions and Handling Precautions
Be sure to read these instructions in order to operate the product safely.
Follow these instructions to prevent injury or harm to the operator of the product or others.

 WARNING
Denotes the risk of serious injury or death.

•	Do not disassemble or modify the video display.
Inside, the video display contains high-voltage/extremely hot/movable parts that can cause fire, electric shock, burns or 
injury.

•	Do not insert foreign objects or liquids into the video display.
If metallic objects, flammable objects or liquids get inside the video display, this may cause fire, electric shock or 
malfunction.

•	Be sure to use the correct voltage.
Using a power source with a voltage other than that specified in this instruction manual can cause fire or electric shock.	
Always use the supplied (or specified) AC power cord. For your safety, do not use this AC power cord to power other 
equipment.

•	Do not use the video display in the following places. 
Doing so can cause fire, electric shock or malfunction.
-- Next to a window when it is raining or snowing. 
-- Places subject to high humidity and dusty places.
-- Places exposed to water drops or moisture such as bathrooms or watering places.
-- Places directly exposed to soot, smoke or steam, or nearby heaters and humidifiers.
-- Places where flammable gases may be present.
-- Places exposed to direct sunlight.

•	Do not install or store the video display in places exposed to direct sunlight. 
The video display's internal temperature can rise and cause fire or malfunction.

•	Do not damage the power cord.
Do not place heavy objects on the power cord and do not pull, modify, heat or tie the power cord in a bundle. The power 
cord may be damaged (exposed or broken wires, etc.) and cause fire or electric shock.

•	When using three-pronged plugs with a ground connection:
Always connect the ground prong. 
A short circuit occurring when the ground prong is not connected can cause fire or electric shock.
The video display's power cable features a three-pronged plug.

•	Do not touch the power cable or plug during lightning storms. 
This can cause electric shock.

•	Do not touch the power cable or plug with wet hands. 
This can cause electric shock.
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•	Observe the following precautions regarding the power source and power plug. 
Failing to do so can cause fire or electric shock.
-- Insert the power plug fully and securely into the power outlet. Do not use a damaged power cable or plug or a 
loose power outlet.
-- Hold the plug itself when unplugging the power cable. Pulling the power cord can damage the power cord and 
cause fire or electric shock.
-- Periodically remove any dust buildup from the power plug.
-- Do not obstruct the access to the power plug by placing other objects around it.
-- Do not connect many power cords to the same power outlet.
-- When using an extension cable, make sure the total power consumption of the devices you connect to the 
extension cable does not exceed its rated power.

•	If the video display was dropped or exposed to a strong impact, turn it off immediately and unplug the power 
plug from the power outlet.
The video display is a precision instrument and continued use in such case can result in a short circuit and cause fire or 
electric shock.

•	Before starting any maintenance work, turn off the video display and unplug the power plug from the power 
outlet. 
Failing to do so can cause electric shock.

•	Before moving, installing, removing or connecting the video display to peripheral devices, turn off the video 
display and all connected devices and unplug their power plugs from the power outlet. 
Failing to do so can cause fire, electric shock or malfunction.

•	In any case of unusual circumstances such as the presence of smoke or strange sounds or smell, turn off 
immediately the video display and unplug the power plug from the power outlet. 
Continued use can cause fire or electric shock.

•	Do not obstruct the access to the power plug so it can always be easily unplugged. 
Failing to disconnect the power plug immediately after unusual circumstances have occurred can cause fire or electric 
shock.

•	Do not block the ventilation holes.
Blocking the video display's vent holes can result in the internal temperature rising and cause fire or malfunction. Observe 
the following precautions to ensure proper ventilation.
-- Do not push the video display into narrow confined spaces or enclosures.
-- Do not wrap the video display in cloth or other materials.
-- Do not place the video display facing up, lay it sideways or upside-down.

•	For your safety, unplug the power plug from the power outlet when not using the video display for extended 
periods of time.
Dust buildup on the power plug can cause fire.

•	If the screen is damaged, do not touch the leaking liquid crystal or other internal liquids.
If the LCD panel is damaged and liquid crystal or other internal liquids leak out, do not put the liquids in the mouth, inhale 
or swallow it or let it come in contact with the skin. If the liquids get in the eye or mouth, wash it immediately with plenty 
of water. If the liquids come in contact with the skin or clothes, wipe them immediately with alcohol etc. and wash the 
exposed area with soap. Leaving the liquids untreated can cause injury or damage.

•	Keep all packaging material out of the reach of children.
Packaging material tightly wrapped around someone's head can result in strangulation or suffocation.
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 CAUTION
Denotes the risk of injury.

•	Do not place any objects on the video display and do not climb on it.
The video display can tip or fall and cause injury.

•	Do not install the video display on an unstable surface.
Installing the video display on a wobbly or slanted surface can cause the display to tip or fall and cause injury. Thoroughly 
check also the strength and sturdiness of the surface where the video display will be placed or installed.

•	Take precautions to prevent the video display from tipping or falling.
In an earthquake the video display can tip or fall. For your safety, when installing the video display on a TV stand or other 
furniture, take precautionary measures to secure the video display against tipping or falling ( 17). Taking such measures 
can be effective in reducing the risk of injury or damage but the effectiveness of the prevention measures cannot be 
guaranteed in all earthquakes.

•	Always follow the specified procedure to install the video display ( 15).
If the installation is not performed correctly, the video display may tilt or fall and cause injury.

•	Inspect the condition of the installation about once per year.
An inadequate fitting or mounting can cause the video display to fall and cause injury.

•	When using headphones, set the volume at a safe level.
Listening through headphones at a high volume can harm your hearing.

•	Do not look at the screen for long periods of time.
Doing so can cause conditions such as eye strain or decreased vision. When looking at the screen for long periods of 
time, rest periodically. If you feel discomfort after continued usage, stop using the video display immediately and rest. If 
you continue to feel discomfort, consult a physician.
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When Using the Main Unit

•	 The screen may be damaged if it is left facing strong source of light. Please take precautions when placing it near 
a window.

•	 Do not press firmly on the screen, scratch it or place an object on the screen. It can cause non-uniformity or 
damage to the panel.

•	 The screen and cabinet may become warm during use. Note this does not constitute a malfunction.

•	 Depending on the environment where the video display is used, the internal temperature of the display may rise, 
resulting in becoming hot to touch. Please take care when handling the video display.

•	 Viewing the display for prolonged periods of time may lead to eye strain or decreased vision. Please ensure to take 
rest periodically to avoid these symptoms.

•	 Refer to Recommendation ITU-R BT.1702 "Guidance for the reduction of photosensitive epileptic seizures caused 
by television" and related guidelines.

About Backlight

The backlight has a limited service life so its brightness may degrade and color may change due to aging.

About Temporary Screen burn-in

If a stationary image is displayed for a prolonged period, screen burn-in may occur where you see remnants of what 
was displayed. This is a characteristic of LCD and is not a failure. However, this is only temporary and will disappear 
when playing video.

About the LCD screen

The screen is produced using extremely high-precision manufacturing techniques, with more than 99.99% of the pixels 
operating to specification. Less than 0.01% of the pixels may occasionally misfire or appear as black, red, blue or 
green dots. In addition, this tendency may increase through long term use due to characteristic of the LCD panel.
These do not constitute a malfunction.

Condensation

If this equipment is brought into a warm room while it is cold or if the room is heated suddenly, condensation may form 
on the surface or inside the equipment. Note that the equipment may be damaged if it is used under such condition. 
If condensation has formed on the surface or inside the equipment, do not use the video display as it may get 
damaged. Turn the power off and wait until the condensation has evaporated before using the video display.
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Cleaning

•	 Before cleaning, be sure to unplug the power plug from the wall outlet.

•	 The screen has a special surface treatment, avoid touching it directly with your hand. In addition, never affix 
adhesive objects such as seals.

•	 Never use alcohol or benzene, thinner, acidic cleaning solution, alkaline cleaning solution, abrasive or chemical 
wipes because these will damage the screen.

•	 If the screen is dirty, wipe gently with soft dry cloth such as cleaning cloth or eye glasses cleaning cloth. Wiping the 
screen too hard may cause unevenness on the screen or damage the LCD panel. The screen may be scratched if 
wiped too hard with a cleaning cloth with foreign particles attached.

•	 When the screen is extremely dirty, wipe with soft cloth such as cleaning cloth or eye glasses cleaning cloth 
moistened with water-diluted neutral detergent.

•	 Use a blower to remove dust from the surface of the screen.

•	 Wipe dirt on cabinet with a soft cloth. If the screen is very dirty, use a moistened cloth with water or mild detergent 
diluted with water. Do not use alcohol, benzene, paint thinner, or pesticides as they may damage the surface finish 
or erase characters on the cabinet.

Disposing

•	 Do not dispose together with normal waste. Do not include the video display in waste that will be taken to landfill.

•	 Observe the rules and regulations of your local authorities when disposing.
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Features
Video Display DP-V2420 / DP-V2421 is an HDR reference display capable of supporting various work flows from 
shooting through to editing in video production for both digital cinema and broadcasting.

Image quality and functions

•	  Supports 12G/6G-SDI.

•	 Equipped with a panel with 4096x2160 resolution and backlight system.

•	 High luminance and high contrast matched to HDR content is achieved.

•	 Equipped with the HDR display function. (SMPTE ST 2084 and Hybrid Log-Gamma are supported)

•	 High uniformity is provided by minimizing any variation due to temperature changes and aging. 

•	 Supports wide DCI-P3 color gamut.

•	 Displays ITU-R BT.2020 color gamut at the optimum level and supports "Constant Luminance".

•	 Supports ACESproxy.

•	 Equipped with functions to assist shooting and video checking, including Wave Form Monitor, Vector Scope, 
Screen Capture, Zoom, and False Color.

•	 Supports gamma equivalent to CRT standardized by ITU-R BT.1886.

•	 A color grading controller (Element-Tk made by Tangent Wave Ltd), external sensor, USB memory, or wireless LAN 
terminal (Wi-Fi adapter) can be connected to the USB port.

•	 Display Controller CL-01 (included with DP-V3010), external control devices, Canon displays, etc can be 
connected to the LAN terminal

•	 Supports "Square Division" and "2 Sample Interleave" video signal transport methods.

•	 Includes a multi-display function (4 or 2 screens)

•	 HDR and SDR content can be displayed for comparison.

•	 Equipped with a HDMI input terminal.

Link with digital cinema cameras

•	 Supports 4K RAW. Establishes 4K RAW workflow on ACES2065-1.

•	 CINEMA EOS SYSTEM link

•	 ARRI / Panasonic Camera System link

Rigidity and flexible installation

•	 High durability achieved by a metal outer covering.

•	 The side carrying handle on the main unit is convenient for installation and transporting. The handle and adjustable 
two position stand provides flexible installation and high portability.
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Nomenclature
■■ Front face of the main unit

3

1

2

1

2

4 5 6 7 8 9

Aq

1 Front stand There are two mounting positions. 16

2 Rear stand This can be detached. 16

3 Headphone terminal Connection for headphone set. 75

4 USB port Connection for an external sensor for calibration ( 27), USB memory, HUB, color 
grading controller (Element-Tk made by Tangent Wave Ltd), or wireless LAN adapter 
(Wi-Fi adapter, 36).

–

5 CH1 to 3 buttons Changes channel. 33

6 CDL button Switches between normal and CDL mode. –

7 F1 to F8 buttons Execute the defined function. You can assign different functions on F buttons in the 
normal and CDL modes respectively.

33

8 MENU button Opens/closes the OSD menu, or moves up one level in a menu. 22

Jog dial Moves the selection frame within the OSD menu, changes the settings (up/down, left/
right, rotation) and determines (press) the selection.

22

RESET button Resets the items to be adjusted using the slider and entered characters. 22

9  (Power) button Turns power On/Off. 21

Aq Power indicator Displays the status of the main unit. The brightness of the power indicator can be set 
from "Off" or "1 (dark) to 5 (brightest)" ( 103). Even when the power indicator is "Off", it 
will flash during firmware update, or when an error is detected.
Off: when power supply is not connected 
Green lit: when a power supply is connected and the power of the video display is on
Green flash: during calibration or firmware update
Amber lit: during standby (a power supply is connected and the power of the video 

display is off)
Amber flash: when error is detected

–
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■■ Back face of the main unit

AaAs Ag Ah AdAfAd Af

DP-V2421DP-V2420

Aa HDMI input terminal Used to input HDMI signals. 20

As LAN (10/100 BASE) 
terminal

Connection for Display Controller CL-01 (included with DP-V3010), external control 
devices, Canon displays, etc.

–

Ad SDI output terminal Pass through output corresponding to 3G/HD-SDI input terminal. –

Af SDI input terminal Used to input SDI signals. 19

Ag Cord clamp mounting 
hole

For installing the AC power cord clamp (Included) 21

Ah AC power input 
terminal

Connection for the provided AC power supply cord. 21

■■ Side face of the main unit

Aj

Right side Left side

Aj Carrying handle Used to install, connect, or carry the unit. 15
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CAUTION

•	 When connecting an external sensor for calibration to the USB port, the USB cable length must not exceed 3 m (9.8 ft.). 
Otherwise, communication error may occur and correct calibration may not be possible.

•	 The video display can perform measurement or calibration of the display using the DP-V Color Adjustment software. Refer 
to the Canon website for the DP-V Color Adjustment. 

•	  When the video display performs measurement or calibration of the display using the DP-V Color Adjustment or it 
is being used via LAN, "DP-V2420" will be displayed as the display name. 

•	 Do not use the HUB when connecting a wireless LAN adapter (Wi-Fi adapter) to a USB terminal. The video display may not 
work. 

•	 For safety, do not connect any connector that may have excessive voltage to the terminal of the video display when 
connecting peripheral devices.

•	 Pass through SD-SDI signals are not output correctly.

Note

•	 Both FAT16 and FAT32 USB memory devices are supported.

•	 Proper operation cannot be guaranteed for all USB memories.

•	 It may take 10 seconds or more for the USB memory to be recognized. If the function to save data on a USB memory is 
executed during recognition, the message "Detecting USB memory" is displayed.
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Installation/Connection
How to Carry the Main Unit

When lifting the video display, please use the carrying handles on the display’s sides.

CAUTION

•	 When unpacking, carrying, installing, or connecting the main unit, please note that at least two people are required.

•	 When carrying the video display, handle it carefully not to touch or damage the screen.

Procedures to attach the protection panel

You can attach the protection panel to protect the screen when carrying the video display or when using it outdoors.

1.	 Unscrew the four screws on the front face.
Use a 1.5 mm hexagonal key.
Do not lose the removed screws. Do not use these screws for other purposes.

2.	 Place the protection panel by aligning its corners with the screw holes.
Take care when attaching the panel in order to avoid damaging it.

4×M3	
7 mm deep (Max.)

CAUTION

•	 Avoid touching the screen during this step as it may damage it.
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Procedures to attach/detach stands

The main unit comes with two stands which can be detached. The position where the front stand is attached can be 
changed.

CAUTION

•	 Use a flat, clear surface when attaching/detaching the stands.

•	 The display can tip over if the stand has not been attached.

•	 Avoid touching the screen during this step as it may damage it.

■■ Detaching

1.	 Place the display with the screen facing down on a soft cloth or cushioning material that is larger than the 
display.

2.	 Front stand: Remove the mounting screws (two each) from the left and right stands. 
Rear stand: Remove the mounting screws (one each) from the left and right stands.
Do not lose the removed screws. Do not use these screws for other purposes.

■■ Attaching

1.	 Place the display with the screen facing down on a soft cloth or cushioning material that is larger than the 
display.

2.	 Align the position of the stand and screw hole on the video display.
Alight the convex part of the stand and concave part of the video display.

3.	 Front stand: Fix the left and right stands using the mounting screws (two each). 
Rear stand: Fix the left and right stands using the mounting screws (one each).

Rear

Screen side

Front stand mounting part (inside)

Front stand
Front stand 	
mounting screw hole

Mounting 
screw

Front stand mounting part (outside)

Concave part

Convex part

Concave 
part

Rear stand

Convex part

Note

•	 It is recommended to mount both front stands in either the outside or inside positions.
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Preventing from Tipping

Fixing the video display using screw holes on the stands can reduce the risk of the main unit tipping over or falling.

1.	 Use screws that fit the screw holes.
The screw hole size is shown below.

Screw hole
2- 4.5

CAUTION

•	 When securing the main unit to a table or desk, please ensure a table or desk is strong enough to carry the weight of the 
main unit.

•	 It is recommended to obtain assistance from another person when performing this step.

•	 Avoid touching the screen during this step as it may damage it. 
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Mounting the Main Unit on a Stand or Wall

This main unit can be fitted to a stand* or to a wall mount bracket*. Remove the stands beforehand ( 16).
* Commercially available. 

CAUTION

•	 For safety, make sure to perform this step with at least two people.

•	 When mounting the main unit on a wall, make sure the wall has sufficient strength. If necessary, apply reinforcement. Also, 
make sure to check the load capacity of the stand or wall mount bracket.

•	 When the video display is placed on a rack or display stand and ventilation around it is blocked by equipment placed 
above or below or in a surrounding area, the operating temperature may increase, causing a failure or overheating. In order 
to maintain the operating temperature condition of the video display (0 ˚C to 40 ˚C), make a space of at least 1U (4.4 cm) 
above and below and at least 4 cm (1.6 in.) space from its back. Make a sufficient space from peripheral equipment, 
secure vents, or install a ventilation fan.

•	 When installing the video display on a wall, make sufficient space from the wall so that cables are not squeezed or twisted.

•	 Avoid touching the screen during this step as it may damage it.

•	 Make sure that the main unit does not fall during installation/removal.

1.	 Attach a commercially available stand or wall mount bracket using the screw holes on the back or side face 
of the main unit ( 111).
The screw hole size is shown below.

Rear
6×M4 	
5 mm deep (Max.)

2×M4 	
8 mm deep (Max.)

Same on the other side

Side
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Connecting the Main Unit to Input Devices

The video display has SDI and HDMI input terminals to connect input devices.

CAUTION

•	 Check that the power of the video display and input devices is switched off before connecting.

■■ SDI input signals

Refer to the SDI input terminals diagram when connecting to the desired input signal. (A, B, C, D)

Actual screen display location

A B
C D

C

B

D

A

DP-V2421DP-V2420

Display area icon

SDI (IN) terminal

Input signal Input terminal

Quad Link
(Square Division) 3G/HD-SDI

12G/6G/3G/HD-SDI

Top left, Mapping signal Input A

Single input system

Top right, Mapping signal Input B

Bottom left, Mapping signal Input C

Bottom right, Mapping signal Input D

Quad Link*
(2 Sample Interleave)

3G-SDI Link 1 Input A

Link 2 Input B

Link 3 Input C

Link 4 Input D

Dual Link*
3G-SDI

6G/3G-SDI

Link 1 Input A

Two input systems
Link 2 Input B

Link 1 Input C

Link 2 Input D

Single Link
3G/HD/SD-SDI

12G/6G/3G/HD/SD-SDI

—

Input A/Input B/	
Input C/Input D

Four input systems

* The signals are automatically switched when "Link Order" is set to "Automatic".
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Reference

•	  The connection is tested using 4VS03A-5C BNC cables (multi) manufactured by Canare Electric Co. 
 The connection is tested using D5.5UHDC03E BNC cables manufactured by Canare Electric Co.

•	 When 3G-SDI RAW signal frequency exceeds 30.00P, it becomes a dual connection.

•	 Each input terminal is compatible with through output. When signals are input from Input A, connect the cable to the SDI 
(OUT) terminal of Input A.

■■ HDMI input signal

HDMI input terminal

CAUTION

•	 Use a HDMI cable with the High Speed logo that complies with the HDMI standard. When a non-compliant HDMI standard 
cable is used, the video display may not work normally, for example a video becomes choppy or nothing is displayed.
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Turning on the Power
This section describes how to turn on the power of the main unit.

Turning on the Power of the Main Unit

1.	 Plug the provided AC power cord HT-21 to the AC power supply input terminal at the rear.
The video display goes into standby and the power indicator lights up in amber.

2.	 Press the power supply button  at the front.
The power indicator lights green.

Note

•	 Warming-up is necessary to stabilize the brightness of the video display. Wait at least 10 minutes after turning on the power 
before using.

Installing the AC power cord clamp HC-01 (Included)

Install the AC power cord clamp before connecting the AC power cord to the main unit.

1.	 Insert the AC power cord clamp connector into the cord clamp mounting 
hole (1).

2.	 Connect the AC power cord to the main unit (2).

3.	 Secure the AC power cord in place with the holder (3).

4.	 Press the holder against the main unit (4).
Make sure that there is no slack (A).

•	 To remove the AC power cord clamp from the AC power cord: Pull the holder 
lever (5).

•	 To adjust the length: Push the holder lock lever down (6).

•	 To remove the AC power cord clamp from the main unit: Press the knobs on the 
left and right and pull out the clamp (7).

2

1

3

4

A

56 7
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Operating the Video Display
Using buttons and jog dial on the video display, you can adjust image quality and configure settings for input signals. In 
addition, you can assign the frequently used functions to the CH and F buttons.

Operating the jog dial

The procedures to operate the jog dial are described below.

MENU button
Opens/closes the OSD 
menu, or moves up one 
level in a menu.

RESET button
Resets the items to be adjusted using the slider and 
entered characters.

Jog dial
Up, down, left, right / rotation: Used to move to a different item and 

change settings.
Press: �Confirms settings or moves the selection frame up/down 1 level.

Basic operations to use the OSD menu

This section describes basic operations to use the OSD menu.

1.	 Press the MENU button to open the OSD menu.

Main Menu
Top Screen

Sub Menu Setting Options
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2.	 Select an item using the jog dial and press it to determine the selection.
The selection frame moves to sub menu.

3.	 Select an item using the jog dial and press it to determine the selection.
The selection frame moves to setting options.

4.	 Select the setting using the jog dial.
Settings change according to the operation of the jog dial.

5.	 Press the jog dial to determine the selection.
The selection frame returns to sub menu.

6.	 Exit menu.
When you press the MENU button, the selection frame moves up one menu level. Move the selection frame all the 
way to the main menu on the top screen and then press the MENU button to exit the menu.

Note

•	 The following functions can be returned to their factory default settings or their anchor point (  25) by pressing the RESET 
button, after adjusting the image quality.
-- "Contrast", "Brightness", "Chroma", "Sharpness", "Power", "Saturation", "Offset", "Slope"
In "User 1-7" mode where you are performing calibration, the setting returns to the value after calibration instead of the 
factory default.

•	 To adjust image quality, warming-up is necessary to stabilize the brightness of the video display. Wait at least 10 minutes 
after turning on the power before using.

•	 The OSD menu and slider will disappear automatically if no operation is performed for approximately 1 minute. The F 
button will disappear automatically if no operation is performed for approximately 10 seconds.

•	 The settings that cannot be set, are grayed out.
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Adjusting Image Quality While Viewing the Entire Image

You can adjust the OSD menu to display as a slider at the bottom of the screen. This allows for the image quality to be 
adjusted whilst it is displayed on the screen.

1.	 Press the jog dial when the selection frame is on setting options.
A slider appears at the bottom of the screen.

2.	 Make adjustments using the jog dial with using the slider as guide.

3.	 When adjustments are completed, press the jog dial.
The screen returns to the original OSD menu.

■■ Adjusting "Gain R/G/B, Bias R/G/B" under "Color Temperature"

You can adjust RGB all at once or individually when the slider for adjusting "Gain R/G/B" and "Bias R/G/B" are 
displayed.

1.	 Switch the guide in the upper right area of the slider screen using the jog dial ( ).
The indication changes to "RGB", "R", "G", and "B".

2.	 When adjustments are completed, press the jog dial.
The screen returns to the original OSD menu.

■■ Adjusting "x, y" under "Color Temperature"

You can adjust "x, y" in "Color Temperature" on the color map.

1.	 Adjust "x" with the   and "y" with .
The adjusted value is indicated by the " " mark on the color map.

2.	 When adjustments are completed, press the jog dial.
The screen returns to the original OSD menu.

Default value

Last used value

Current value

Current value
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Temporarily Saving Parameters (Anchor Point Setting)

You can temporarily save parameters for "Contrast", "Brightness", "Chroma", "Sharpness", and "HDR Range" and 
recover the values. See 56 for setting anchor points during CDL adjustment. 

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Adjustment" using the jog dial and press the dial to determine the selection.
The selection frame moves to sub menu.

3.	 Select "Anchor Adjustment" using the jog dial and press the dial to determine the selection.
When the confirmation screen appears, select "OK". The parameter is saved and sets anchor point.

4.	 Adjust the image quality again and press the RESET button on the video display.
Press the RESET button to return to each saved anchor point.

Current valueLast used value

Anchor point

Note

•	 Executing "Reset" under "Adjustment" or "Reset All Settings" under "System Settings" resets saved anchor points and the 
settings return to their factory default values.

•	 When calibration is performed in "User 1-7" under "Picture Mode", the values are saved as anchor points.

Enlarging the display (Zoom function) ( 73)

The zoom display position can be adjusted, and the zoom magnification (2x, 4x, 8x) can be selected.

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Display Settings" → "Zoom" using the jog dial.

3.	 Select "Zoom Preset" using the jog dial.
Select a preset zoom display.

4.	 Select "Position" using the jog dial.
The zoom adjustment screen is displayed.
- To move the display position: Move the jog dial (   or rotation).
- To return to the center: Press the RESET button.

5.	 When adjustments are completed, press the jog dial.
The screen returns to the original OSD menu.

Zoom 2   [x4]
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Note

•	 When magnifying the image and the OSD menu is not being displayed,
-- you can set the magnification ratio by pressing the jog dial.

-- You can move the display location by moving the jog dial (  ).

-- You can set the following functions using the CH button: 	
CH1: Select zoom type; CH2: Switch between zoom presets (Zoom 1/Zoom 2/Zoom 3); CH3: Zoom off

Changing Image Quality Automatically According to Input Signal

On this video display, you can automatically change the image quality according to video resolution or metadata.

■■ Changing "Picture Mode" automatically ( 67)

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Channel Settings" → "Select Channel" using the jog dial.
Select the channel.

3.	 Select the "Channel Settings" → "Picture Mode" → "Type" using the jog dial.
Select the Type.

Changing by individual video resolution (4K/2K)
Select "4K/2K".

Changing according to video resolution (4K/2K) or metadata (SDI)
Select "Automatic".

4.	 Select the Picture Mode using the jog dial.

■■ Changing the image quality setting according to video metadata (HDMI) ( 59)

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Adjustment" → "Picture Mode" using the jog dial.
Select "User 1" to "User 7".

3.	 Select the "Channel Settings" → "Picture Mode" → "Type" using the jog dial.
Select other than "L/R".

4.	 Select "Adjustment" → "Detail Settings" → "HDMI Link" → "Automatic Adjustment" using the jog dial.
•	 Select "On".

•	 See "HDMI Link" ( 59) for the configurable settings.

Note

•	 When automatic changing of image quality according to video resolution (4K/2K) or SDI metadata 
is set, information showing which resolution (4K/2K, etc.) is selected will be displayed at the top 
right of the menu screen.
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Adjust image quality on left/right side of screen (image comparison mode)

You can divide the screen in two and adjust the image quality on the left and right sides of the screen individually.

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Channel Settings" → "Picture Mode" → "Type" using the jog dial.
After selecting "L/R", press the jog dial to determine the selection.

3.	 Select the screen to adjust image quality.
•	 When the OSD menu is open:

-- In the "Adjustment" main menu, press the jog dial’s  button.

-- In the "Adjustment" main or sub menu, press the CH1 button.
•	 When the OSD menu is not being displayed: Move the jog dial (  ).

•	 Each time the target screen is switched, the set "Picture Mode" is displayed at the top.

4.	 Adjust the image quality on the selected screen.

Note

•	 When in Image Comparison mode, an icon showing which screen (L/R) is selected for image quality 
adjustment will be displayed at the right top of the "Adjustment" menu screen.

•	 The functions that cannot be used when the right screen is selected are as follows.
-- Sub Menu items for "Adjustment": "Contrast", "Backlight Control", "Peak Luminance Control", "HDR/SDR View", 
"Calibration"

•	 When two screens are displayed, you can adjust the image quality on each screen individually and compare them.
-- When two screens are displaying the same image ("Single Input Dual View" 68)

-- When two screens are displaying different images ("Multi View (Dual)" 65)

-- The HDR (High Dynamic Range) and SDR (Standard Dynamic Range) displays can be tested side by side. ("HDR/SDR 
View" 58)

Calibration without a PC ( 59)

When "User 1-7" under "Picture Mode" is selected, you can perform calibration using an external sensor, without using 
the computer.
The supported external sensors are Konika Minolta Display Color Analyzers CA-310 and CA-210. Be sure to also read 
the instruction manual of the CA-310 and CA-210.
The video display can perform measurement or calibration of the display using the DP-V Color Adjustment software. 
Refer to the Canon website for the DP-V Color Adjustment.

1.	 Connect the display color analyzer to the USB port of the main unit.

2.	 Open the OSD menu and select "Adjustment" → "Detail Settings" → "Calibration".
Set each target value.
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3.	 Press the jog dial and select "Start".
Please follow the information indicated on the screen.

4.	 Initialize the sensor.
Set the mode dial of the Universal Measuring Probe to "0-CAL".
Press the jog dial of the video display, select "OK", and execute initialization.

5.	 Place the universal measuring probe pointing at the center of the video display.
Set the mode dial of the universal measuring probe to "MEAS" and place the probe as shown below according to 
the displayed content. Press the jog dial of the video display, select "OK", and execute calibration.

Konica Minolta Universal Measuring Probe 
CA-310 support: CA-PU32, CA-PU35
CA-210 support: CA-PU12, CA-PU15

Konica Minolta
Display Color Analyzer CA-310, CA-210

Main Unit

6.	 Finish calibration.
When the message "Calibration is completed." is displayed, press the jog dial and select "OK".

•	 If the message "Calibration error." is displayed.	
Calibration has been terminated due to an error. The main unit returns to the state before calibration. ( 130) 

•	 To cancel calibration	
Press the jog dial during calibration and select "Cancel". The main unit returns to the state before calibration.

Note

•	 Due to the characteristic of LCD panel and individual difference of CA-310 and CA-210, the calibration results may differ.

•	 Perform matrix calibration of the display color analyzer prior to calibration. If calibration is performed without performing 
matrix calibration, an error may occur. Refer to the CA-310 and CA-210 instruction manual for the detail operation.

•	 Warming-up is necessary to stabilize the brightness of the video display. Wait at least 10 minutes after turning on the power 
before calibration.

•	 Perform calibration in a dark room so that no external light enters the sensor. If external light enters the sensor, low 
brightness characteristics cannot be calibrated correctly.
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Export/Import

You can export/import LUT and CDL parameters as well as main menu settings. Insert a USB memory stick into the 
USB port of the main unit.

■■ LUT Import ( 57)

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Adjustment" → "Detail Settings" → "LUT Import" using the jog dial.

3.	 Select the file using the jog dial.
In the "Filename" field, search and display a file with extension ".clut" in the root folder.

4.	 Select the LUT type using the jog dial. 
•	 Select the LUT type by using "User LUT", "Gamma LUT" or "Gamut LUT".

•	 Refer to the "Concept Drawing of Display Image Processing and LUT". Or, also refer to the "User LUT Creation 
Guide" on the Canon website.

5.	 Select "Select LUT" using the jog dial.
Selects User LUT 1-8/Gamma LUT 1-8/Gamut LUT 1-8.

6.	 Select the standard color gamut using the jog dial.
Select the color gamut used when creating the LUT (when "Gamut LUT" under "LUT Type" is selected).

7.	 Select "Execute" using the jog dial.
When the confirmation screen appears, select "OK". Import starts.

Note

•	 The LUT file is proprietary to Canon Video Display. Refer to the Canon website for the file format and how to create.

•	 Up to 1000 LUT import files are recognized.

•	 You can delete the imported LUT. You can specify the name of LUT ( 57).

Import LUT file
（3D-LUT）

OSD Menu
Gamma/EOTF 

Setting

or
Import LUT file

（1D-LUT）

or
Import LUT file

（3D-LUT）

OSD Menu
CDL/User LUT

Setting

OSD Menu
Color 

Temperature
Setting

Color 
Temperature

OSD Menu
Base Color 

Gamut Setting

Color Gamut

Gamma 2.2

Color Gamut
（User selectable）

Color Temperature
（User selectable)

3D-LUT
（Gamut LUT）

1D-LUT
（Gamma LUT）

3D-LUT
（User LUT）

Concept Drawing of Display Image Processing and LUT
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■■ Export/Import Main Menu Settings ( 104)

1.	 Press the MENU button to open the OSD menu.

2.	 Select "System Settings" → "Export/Import".

3.	 Select "Export" or "Import" using the jog dial.

	 Exporting
- Select "Target" from "USB", "User 1-3" or "LAN".
Export "USB" to the USB memory and "User 1-3" to the built-in memory of the main unit. When you select "LAN", 
the file is exported to a display connected via LAN.
- If you selected "USB" or "User 1" to "User 3", select "Filename".
·· Factory default is "dinfo_dpv2420.dat" (  "dinfo_dpv2421.dat"). You can change the name of the file to be 
exported to the USB memory within 16 one-byte characters including alphabetical characters, numbers, and 
symbols.

If you selected "LAN", select "Display".
·· Select the display to which to export the settings from the displays connected via LAN.

- Select "Execute".
When the confirmation screen appears, select "OK". Export starts.

	 Importing
- Select "Target" from "USB" or "User 1-3".
Specify the destination to save the file to be imported.
- Select "Filename".
- In "Settings", select "All" or Main Menu name.
- Select "Execute".
When the confirmation screen appears, select "OK". Import starts.

Note

•	 After export to "User 1-3", you can select the configurations at startup from "User 1-3" in "Power on Setting" in "System 
Settings" ( 105). 

•	 To export this device's settings to other Canon displays:
-- If a display model has functions with different menu settings or setting ranges, some settings will not be correctly 
exported (settings will not be changed, will revert to factory defaults, etc.)

-- When the export is completed, a message will appear on the target display.
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■■ Exporting/Importing CDL Parameters ( 56)

1.	 Press the MENU button to open the OSD menu.

2.	 Select "Adjustment" → "CDL/User LUT" using the jog dial.
Select "CDL 1-8".

3.	 Select "Detail Settings" → "CDL Export" or "CDL Import".

	 Exporting
- Select "CDL Preset".
- Select a file format ".ccc" or ".cdl".
- Select "Execute".
When the confirmation screen appears, select "OK". Export starts. 

	 Importing
- Select "Filename".
- Select "CDL Preset".
- Select "Execute".
When the confirmation screen appears, select "OK". Import starts.

Note

•	 The exported file is automatically saved under the name "YYYYMMDDhhmmss_Preset name.ccc (cdl)".

•	 Up to 1000 CDL import files are recognized.

Set Date/Time ( 101)

This section describes how to set the Date/Time. The Date/Time of this video display will be reset if the power cord is 
not connected for about 20 days.

1.	 Press the MENU button to open the OSD menu.

2.	 Select "System Settings"→"Date/Time".
A screen to input the Date/Time appears.

3.	 Set the Date/Time using the jog dial.
The selection frame moves and numbers change as you operate the jog dial. Repeat until you complete setting the 
year, month, date, hour, and minute.

4.	 Press the jog dial when you are finished.
The selection frame moves to "OK".

5.	 Check the content and press the jog dial to confirm the settings.

Reference

•	 When selecting "Cancel" or pressing MENU button before selecting "OK", the settings will be reset and the previous screen 
will be displayed.
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Inputting Characters

This section describes how to input the characters.

1.	 Press the MENU button to open the OSD menu.

2.	 The character input screen appears automatically when 
character input is required.
Move the selection frame to the location to enter characters 
using the jog dial (  ).

3.	 Select characters using the jog dial (  or rotation).
The following characters can be selected: Press  
buttons to display them one by one.
	 	 Alphanumeric characters: A to Z, a to z, 0 to 9
	 	 Symbols: , . : ; ‘ ` - + / = % & ! ? # _ | $ ^ ~ @ { } [ ] < > ( ) space
Characters that cannot be entered are automatically skipped.

4.	 Repeat steps 2 and 3 until the desired text has been inputted. 

5.	 Press the jog dial when you are finished.
The selection frame moves to "OK".

6.	 Check the content and press the jog dial to confirm the settings.

Reference

•	 When selecting "Cancel" or pressing MENU button before selecting "OK", the settings will be reset and the previous screen 
will be displayed.

•	 To erase characters in the selection frame or reset it, press the RESET button on the video display.
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Using the Function (F) Buttons

You can assign functions to the F buttons on the video display to execute them instantly.

1.	 Press the MENU button to open the OSD menu.

2.	 Select "System Settings" → "Function/Channel Button" → "Display Function" or "Display Function (CDL)" 
and press the jog dial to determine the selection.
A new window opens and displays button names F1 to F8.

3.	 Select the name of the button using the jog dial and press the jog dial to determine the selection.
The selection  frame moves to next OSD menu level.

4.	 Select the function to assign using the jog dial.
See "Display Function" or "Display Function (CDL)" ( 101, 106) for the available functions.

5.	 Press the jog dial to determine the selection.
The setting is confirmed.

Reference

•	 Holding the F button down will display the function selection screen, and you can set the function you wish to register.

•	 Turning "System Settings" → "OSD Settings" → "Function Button Guide" to "On" will mean that when OSD is not 
displayed, pressing/moving (  , or rotate) the jog dial will allow you to see the list of functions registered to the F 
button. Selecting a function from the list and pressing/moving ( ) the jog dial will display the detailed settings screen, or 
execute that function.

Using the Channel (CH) Button

You can assign channels (various settings related to input signal) to the CH buttons on the video display and switch 
channels instantly.

1.	 Press the MENU button to open the OSD menu.

2.	 Select "System Settings" → "Function/Channel Button" → "Display Channel" and press the jog dial to 
determine the selection.
A new window opens and displays button names CH1 to CH3.

3.	 Select the name of the button using the jog dial and press the jog dial to determine the selection.
The selection frame moves to next OSD menu level.

4.	 Select the channel to assign using the jog dial.
See "Channel Settings" ( 64) for the configurable settings.

5.	 Press the jog dial to determine the selection.
The setting is confirmed.
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The following content is assigned to channel buttons on the video display by factory default.

CH CH1 CH2 CH3

Input Configuration 3G/HD-SDI HDMI 3G-SDI RAW

12-3G/HD-SDI HDMI 3G-SDI RAW

Select Input Signal Automatic Automatic Automatic

Image Division Automatic Automatic Automatic

Link Order Automatic Automatic Automatic

Format Automatic Automatic Automatic

Audio Input Automatic Automatic Automatic

Marker/TC/CameraInfo Input Input A Input A Input A

Internal Sync Off Off Off

Channel Name (Blank) (Blank) (Blank)

Picture Mode → Type Normal Normal Normal

Picture Mode
Picture Mode L
Resolution 4K

ITU-R BT.709 ITU-R BT.709 CINEMA EOS SYSTEM

Picture Mode R
Resolution 2K

ITU-R BT.709

Payload UHD/PQ User 1 (2020 PQ)

UHD/HLG User 2 (2020 HLG)

UHD ITU-R BT.2020

709/PQ —

709/HLG —

709 ITU-R BT.709

VANC —

Unknown —

Camera CINEMA EOS         
SYSTEM

CINEMA EOS SYSTEM

ARRI User 6

VARICAM User 7

Single Input Dual View Off Off Off

Separator Off Off Off

Note

•	 Holding the CH button down displays the channel list, allowing the user to select the desired channel. However, in the 
following cases, a list of input signals will be displayed and the user can temporarily switch signals: When a 12G-SDI signal 
or 6G-SDI signal is input; or when video that can be displayed simultaneously with a 12G-SDI or 6G-SDI signal is input and 
"Select Input Signal" is set to "Automatic" ( ).
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Checking Signal Information and Status of the Main Unit

The video display is equipped with a banner function which displays signal information or the status of the main unit.

1.	 Press the jog dial when the OSD menu is closed.
The channel name, signal information, and status of the main unit will be displayed in the banner. It will automatically 
disappear after 6 seconds.

Note

•	 You can select how the banner is displayed ("Banner" 102).

•	 You can monitor the input signal status. ("Signal Monitoring" 88)

•	 For more detailed signal information, please refer to the section on "Signal Information" ( 108).

•	 The "Detecting sync." banner will continue to appear until the input signal is synchronized.

Operating the video display using an external device [LAN terminal]

The video display supports Television Systems Ltd.’s "TSL UMD Protocol Ver. 5.0". You can operate the video display 
using an external device connected to the LAN terminal and display characters and tally lights on the screen. There are 
two tally lights, on the left and right. Up to 16 characters can be displayed. 

Tally display (left) Character display Tally display (right)

1.	 Connect an external control device to the LAN terminal.

2.	 Set "SCREEN" and "INDEX" to "0x0000" in the TSL Protocol settings.

3.	 Press the MENU button to open the OSD menu. 

4.	 Select "Network/IMD Settings" → "In Monitor Display" and press the jog dial to determine the selection.

5.	 Select "Control" → "TSL Ver. 5.00" using the jog dial.
•	 This will allow operation from an external control device, and display characters and tally lights.

6.	 Select "Position" → "Top" or "Bottom" using the jog dial.
•	 This sets the position where characters and tally lights will be displayed.

Note

•	 When "Multi View (Dual)" or "Multi View (Quad)" is displayed, set the "INDEX" setting to from "0x0001" to "0x0004".

•	 The port number for the controlling is fixed at "45000".

•	 With "In Monitor Display" you can also display user-selected characters on the screen. ( 100)
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Operating the video display using an external device [USB terminal: Wi-Fi 

connection]

A Wi-Fi adapter can be connected to the USB terminal of the video display so that the video display can be connected 
to a portable terminal in the Wi-Fi network environment in use. The following two methods can be used to connect:
Infrastructure: This method connects to Wi-Fi via an access point.
Access Point: This device acts as an access point, and this method connects the device directly to the Wi-Fi device.
•	 Network settings such as IP address and subnet mask are acquired automatically.

•	 Supported encryption schemes	
Infrastructure: WEP64 (ASCII), WEP128 (ASCII), WPA-TKIP, WPA-AES (CCMP), WPA2-TKIP, WPA2-AES (CCMP)	
Access Point: WPA2-AES (CCMP)

CAUTION

•	 Note that we cannot accept any liability for damages that arise as a result of incorrect settings made on the network to use 
network functions and for damage that arise as a result of use of this function.

•	 Avoid connecting to Wi-Fi or network environments that are not protected by appropriate security measures. Remember to 
change the default password when setting the access point. Doing so may cause the customers’ personal information or 
other important information to leak to a third party. When not using Wi‑Fi, set "Wi‑Fi" → "Control" to "Off".

•	 The specifications and restrictions of Wi-Fi connection methods differ depending on the Wi-Fi network in use.

•	 There is no guarantee that the Wi-Fi adapter functions in use will work on the video display. For information about Wi-Fi 
adapter related defects, contact the device manufacturer. Also, in various countries and regions, approval is needed to 
use the Wi-Fi adapter, and use of non-approved Wi-Fi adapters is not permitted. If you are unclear of whether or not use is 
approved, check with the device manufacturer.

Note

•	 Refer to the Canon website for a list of supported devices (Wi-Fi adapters).

•	 For details on how to use the Wi-Fi adapter, precautions for use, how to set access points, and other information, either 
refer to the device Instruction Manual or contact the manufacturer.

•	 Up to 24 access points can be displayed and selected on the video display.

1.	 Connect the Wi-Fi adapter to the USB terminal.

2.	 Press the MENU button to open the OSD menu.

3.	 Select "Network/IMD Settings" → "Wi-Fi", and press the jog dial to determine the selection.

When using the "Infrastructure" method

4.	 Select "Control" → "Infrastructure" using the jog dial.

5.	 Set the access point to connect to.

6.	 If a password is needed when connected to an access point, enter the password ( 99).
•	 This is set using up to 24 alpha-numerical characters and symbols. The following characters can be entered.

   Alphanumeric characters: A to Z, a to z, 0 to 9
   Symbols: _ or -
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When using the "Access Point" method

4.	 Select "Control" → "Off" using the jog dial.

5.	 Select "Access Point" using the jog dial ( 99).
•	 Enter the SSID. This is set using up to 24 alpha-numerical characters and symbols.

•	 Sets the communication mode.

•	 Sets the channel.

•	 Enter the password. This is set using between 8 and 24 alpha-numerical characters and symbols.

•	 "SSID", "Password": The following characters can be entered.

   Alphanumeric characters: A to Z, a to z, 0 to 9
   Symbols: _ or -

6.	 Select "Control" → "Access Point" using the jog dial.
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Use a web browser to remotely operate the video display

A web browser can be used to remotely operate the video display using a computer terminal connected to the LAN 
terminal or a portable terminal ( 36) connected via a Wi-Fi adapter to the USB terminal. From the device connected to 
the network, you can change image quality settings or switch channels.
This function checks operation using the following web browsers.
•	 Safari (Apple)

•	 Google Chrome (Google)

※	 * Correct operation cannot be guaranteed on all supported OS or web browser editions.

CAUTION

•	 Remember to change the initial settings for ID and Password when using this function.

Note

•	 Access is only possible from a single terminal.

•	 This function may not work if the video display is accessed using LAN and a Wi-Fi adapter, at the same time.

•	 Opening multiple pages in multiple tabs on the web browser can cause it to not function properly.

•	 Executing "Capture" in the "View" screen can cause the video on this video display to pause temporarily.

•	 Operating the video display itself while it is being accessed from a web browser can cause the network connection to be 
lost.

•	 A delay may occur in video display or in the various settings depending on the network environment and communication 
conditions.

•	 The IP address can be checked in the "System Information" screen.

•	 The operation screen only displays English.

1.	 Connect external control devices via the network.

2.	 Press the MENU button to open the OSD menu.

3.	 Select "Network/IMD Settings" → "Web", and press the jog dial to determine the selection.

4.	 Select "Control" → "On" using the jog dial.

5.	 Select "User ID" and "Password" using the jog dial. ( 99)
•	 User ID: Enter the user ID. This is set using up to 16 alpha-numerical characters and symbols.

	 Password: Enter the password. This is set using between 8 and 16 alpha-numerical characters and symbols.
	 The following characters can be entered.
	 Alphanumeric characters: A to Z, a to z, 0 to 9 
	 Symbols: _ or -

6.	 Start up a web browser on the device connected to a network.

7.	 Enter the IP address of this video display in the address bar.
•	 The remote operation screen is displayed on the web browser.

•	 When the basic authentication screen is displayed, enter the user ID and password.

8.	 When operation ends, close the web browser.
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■■Operation screen

"View" screen
After pressing one of the image capture buttons, the captured image will be displayed. You can also operate the CH 
buttons and F buttons (function/channel buttons).

Captured image

Image capture button

"Control" screen
Allows the Picture Mode, Channel, and various marker displays to be set.

"Name / ID /Password"
Enter the text.
Get: Get the text data to be entered.
Set: Apply the text data to the text input screen.

"Zoom / Pixel Value"
Sets the display position for "Zoom" or the pixel 
position for "Pixel Value Check".

"Setting" screen
You can import LUT, export "Frame Luminance Monitor", and import or export this video display's settings. 

"LUT Import (User LUT)"
Imports a LUT. When the LUT import is completed, the 
setting of the imported LUT will be applied to the current 
"Picture Mode"'s "CDL/User LUT".

"Frame Lum. Monitor Export" 
Exports "Frame Luminance Monitor". Exporting "Frame 
Luminance Monitor" will create a "latest.csv" file for the 
luminance in the final screen and an "all.tar.gz" file (a file 
compressed using the tar.gz method) that contains all 
acquired luminance information.
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"lnformation" screen
Displays the settings for "Adjustment" and "Channel Settings", and information for "Signal Information" and "System 
Information".

"Link" screen
You can display a list of the display connected via LAN to this video display, set "Display Setting Link", and change 
the display names.
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OSD Menu
OSD Menu Index
Adjustment ( 49)

Picture Mode

Contrast

Brightness

Chroma

Sharpness

Backlight Control

Color Temperature

Color Gamut

Gamma/EOTF

HDR Range

Input Transform

Output Transform

Output Transform Surround

Color Range

CDL/User LUT

CDL/User LUT

Power

Saturation

Offset

Slope

CDL/User LUT Bypass

Detail Settings

CDL Export

CDL Import

CDL Preset Name

Anchor CDL

Reset CDL

Detail Settings

Peak Luminance Control

LUT Import

LUT Name

LUT Delete

YCbCr Color Matrix

2020 Constant Luminance

2020 Gamut Mapping

Hybrid Log-Gamma System

HDR/SDR View

Calibration

HDMI Link
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Copy Picture Mode

Picture Mode Name

Anchor Adjustment

Reset

Channel Settings ( 64)

Select Channel

Input Configuration

Select Input Signal

Image Division

Link Order

Format

Audio Input

Marker/TC/CameraInfo Input

Internal Sync

Channel Name

Picture Mode

Single Input Dual View

Separator

Display Settings ( 71)

Screen Scaling

Anamorphic

Scaling Method

Video Position (Multi View)

Zoom

Zoom Preset

Magnification

Position

Type

Frame Hold

Background Color

I/PsF

PsF

I/P Conversion

Film Cadence

Audio Settings ( 75)

SDI Group

CH L/R (SDI)

CH L/R (HDMI)

Volume

Audio Switch
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Marker Settings ( 76)

Marker Preset

Aspect Marker

Enable

Mask

Aspect Ratio

Line

Line Width

Line Color

Line Brightness

H Position

V Position

Safety Zone Marker 1, 2

Enable

Aspect Ratio

Area Size

Rate (%)

Width (dot)

Height (dot)

Shape

Line Width

Line Color

Line Brightness

H Position

V Position

Area Marker

Enable

H Position

V Position

Width (dot)

Height (dot)

Mask

Line

Line Width

Line Color

Line Brightness

Center Marker

Enable

Size

Line Width

Line Color

Line Brightness
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Grid Marker

Enable

Distance

Line Width

Line Color

Line Brightness

Function Settings ( 81)

Time Code

Enable

Type

Size

Position

H Offset

Type String Display

Brightness

Audio Level Meter

Enable

Channel Number (SDI)

Channel Number (HDMI)

Size

Peak Hold

Reference Level

Brightness

Wave Form Monitor

Enable

Select Signal

Display Type

Select Line

Scale

Reference Line

Reference Level

Reference Level High

Reference Level Low

Color

Brightness

Position

Size

Vector Scope

Enable

Target

Position

Size
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Histogram

Enable

Color

Gain

HDR Range

HDR/SDR Ratio

Peak/Ave. Luminance

Size

Frame Luminance Monitor

Enable

Display

Luminance Graph Settings

HDR/SDR Ratio Graph Settings

Size

Reset

Export

Pixel Value Check

Enable

H Position

V Position

Reset Position

Test Pattern

Signal Monitoring

Control

Error Hold

No Signal/Unsupported Signal

2SI Link Order

 SDI CRC Error

 8K 2SI Format

 8K 2SI Switching

Error Log

Screen Capture

Capture

Frame Hold

Capture Source

File Type

Create HDR/SDR Compare File

Playback File

Finish Playback File
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Camera Link

Automatic Adjustment (CINEMA EOS)

Color Gamut/Gamma/EOTF

Color Temperature

Display Color Gamut

Automatic Adjustment (ARRI)

User LUT

Automatic Adjustment (VARICAM)

User LUT

Anamorphic

Area Marker

Fan

Camera Information

Picture Function Settings ( 94)

Peaking

Enable

Monochrome

Frequency

Range

Color

False Color

Enable

Type

HDR/SDR Border

Range - SDR

Range - HDR

Over Range

Enable

Range (HDR/SDR)

2020 Outside of Gamut View

Enable

Color Gamut

Range

Monochrome

Blue Only

Red Off

Green Off

Blue Off
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Compare View

Enable

Type

HDR/SDR Convert Method

Contrast (SDR)

Color Temperature (SDR)

Gain (SDR)

User LUT Target 1

 User LUT Target 2 (Quad)

 User LUT Target 3 (Quad)

Network/IMD Settings ( 99)

LAN

Wi-Fi

Web

Display Setting Link

In Monitor Display

System Settings ( 101)

Function/Channel Button

Display Function

Display Function (CDL)

Display Channel

Language

Date/Time

Display Name

OSD Settings

Banner

Function Button Guide

OSD Position

OSD Size

OSD Brightness

Protect Settings

Password

Protect Target

Protect

Power Indicator/Button LED Settings

Power Indicator Brightness

Display Button LED

Button Name Lighting Time (sec.)

Fan Settings

Fan Control

Fan Stop
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Compatible Settings

HDMI

Color Range

Backlight Control

Reduce Backlight Flash

 User LUT

Firmware/License Update

Export/Import

Power on Setting

Reset All Settings

Signal Information ( 108)

System Information ( 108)
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Adjustment

This menu is used to adjust the image quality and perform calibration without a PC. The factory defaults differ 
according to the "Picture Mode" setting. ( 61)

Item Setting Options (underline indicates factory default)

Picture Mode

 

Select a preset mode.
SMPTE-C, EBU, ITU-R BT.709, ITU-R BT.2020, Adobe RGB, DCI-P3: Mode set to the 
brightness, color temperature, gamma/EOTF, and color gamut of the three primary colors 
chromaticity points of each standard.
User 1-7 (User 1 (2020 PQ), User 2 (2020 HLG), User 3 (DCI PQ), User 4 (DCI PQ D65), 
User 5 ~ User 7): Custom modes. Set each item of "Adjustment". You can change the mode name 
within 24 one-byte characters including alphabetical characters, numbers, and symbols ( 60).
CINEMA EOS SYSTEM: Canon Log is ideal when viewing image captured with Cinema EOS 
camera/video camera. Using Camera Link, you can have the image quality setting change 
automatically ("Automatic Adjustment (CINEMA EOS)" 90). 
ACESproxy (ver. 1.0.1): A mode to display ACESproxy videos in optimum gamma/EOTF and color 
gamut.

Note

•	 "ACESproxy (ver. 1.0.1)" cannot be set when "Channel Settings" → "Picture Mode" → "Type" 
are "L/R", "4K/2K" or "Automatic".

Contrast Adjusts the white level of the image. (Increments of 1) 
0 to 6000
 ‌�When "Peak Luminance Control" in "Detail Settings" is set to "On", the settable range is shown 
below. When "Peak Luminance Control" is "On", "Contrast [Peak Control]" is displayed.	
0 to 12000

Note

•	 When "Channel Settings" → "Picture Mode" → "Type" is "L/R", "Contrast" cannot be adjusted 
at the "Picture Mode" setting for the right screen. The right screen's setting will be the same 
as set for the left screen.

Brightness Adjusts the black level of the image. (Increments of 1)
-500 to 500

Chroma Adjusts the color saturation of the image (color depth). (Increments of 1)
0 to 2000

Note

•	 Can only be adjusted when "CDL/User LUT" is "CDL 1-8" or "Off".

Sharpness Adjusts the sharpness of the image. (Increments of 1)
0 to 100

Backlight Control Switches the backlight control method.
Local Dimming (High, Low): Local dimming technology controls the amount of light emitted by 
the backlight for each display area. The backlight of bright area is increased and the dark area is 
decreased according to the displayed content. 
Off: No backlight dimming is applied.

Note

•	 When "Peak Luminance Control" is set to "On", you cannot select "Backlight Control".

•	 When "Channel Settings" → "Picture Mode" → "Type" is "L/R", "Backlight Control" cannot 
be set at the "Picture Mode" setting for the right screen. The right screen's setting will be the 
same as set for the left screen.
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Item Setting Options (underline indicates factory default)

Color Temperature Sets the color temperature.
D93, D65, D61, D60, D56, D50, DCI-P3: Select from preset color temperatures.
D65 Custom: This preset is for adjusting the color of the video display and displays having different 
display characteristics. The gain and bias are adjusted based on D65.
Gain R/G/B, Bias R/G/B: Can be adjusted in increments of 1 when a preset color temperature is 
selected.
   Gain R/G/B: 0 to 1023
   Bias R/G/B: -500 to 500
Custom (xy): You can adjust CIE x, y in increments of 0.001.
   x: 0.260 to 0.360
   y: 0.260 to 0.360 
Off: Color temperature is not set.

Note

•	 "Custom (xy)" and "Gain R/G/B" or "Bias R/G/B" cannot be selected at the same time.

•	 When "Gain R/G/B" or "Bias R/G/B" value is adjusted, an asterisk "*" is displayed by color 
temperature preset mode. 

•	 The displayed color coordinates (x, y) are just a guide and not guaranteed absolute values.

Color Gamut Color gamut can be selected when "User 1-7" or "CINEMA EOS SYSTEM" is selected for "Picture 
Mode".
SMPTE-C, EBU, ITU-R BT.709, ITU-R BT.2020, Adobe RGB, DCI-P3: Color gamut compliant to 
each standard.
Native: Color gamut that can be displayed by this video display.
Cinema Gamut to 709, Cinema Gamut to 2020, Cinema Gamut to DCI, DCI-P3+ to 709, 
DCI-P3+ to DCI: Modes where the color gamut is converted to monitor Cinema Gamut and 
DCI-P3+ videos recorded by the CINEMA EOS SYSTEM cameras.
S-Gamut3 to 709, S-Gamut3 to 2020, S-Gamut3 to DCI, S-Gamut3.Cine to 709,  
S-Gamut3.Cine to 2020, S-Gamut3.Cine to DCI: Preset modes where the color gamut is 
converted.
Gamut LUT 1 to Gamut LUT 8: Selects an external LUT.

Note

•	 "Color Gamut" cannot be set in the following cases.
-- When "CDL/User LUT" → "ARRI (Rec2100-PQ-1K-100)", "ARRI (Rec2100-HLG-1K-200)", 
"VARICAM (V-Log to V-709)", "2020 PQ to 2020 SDR", "2020 PQ to 709 SDR", "2020 HLG 
to 709 HLG" or "2020 HLG to 709 SDR" is selected.

•	 For checking the video captured with Cinema EOS cameras, please refer to the "Parameter of 
Cinema EOS cameras and video display ( 90)" in "Adjustment".
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Item Setting Options (underline indicates factory default)

Gamma/EOTF Sets the Gamma/EOTF.
1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, Canon Log, Canon Log 2, Canon Log 3, S-Log2 (HDR), 
S-Log3 (HDR): Select the preset gamma.
SMPTE ST 2084 (PQ), Hybrid Log-Gamma, Hybrid Log-Gamma RGB, Canon Log (HDR), 
Canon Log 2 (HDR), Canon Log 3 (HDR): Select the gamma/EOTF for HDR display. 
Gamma LUT 1 to Gamma LUT 8: Selects an external LUT.
Off: Gamma is not set.

Note

•	 About "Hybrid Log-Gamma"
-- This video display supports the following two methods.
"Hybrid Log-Gamma": This method processes the system gamma for the Y signal (Compliant 
with ITU-R BT.2100).

"Hybrid Log-Gamma RGB": This method processes the system gamma for the RGB signal.

-- If using "Hybrid Log-Gamma" then the system gamma value will be displayed in the "Setting 
Options" on the menu screen.

•	 Not settable in the following cases:
-- When "ACESproxy (ver. 1.0.1)" is selected in "Picture Mode"
-- When "CDL/User LUT" → "ARRI (Rec2100-PQ-1K-100)", "ARRI (Rec2100-HLG-1K-200)", 
"VARICAM (V-Log to V-709)", "2020 PQ to 2020 SDR", "2020 PQ to 709 SDR", "2020 HLG 
to 709 SDR" is selected.

•	 For checking the captured video with Cinema EOS cameras and ARRI / Panasonic cinema 
cameras, please refer to "Camera Link" → "Automatic Adjustment" ( 90).
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The relationship between "Color Gamut" and "Gamma/EOTF" that can be selected is shown below. When "Color Gamut" is 
changed, "Gamma/EOTF" is changed to the underlined value (default value) when the current "Gamma/EOTF" settings are not 
selectable.

Picture Mode Color Gamut Selectable Gamma/EOTF

SMPTE-C Cannot be selected Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Canon Log, 
Canon Log (HDR), Gamma LUT 1 to Gamma LUT 8

EBU Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Canon Log, 
Canon Log (HDR), Gamma LUT 1 to Gamma LUT 8

ITU-R BT.709, 
ITU-R BT.2020

Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Hybrid 
Log‑Gamma, Hybrid Log-Gamma RGB, Canon Log, Canon Log (HDR), Canon Log 2, 
Canon Log 2 (HDR), Canon Log 3, Canon Log 3 (HDR), S-Log2 (HDR), S-Log3 (HDR), 
Gamma LUT 1 to Gamma LUT 8

Adobe RGB Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, Gamma LUT 1 to Gamma LUT 8

DCI-P3 Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Canon Log, 
Canon Log (HDR), Canon Log 2, Canon Log 2 (HDR), Canon Log 3, Canon Log 3 
(HDR), S-Log2 (HDR), S-Log3 (HDR), Gamma LUT 1 to Gamma LUT 8

CINEMA EOS 
SYSTEM, 
User 1-7

SMPTE-C Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Canon Log, 
Canon Log (HDR), Gamma LUT 1 to Gamma LUT 8

EBU Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Canon Log, 
Canon Log (HDR), Gamma LUT 1 to Gamma LUT 8

ITU-R BT.709, 	
ITU-R BT.2020

Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Hybrid 
Log‑Gamma, Hybrid Log-Gamma RGB, Canon Log, Canon Log (HDR), Canon Log 2, 
Canon Log 2 (HDR), Canon Log 3, Canon Log 3 (HDR), S-Log2 (HDR), S-Log3 (HDR), 
Gamma LUT 1 to Gamma LUT 8

Adobe RGB Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, Gamma LUT 1 to Gamma LUT 8

DCI-P3 Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Canon Log, 
Canon Log (HDR), Canon Log 2, Canon Log 2 (HDR), Canon Log 3, 	
Canon Log 3 (HDR), S-Log2 (HDR), S-Log3 (HDR), Gamma LUT 1 to Gamma LUT 8

Native Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), Gamma LUT 1 to 
Gamma LUT 8

Cinema Gamut to 709, 
Cinema Gamut to 2020

2.2, Canon Log, Canon Log (HDR), Canon Log 2, Canon Log 2 (HDR), Canon Log 3, 
Canon Log 3 (HDR)

Cinema Gamut to DCI Canon Log, Canon Log (HDR), Canon Log 2, Canon Log 2 (HDR), Canon Log 3, 
Canon Log 3 (HDR)

DCI-P3+ to 709, 
DCI-P3+ to DCI

Canon Log, Canon Log (HDR)

S-Gamut3 to 709
S-Gamut3 to 2020
S-Gamut3.Cine to 709
S-Gamut3.Cine to 2020

Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), 
Hybrid Log-Gamma, Hybrid Log-Gamma RGB, S-Log2 (HDR), S-Log3 (HDR), 	
Gamma LUT 1 to Gamma LUT 8 

S-Gamut3 to DCI
S-Gamut3.Cine to DCI

Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, SMPTE ST 2084 (PQ), S-Log2 (HDR), 
S-Log3 (HDR), Gamma LUT 1 to Gamma LUT 8 

Gamut LUT 1 to Gamut 
LUT 8

Off, 1.0, 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886, Gamma LUT 1 to Gamma LUT 8
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Item Setting Options (underline indicates factory default)

HDR Range Sets the display method when Gamma/EOTF for HDR display is selected.
SMPTE ST 2084 (PQ): ‌�Sets the "SMPTE ST 2084 (PQ)" dynamic range to be displayed, from 0.005 

to 10,000 cd/m2 (nits). (100 to 4000: 100 increments. 4000 to 10000: 1000 
increments)	
100 to 10000 (1000)

Hybrid Log-Gamma,  
Hybrid Log-Gamma RGB: ‌�Sets how far to display the "Hybrid Log-Gamma" dynamic range. 

(in increments of 100)	
The upper limit value will change to match the settings of "Hybrid Log-
Gamma System". ( 58)
Hybrid Log-Gamma: 100 to 1000
Hybrid Log-Gamma RGB: 100 to 1000/2000

Canon Log (HDR): Sets the "Canon Log" dynamic range to be displayed, from 0 to 800%. (in 100 
increments)	
100 to 800

Canon Log 2 (HDR): Sets the "Canon Log 2" dynamic range to be displayed, from 0 to 1600%. (in 
100 increments)	
100 to 1600

Canon Log 3 (HDR): Sets the "Canon Log 3" dynamic range to be displayed, from 0 to 1600%. (in 
100 increments)	
100 to 1600

S-Log2 (HDR), S-Log3 (HDR): ‌�Sets how far to display the "S-Log" dynamic range. 
(in 100 increments)	
S-Log2 (HDR): 100 to 1400 (1000)
S-Log3 (HDR): 100 to 3900 (1000)

Gamma LUT 1 to Gamma LUT 8: ‌�Sets how far to display the 10-bit LUT data dynamic range, from 
0 to 1023. (in 1 increments)	
512 to 1023

 Setting procedures
The procedures below use Canon Log 2 (HDR) as an example.
When the maximum value (1600) is specified, the 1600% dynamic range of Canon Log 2 is assigned 
to the dynamic range of the video display. Although the brightness in appearance lowers, you can 
check the dynamic range included in video signals. When "1200" is specified, the part exceeding 
1200% of Canon Log 2 is clipped (gradation is saturated) and the part up to 1200% is assigned to 
the dynamic range of the video display.
The brightness of the video display corresponds to the value set for Contrast.

1600% 

1200% 

1600% 

1200% 1200%

Canon Log 2 1600% signal

(Contrast: "12000")

Canon Log 2 (HDR): Set to "1600" Canon Log 2 (HDR): Set to "1200"

Canon Log 2 
range

Canon Log 2 
range

Range of 
video display

Range of 
video display

Gradation is reproduced by assigning 
the range to the range of 

the video display 
(which lowers 
the brightness).

Clip (Saturates gradation.)

Brightness 
value 
corresponding 
to the contrast 
setting
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Item Setting Options (underline indicates factory default)

Input Transform Sets whether or not to apply ACES Input Transform to "3G-SDI RAW" signals ( 64) when 
"ACESproxy (ver. 1.0.1)" is selected for "Picture Mode".
Automatic: Applied automatically.
Off: Not applied.

Output Transform This is displayed instead of "Gamma/EOTF" and "Color Gamut" when "ACESproxy (ver. 1.0.1)" is 
selected for "Picture Mode".
ITU-R BT.709, ITU-R BT.2020, DCI-P3: ACESproxy is converted into respective mode.

Output Transform 
Surround

This is displayed instead of "Gamma/EOTF" and "Color Gamut" when "ACESproxy (ver. 1.0.1)" is 
selected for "Picture Mode".
Dim Surround: �Enables Dim Surround process specified by ACESproxy.
Dark Surround: Enables Dark Surround process specified by ACESproxy.
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Item Setting Options (underline indicates factory default)

Color Range Sets the quantization range.
Automatic: Sets the range based on signal information automatically. 

When "Color Range" is set to "Normal" ( 104)
Full, SDI Full (4-1019), Limited

When "Color Range" is set to "Compatible" ( 104)
Full (0-1023), SDI Full (4-1019), Limited 1 (64-940), Limited 2 (64-1023)

Note

•	 Setting is disabled when "ACESproxy (ver. 1.0.1)" is selected for "Picture Mode".

•	 Operations when "Automatic" is selected are described below.
-- It is set in accordance with the settings if Color Range settings are included in the camera 
metadata. When there is "Full Range" metadata in Payload when SDI is selected, it will be 
set to "SDI Full".

-- When HDMI is selected, "Full" or "Limited" ("Full (0-1023)" or "Limited 1 (64-940)") is 
automatically set according to the HDMI signal information.

-- When SDI is selected, the setting is configured according to the settings for Picture Mode, 
Color Gamut, and Gamma/EOTF.

Setting Options

Color Range to be Set

"System Settings" → "Compatible Settings" → 
"Color Range"

When "Normal" When "Compatible"

Picture Mode DCI-P3

Full Full (0-1023)

Color Gamut

DCI-P3

Cinema Gamut to DCI

DCI-P3+ to DCI

Gamma/EOTF

Canon Log (HDR)

Canon Log 2 (HDR)

Canon Log 3 (HDR)

S-Log2 (HDR)

S-Log3 (HDR)

Canon Log

Limited 
Limited 2 (64-1023)Canon Log 2

Canon Log 3

Other than the above Limited 1 (64-940)

•	 Operations when "Format" is set to "ICtCp" are described below.
-- When "Color Range" is set to other than "Full", "Wave Form Monitor" will display only a 
signal set with "Color Range".

-- If "Channel Settings" → "Picture Mode" → "Type" is "L/R", the right screen's "Color Range" 
setting for the following will be the same as set for the left screen:	
- When displaying a single terminal’s input in full-screen	
- When displaying "2 Sample Interleave" or "Dual Link 3G-SDI" signals
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Item Setting Options (underline indicates factory default)

CDL/User LUT Configures settings for CDL or User LUT.
CDL/User LUT:	�Select a preset such as CDL or external LUT. 

CDL 1 to CDL 8, User LUT 1 ~ User LUT 8, Off 
Only when "Picture Mode" is set to "User 1-7"	
ARRI (Rec2100-PQ-1K-100), ARRI (Rec2100-HLG-1K-200),  
VARICAM (V-Log to V-709), 2020 PQ to 2020 SDR, 2020 PQ to 709 SDR, 
2020 HLG to 709 HLG, 2020 HLG to 709 SDR

Power: �Adjusts the Gamma of the image. (0.01 increments)
0.50 to 4.00 (1.00)

Saturation: �Adjusts the color saturation of the image. (0.001 increments)
0.000 to 2.000 (1.000)

Offset: �Adjusts the black level of the image. (0.001 increments)
-1.000 to 1.000 (0.000)

Slope: �Adjusts the white level of the image. (0.001 increments)
0.000 to 2.000 (1.000)

CDL/User LUT Bypass: 
When "CDL" is selected: ��When set to "On", you can temporarily disable the CDL 

adjustment result and return to previously set image quality. 
When "User LUT" is selected: �When set to "On", you can return to the image quality before 

user LUT was applied. 	
On, Off

Detail Settings
CDL Export: �Exports CDL parameters.  

CDL Preset (CDL 1 to CDL 15, All ), File Type (CCC, CDL), Execute
CDL Import: �Imports CDL parameters. 

Filename, CDL Preset (CDL 1 to CDL 8), Execute
CDL Preset Name: �You can specify the name of preset mode within 16 one-byte characters 

including alphabetical characters, numbers, and symbols.
Anchor CDL: �You can temporarily save parameters for "Power", "Saturation", "Offset", and "Slope" 

and recover the values. (anchor point setting)
Reset CDL: Resets CDL parameters.
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Item Setting Options (underline indicates factory default)

CDL/User LUT Note

•	 When a setting other than "CDL 1-8" is selected, the following functions cannot be set.
-- "Power", "Saturation", "Offset", "Slope", "Detail Settings", "Anchor CDL", "Reset CDL".

•	 When "ARRI (Rec2100-PQ-1K-100)" is selected, "HDR Range" → "SMPTE ST 2084 (PQ)" 
settings become "1000".

•	 When "ARRI (Rec2100-HLG-1K-200)" is selected, "HDR Range" → "Hybrid Log-Gamma" 
settings become "1000".

•	 Depending on the "User LUT" settings, "Color Gamut" and "Gamma/EOTF" will be the same 
as set below.

User LUT Color Gamut Gamma/EOTF

ARRI (Rec2100-PQ-1K-100) ITU-R BT.2020 SMPTE ST 2084 (PQ)

ARRI (Rec2100-HLG-1K-200) ITU-R BT.2020 Hybrid Log-Gamma

VARICAM (V-Log to V-709) ITU-R BT.709 2.2

2020 PQ to 2020 SDR ITU-R BT.2020 2.4

2020 PQ to 709 SDR ITU-R BT.709

2020 HLG to 709 HLG ITU-R BT.709 —

2020 HLG to 709 SDR ITU-R BT.709 2.4

•	 "CDL/User LUT Bypass": Fixed at "Off" when "Picture Function Settings" → "Compare View" 
→ "Enable" is set to "On".

Detail Settings Sets details for Picture Mode.

Peak Luminance 
Control

Controls the display luminance according to the brightness of the input image.
On, Off

Note

•	 When this is set to "On", the F button assigned with the "Peak Luminance Control" function 
flashes when display luminance is restricted.

•	 It is not possible to set the function after selecting Picture Mode when the right screen is 
selected. The right screen's setting will be the same as set for the left screen.

LUT Import You can import LUT. File names that can be imported can be up to 48 one-byte characters, including 
alphabetical characters, numbers, and symbols (including file extensions).
Filename: Select a filename.
LUT Type (User LUT, Gamma LUT, Gamut LUT): Select the LUT type.
Select LUT: Selects User LUT 1-8/Gamma LUT 1-8/Gamut LUT 1-8.
Base Color Gamut (SMPTE-C, EBU, ITU-R BT.709, Adobe RGB, DCI-P3, Native): Selects the 
color gamut used when creating the LUT (when "Gamut LUT" under "LUT Type" is selected).
Execute: Performs import.

LUT Name You can specify the name of LUT within one-byte 24 characters including alphabetical characters, 
numbers, and symbols.
LUT Type (User LUT, Gamma LUT, Gamut LUT): Select the LUT type.
Select LUT: Selects User LUT 1-8/Gamma LUT 1-8/Gamut LUT 1-8.
Input Name: Input the LUT name.

LUT Delete Deletes imported LUT.
LUT Type (User LUT, Gamma LUT, Gamut LUT): Select the LUT type.
Select LUT: Selects User LUT 1-8/Gamma LUT 1-8/Gamut LUT 1-8.
Delete: Deletes LUT.
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Item Setting Options (underline indicates factory default)

YCbCr Color 
Matrix

Sets the matrix conversion method for input signals in YCbCr format. 
Automatic: �Matrix coefficient is set in conformance with the ITU-R BT.2020 standard when the

 "Picture Mode" or "Color Gamut" setting is "ITU-R BT.2020" and in conformance with	
 the ITU-R BT.709 standard otherwise.

ITU-R BT.709: Matrix coefficient is set in conformance with the ITU-R BT.709 standard. 
ITU-R BT.2020: Matrix coefficient is set in conformance with the ITU-R BT.2020 standard.

2020 Constant 
Luminance

Sets the color matrix conversion method to be used when "ITU-R BT.2020" is selected for "Picture 
Mode" or "Color Gamut".
Constant Luminance: YUV signals are linearly converted and then converted into RGB signals.
Non-constant Luminance: �YUV signals are converted into RGB signals without changing gamma

 0.45.

Note

•	 SD-SDI is fixed to "Non-constant Luminance".

•	 If "Channel Settings" → "Picture Mode" → "Type" is "L/R", "2020 Constant Luminance" is fixed 
at "Non-constant Luminance" for the following. However, if "Color Gamut" for the left and right 
screens is "ITU-R BT.2020", then the right screen's setting will be the same as set for the left 
screen.
-- When displaying a single terminal’s input in full-screen
-- When displaying "2 Sample Interleave" or "Dual Link 3G-SDI" signals

2020 Gamut 
Mapping

Set this item when "ITU-R BT.2020" is selected for "Picture Mode" or "Color Gamut".
Gamut Mapping: Mapping is performed on colors outside the native color gamut by Canon's 

unique method.
Clipping: Colors outside the native color gamut are clipped by a general method.

Hybrid Log-
Gamma System

Sets the system gamma or peak luminance when selecting "Hybrid Log-Gamma" or "Hybrid Log-
Gamma RGB" in "Gamma/EOTF".
Automatic: When "Hybrid Log-Gamma" is selected, it adjusts the system gamma automatically to 
match the contrast value. It cannot be set when "Hybrid Log-Gamma RGB" is selected.
Manual: Operations for when "Hybrid Log-Gamma" or "Hybrid Log-Gamma RGB" is selected are as 
follows:
	 When "Hybrid Log-Gamma" is selected:	Adjusts the system gamma.

1.000 to 1.500 (1.200, 0.005 increments)
	 When "Hybrid Log-Gamma RGB" is selected:	Sets the peak luminance. The maximum value 

for each setting becomes the upper limit value of "HDR Range".	
γ1.2 - 1000 cd/m2, γ1.2 - 2000 cd/m2

HDR/SDR View The HDR (High Dynamic Range) and SDR (Standard Dynamic Range) displays can be compared.
On: The right screen is displayed at SDR luminance.
Off: Does not compare the HDR and SDR display.

Note

•	 This cannot be set when the "Picture Mode" setting for the left and right screens is the same.

•	 When the "Contrast" setting for the left screen is specified as "1000" or less, the luminance of 
the left and right screens is the same.
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Item Setting Options (underline indicates factory default)

Calibration Performs calibration based on set target values when "User 1-7" is selected for "Picture Mode".
Luminance: Sets the target luminance.
	 48 to 500 (100) cd/m2

Color Temperature: Sets the target color temperature.
	 D93, D65, D61, D60, D56, D50, DCI-P3: Select from preset color temperatures.
	 Custom (xy): You can adjust CIE x, y in increments of 0.001.
	 x: 0.260 to 0.360 (0.313)/y: 0.260 to 0.360 (0.329)
Color Gamut: Sets the color gamut.
	 SMPTE-C, EBU, ITU-R BT.709, ITU-R BT.2020, Adobe RGB, DCI-P3
Gamma: Sets the target gamma.
	 2.2, 2.35, 2.4, 2.6, ITU-R BT.1886
Start: Performs calibration.

Note

•	 When "Luminance" is set to high brightness, it may be calibrated beyond the brightness 
adjustment range and set lower than the target value, depending on the "Color Temperature" 
setting. In that case, set the "Luminance" again.

•	 Calibration cannot be executed in "Picture Mode" for the right screen.

HDMI Link When "User 1-7" is selected for "Picture Mode", video is displayed at the image quality linked to the 
video image quality setting using the HDMI metadata.
Automatic Adjustment
	 On, Off
Color Gamut/Gamma/EOTF: ‌�Matches the "Color Gamut" and "Gamma/EOTF" settings of the 

video display with the HDMI metadata.	
On, Off

Contrast/HDR Range: ‌�Matches the "Contrast" and "HDR Range" setting of the video display with 
the HDMI metadata.	
On, Off

Backlight Control: ‌�Matches the brightness setting of the video display with the HDMI metadata.
	 Peak luminance priority: ‌�Operates if "Peak Luminance Control" is "On" even when the 

average luminance of HDMI metadata is high.
	 Average luminance priority: ‌�Operates if "Peak Luminance Control" is "Off" when the 

average luminance of HDMI metadata is high.
	 Off

Note

•	 Parameter of HDMI metadata and Video Display

HDMI metadata Video display setting

Color Gamut
BT.709 ITU-R BT.709

BT.2020 ITU-R BT.2020

Gamma/EOTF

Traditional SDR 2.2

PQ PQ

Hybrid Log-Gamma Hybrid Log-Gamma

•	 Cannot set "HDMI Link" when "Channel Settings" → "Picture Mode" → "Type" is "L/R".
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Item Setting Options (underline indicates factory default)

Copy
Picture Mode

When "User 1-7" is selected for "Picture Mode", the content of the selected picture mode is copied. 
The following modes can be selected:
Picture Mode (Copy from): SMPTE-C, EBU, ITU-R BT.709, ITU-R BT.2020, Adobe RGB, 
DCI-P3, User 1-7 (other than the currently set parameter)
Execute: Performs copy.

Note

•	 In "Picture Mode" other than "User 1-7", the results of calibration performed at the factory are 
copied.

Picture
Mode Name

You can change the name of "User 1-7" within 24 characters including alphabetical characters, 
numbers, and symbols.

Anchor Adjustment Temporarily saves parameters for adjusting "Contrast", "Brightness", "Chroma", "Sharpness", and 
"HDR Range" and recover the values (anchor point setting).
OK: Performs anchor point setting.
Cancel: Returns to the previous screen without setting anchor point.

Reset Return "Picture Mode" to factory default. Note that in "User 1-7" mode where you are performing 
calibration, the setting returns to the value after calibration instead of the factory default.
When selected, the message "Reset Adjustment settings to defaults?" appears.
OK: Performs reset.
Cancel: Returns to the previous screen without resetting.
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The factory default settings for each "Picture Mode" is as follows:

Item SMPTE-C EBU
ITU-R 
BT.709

ITU-R  
BT.2020

Adobe
RGB

DCI-P3

Contrast 1000 1000 1000 1000 1000 480

Brightness 0 0 0 0 0 0

Chroma 1000 1000 1000 1000 1000 1000

Sharpness 0 0 0 0 0 0

Backlight Control Local Dimming Low

Color 
Temperature

Preset D65 D65 D65 D65 D65 DCI-P3

x 0.313 0.313 0.313 0.313 0.313 0.314

y 0.329 0.329 0.329 0.329 0.329 0.351

Gain R/G/B 1023/1023/1023 (When "D65 Custom" : 1000/1023/1023)

Bias R/G/B 0 0 0 0 0 0

Color Gamut SMPTE-C EBU ITU-R BT.709 ITU-R 
BT.2020

Adobe RGB DCI-P3

Gamma/EOTF 2.2 2.35 2.2 2.2 2.2 2.6

Color Range Automatic Automatic Automatic Automatic Automatic Automatic

Input Transform – – – – – –

Output Transform – – – – – –

Output Transform Surround – – – – – –

CDL/User LUT Off Off Off Off Off Off

Peak Luminance Control Off Off Off Off Off Off

YCbCr Color Matrix Automatic Automatic Automatic Automatic Automatic Automatic

2020 Constant Luminance Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

2020 Gamut Mapping Clipping Clipping Clipping Clipping Clipping Clipping

Hybrid Log-Gamma System – Manual (when "Hybrid Log-
Gamma": 1.200;  	

when "Hybrid Log-Gamma 
RGB": γ1.2-1000 cd/m2)

–

HDR/SDR View Off Off Off Off Off Off

HDMI Link Off Off Off Off Off Off

Picture Mode Name – – – – – –
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Item User 1 User 2 User 3 User 4 User 5-7

Contrast 10000 10000 10000 10000 1000

Brightness 0 0 0 0 0

Chroma 1000 1000 1000 1000 1000

Sharpness 0 0 0 0 0

Backlight Control Local Dimming Low

Color 
Temperature

Preset D65 D65 DCI-P3 D65 D65

x 0.313 0.313 0.314 0.313 0.313

y 0.329 0.329 0.351 0.329 0.329

Gain R/G/B 1023/1023/1023 (When "D65 Custom" : 1000/1023/1023)

Bias R/G/B 0 0 0 0 0

Color Gamut ITU-R 
BT.2020

ITU-R 
BT.2020

DCI-P3 DCI-P3 ITU-R BT.709

Gamma/EOTF SMPTE ST 
2084 (PQ)

Hybrid Log-
Gamma

SMPTE ST 
2084 (PQ)

SMPTE ST	
2084 (PQ)

2.2

Color Range Automatic Automatic Automatic Automatic Automatic

Input Transform – – – – –

Output Transform – – – – –

Output Transform Surround – – – – –

CDL/User LUT Off Off Off Off Off

Peak Luminance Control On On On On Off

YCbCr Color Matrix Automatic Automatic Automatic Automatic Automatic

2020 Constant Luminance Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

Non-constant 
Luminance

2020 Gamut Mapping Clipping Clipping Clipping Clipping Clipping

Hybrid Log-Gamma System Manual (when "Hybrid Log-Gamma": 1.200;  	
when "Hybrid Log-Gamma RGB": γ1.2-1000 cd/m2)

HDR/SDR View On On On Off Off

HDMI Link Off Off Off Off Off

Picture Mode Name User 1	
(2020 PQ)

User 2	
(2020 HLG)

User 3	
(DCI PQ)

User 4	
(DCI PQ D65)

User 5 to 
User 7
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Item CINEMA EOS SYSTEM ACESproxy (ver. 1.0.1)

Contrast 10000 480

Brightness 0 0

Chroma 1000 1000

Sharpness 0 0

Backlight Control Local Dimming Low

Color 
Temperature

Preset D65 D60

x 0.313 0.322

y 0.329 0.338

Gain R/G/B 1023/1023/1023 (When "D65 Custom" : 1000/1023/1023)

Bias R/G/B 0 0

Color Gamut ITU-R BT.2020 –

Gamma/EOTF Canon Log 2 (HDR) –

Color Range Automatic –

Input Transform – Automatic

Output Transform – DCI-P3

Output Transform Surround – Dark Surround

CDL/User LUT Off Off 

Peak Luminance Control On Off

YCbCr Color Matrix Automatic Automatic

2020 Constant Luminance Non-constant Luminance Non-constant Luminance

2020 Gamut Mapping Clipping Clipping

Hybrid Log-Gamma System Manual (when "Hybrid Log-
Gamma": 1.200;  	

when "Hybrid Log-Gamma 
RGB": γ1.2-1000 cd/m2)

–

HDR/SDR View Off Off

HDMI Link Off Off

Picture Mode Name – –
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Channel Settings

This menu is used for input related settings. Select the "Select Channel" and choose a channel number from CH1 to 
CH30. Finally define the parameter of each of the "Channel Settings".
 Supported Signal Format ( 112)

Item Setting Options

Select Channel Display the channel number. In addition, you can assign each content of "Channel Settings" to each 
channel ( 33).
CH1 to CH30

Note

•	 It may take 5 seconds when switching channels.

Input Configuration Select the input. Factory default depend on the channel ( 69).
 3G/HD-SDI, 3G-SDI RAW, SD-SDI, HDMI, — (Not set)
 12G-3G/HD-SDI, 3G-SDI RAW, SD-SDI, HDMI, — (Not set) 

Select Input Signal Sets the signal display method ( 19).
Automatic: The display method is automatically determined to match the input signal.
Quad Input: Four input signals (Input A to Input D) are displayed.
Dual Input A,B: �Two input signals (Input A terminal and Input B terminal) are displayed.
Dual Input C,D: Two input signals (Input C terminal and Input D terminal) are displayed.
Single Input A, Single Input B, Single Input C, Single Input D: One input signal (any of Input A 
to Input D) is displayed.

Note

•	 Settings that can be set differ according to the input signal.
-- SD-SDI: Only "Single Input A" to "Single Input D" can be selected.
-- HDMI: This is fixed to "Automatic".
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Item Setting Options

Image Division Sets the display method when "Input Configuration" is set to "3G/HD-SDI (  12-3G/HD‑SDI)" 
and "Select Input Signal" is set to "Quad Input" or "Dual Input." Two division methods "Square 
Division" and "2 Sample Interleave" are supported for 4K video signals.

■■ "Quad Input"

Automatic: Automatically determined based on payload and displayed.
Square Division: Displays a signal transmitted over four inputs as a single image.
2 Sample Interleave: Displays a signal transmitted divided into a 2K/HD signal as a single image.
Multi View (Quad): Displays the video of each of the four inputs in four screens.

■■ "Dual Input A,B" or "Dual Input C,D"

Automatic: Automatically determined based on payload and displayed.
Square Division: Displays a signal transmitted over four inputs as a single image.
2 Sample Interleave: Displays a signal transmitted divided into a 2K/HD signal as a single image.
Dual Link 3G-SDI: Displays a Dual Link 3G-SDI signal as a single image.
Multi View (Dual): �Displays the video of each of the two inputs (Input A,B or Input C,D) in two

 screens.

Select Input Signal: �Quad Input, Image Division: Square Division

Note

•	  The combinations of video signal formats that can be displayed when using two 
screens or four screens in "Multi View (Quad)" or "Multi View (Dual)" are as follows:
-- Resolution combinations: Same, or "4096x2160, 2048x1080", "3840x2160, 	
1920x1080"

-- When using a frame rate and I/P/PsF combination that is one of 	
"23.98P / 24P / 25P / 29.97P / 30P"	
"I (All) / PsF (All) / 47.95P / 48P / 50P / 59.94P / 60P"

-- (Quad screen display only) For both left and right, when the top and bottom screen video 
signal frame rates and I/P/PsF are the same

•	 There may be periodical deterioration in the image when inputting signals with differing frame 
rates or I/P/PsF.

Link Order Automatically detects and displays correct terminal order based on payload when using "2 Sample 
Interleave" or "Dual Link 3G-SDI".
Automatic, Off
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Item Setting Options

Format Sets the color format and gradation.

■■ SDI Signal

Automatic, 4:2:2 YCbCr 10-bit, 4:2:2 YCbCr 12-bit, 4:4:4 YCbCr 10-bit,  
4:4:4 YCbCr 12-bit, 4:2:2 ICtCp 10-bit, 4:2:2 ICtCp 12-bit, 4:4:4 ICtCp 10-bit,  
4:4:4 ICtCp 12-bit, 4:4:4 RGB 10-bit, 4:4:4 RGB 12-bit, 4:4:4 XYZ 10-bit, 4:4:4 XYZ 12-bit

■■ HDMI Signal

Automatic, 4:4:4 XYZ 12/10-bit

Note

•	 The HD-SDI signal is either "4:2:2 YCbCr 10-bit" or "4:2:2 ICtCp 10-bit".

•	 "SD-SDI" is fixed to "4:2:2 YCbCr 10-bit".

•	 For "3G-SDI RAW", the setting is fixed to "Automatic".

•	 The settings for correctly displaying ICtCp format signals are as follows.
-- "Picture Mode": "ITU-R BT.709" or "ITU-R BT.2020"
-- "Color Gamut": "ITU-R BT.709" or "ITU-R BT.2020"
-- "Gamma/EOTF": "SMPTE ST 2084 (PQ)", "Hybrid Log-Gamma" or "Hybrid Log-Gamma 
RGB"

•	 If you need to use the ICtCp format for SDI signals, select any of the following to match the 
signal: "4:2:2 ICtCp 10-bit", "4:2:2 ICtCp 12-bit", "4:4:4 ICtCp 10-bit", "4:4:4 ICtCp 12-bit"

•	 If "Automatic" is selected, they are rendered in a Payload that is selected in the order A → B → 
C → D.

•	 To use 4:4:4 XYZ 10-bit for SDI signals, select "4:4:4 XYZ 10-bit". Then, signals will be 
processed as signals where XYZ data is included in RGB data output in 4:4:4 RGB 10-bit 
format.

Audio Input Sets the audio terminal. Terminals that can be selected differ according to the setting of "Select Input 
Signal."
When "Quad Input": Automatic, Input A, Input B, Input C, Input D
When "Dual Input A,B": Automatic, Input A, Input B
When "Dual Input C,D": Automatic, Input C, Input D
Automatic: Sets automatically to match the input signal.

Note

•	 This setting is fixed at "Automatic" when "Select Input Signal" is "Automatic" or "Single Input".

Marker/TC/CameraInfo 
Input

Set the target terminal so that various markers (except Grid Marker), Time Code, and Camera 
Information are displayed. (Camera Information is available in the "Multi View (Quad)" display only)

When "Automatic" or "Quad Input": Input A, Input B, Input C, Input D
When "Dual Input A,B": Input A, Input B
When "Dual Input C,D": Input C, Input D

Note

•	 This setting becomes invalid except for the "Multi View (Quad)" or "Multi View (Dual)" display.

Internal Sync Sets whether to synchronize four inputs when "Square Division" is selected.
On: Force synchronization.
Off: Do not force synchronization.
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Item Setting Options

Channel Name Sets the name of the selected channel. You can input up to 16 alphanumeric characters.

Picture Mode Set "Picture Mode" by individual channel.

Type Normal: Set one "Picture Mode".
Picture Mode

L/R: Sets "Picture Mode" by individual left and right screen. Displays as "Single Input Dual View" 
when using resolutions of 2K or lower.

Picture Mode L, Picture Mode R
4K/2K: Sets "Picture Mode" by individual 4K or 2K signal screen.

Resolution 4K, Resolution 2K
Automatic: "Picture Mode" is set according to the SDI signal. The set "Picture Mode" is changed to 
in the order camera metadata → Payload → resolution (4K/2K).

Resolution 4K, Resolution 2K, Payload UHD/PQ, Payload UHD/HLG,  
Payload UHD, Payload 709/PQ, Payload 709/HLG, Payload 709, Payload VANC,  
Payload Unknown, Camera CINEMA EOS SYSTEM,  
Camera ARRI, Camera VARICAM

Note

•	 Settings that can be set differ according to the input signal.
-- "SD-SDI": "Type" is fixed to "Normal". "Automatic" cannot be set.
-- "3G-SDI RAW" and "HDMI": "Automatic" and "4K/2K" cannot be set in "Type".

•	 When "Type" is "L/R"
-- Setting the same "Picture Mode" for both left and right screens will cause "Picture Mode" 
in the non-selected screen to change to a different mode (for example, the "Picture Mode" 
settings of the left and right screens are switched).

-- When using a signal 2K or under, it is fixed at "Single Input Dual View".

Picture Mode Set the "Picture Mode" for each screen.

SMPTE-C, EBU, ITU-R BT.709, ITU-R BT.2020, Adobe RGB, DCI-P3,  
User 1 (2020 PQ), User 2 (2020 HLG), User 3 (DCI PQ), User 4 (DCI PQ D65),  
User 5 ~ User 7, CINEMA EOS SYSTEM
ACESproxy (ver. 1.0.1): Can be set when "Type" is "Normal".
— (Not set): Cannot automatically change image quality to suit input signal. Can be set when other 

than "Resolution 4K" and "Resolution 2K" are selected in "Type" → "Automatic".

•	 Colorimetry Bit/Transfer Characteristics of the SDI Payload ID supports the signal in conformity 
with the following standard.

	 SMPTE ST 2082-10:2018 (12G-SDI) 
	 SMPTE ST 2081-10:2018 (6G-SDI) 
	 SMPTE ST 425-1:2017 (3G-SDI Single Link / Square Division)
	 SMPTE ST 425-3:2019 (3G-SDI Dual Link(2SI) )
	 SMPTE ST 425-5:2019 (3G-SDI Quad Link(2SI) )
	 SMPTE ST 292-1:2018 (HD-SDI)

Picture Mode L

Picture Mode R

Resolution 4K

Resolution 2K

Payload UHD/PQ

Payload UHD/HLG

Payload UHD

Payload 709/PQ

Payload 709/HLG

Payload 709

Payload VANC

Payload Unknown

Camera CINEMA EOS 
SYSTEM

Camera ARRI

Camera VARICAM
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Item Setting Options

Single Input Dual View When other than "Image Division" → "Multi View (Quad)" or "Multi View (Dual)", the image from the 
input signal can be reduced and shown in dual-screen.
Automatic: ‌�When "Picture Mode" → "Type" is "L/R", or when the "Picture Function Settings" Sub 

Menu items are set to "On", identical images are automatically shown and dual-screen 
comparison can be made. 4K images are shown in reduced size.	
Relevant "Picture Function Settings" Sub Menu items: 	
"Peaking", "False Color", "Over Range", "2020 Outside of Gamut View", "Monochrome", 
"Blue Only", "Red Off", "Green Off", "Blue Off", and "Compare View"

Off

Note

•	 Cannot be used when unsupported video signal is input.

Separator In the following cases, screen borders will be displayed.
-- When "Picture Mode" → "Type" is "L/R"
-- When "Multi View (Quad)" or "Multi View (Dual)" is selected
-- When "Single Input Dual View" is set to "Automatic" and the images are shown next to each other 
for image comparison
-- When "Picture Function Settings" → "Compare View" → "Enable" is "On"

White, Half, Black, Off
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The factory default settings for each channel is shown in the following table.

CH CH1 CH2 CH3 CH4 CH5

Input 
Configuration

3G/HD-SDI HDMI 3G-SDI RAW 3G/HD-SDI 3G/HD-SDI

12-3G/HD-SDI HDMI 3G-SDI RAW 12-3G/HD-SDI 12-3G/HD-SDI

Select Input Signal Automatic Automatic Automatic Automatic Automatic

Image Division Automatic Automatic Automatic Automatic Automatic

Link Order Automatic Automatic Automatic Automatic Automatic

Format Automatic Automatic Automatic Automatic Automatic

Audio Input Automatic Automatic Automatic Automatic Automatic

Marker/TC/CameraInfo Input Input A Input A Input A Input A Input A

Internal Sync Off Off Off Off Off

Channel Name (Blank) (Blank) (Blank) (Blank) (Blank)

Picture Mode → Type Normal Normal Normal 4K/2K L/R

Picture Mode
Picture Mode L
Resolution 4K

ITU-R BT.709 ITU-R BT.709 CINEMA EOS 
SYSTEM

User 1 	
(2020 PQ)

User 1 	
(2020 PQ)

Picture Mode R
Resolution 2K

ITU-R BT.709

Payload UHD/PQ User 1 (2020 PQ)

UHD/HLG User 2 (2020 HLG)

UHD ITU-R BT.2020

709/PQ —

709/HLG —

709 ITU-R BT.709

VANC —

Unknown —

Camera CINEMA 
EOS         
SYSTEM

CINEMA EOS SYSTEM

ARRI User 6

VARICAM User 7

Single Input Dual View Off Off Off Automatic Off

Separator Off Off Off Off White
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CH CH6 CH7 CH8 CH9 CH10 to CH30

Input 
Configuration

3G/HD-SDI 3G/HD-SDI 3G/HD-SDI 3G/HD-SDI — (Not set)

12-3G/HD-SDI 12-3G/HD-SDI 12-3G/HD-SDI 12-3G/HD-SDI — (Not set)

Select Input Signal Automatic Automatic Automatic Automatic Automatic

Image Division Automatic Automatic Automatic Automatic Automatic

Link Order Automatic Automatic Automatic Automatic Automatic

Format Automatic Automatic Automatic Automatic Automatic

Audio Input Automatic Automatic Automatic Automatic Automatic

Marker/TC/CameraInfo Input Input A Input A Input A Input A Input A

Internal Sync Off Off Off Off Off

Channel Name (Blank) (Blank) (Blank) (Blank) (Blank)

Picture Mode → Type L/R 4K/2K L/R L/R Normal

Picture Mode
Picture Mode L
Resolution 4K

User 1 	
(2020 PQ)

User 2 	
(2020 HLG)

User 2 	
(2020 HLG)

User 2 	
(2020 HLG)

ITU-R BT.709

Picture Mode R
Resolution 2K

ITU-R BT.709

Payload UHD/PQ User 1 (2020 PQ)

UHD/HLG User 2 (2020 HLG)

UHD ITU-R BT.2020

709/PQ —

709/HLG —

709 ITU-R BT.709

VANC —

Unknown —

Camera CINEMA 
EOS         
SYSTEM

CINEMA EOS SYSTEM

ARRI User 6

VARICAM User 7

Single Input Dual View Automatic Automatic Off Automatic Off

Separator Off Off White Off Off



71OSD Menu

Display Settings

This menu is used to configure the display method.

Item Setting Options (underline indicates factory default)

Screen Scaling Defines how the video is scaled and displayed on the screen.
Native Input Resolution: Displays the input signal without scaling.

          1920x1080 (original)

200%: Doubles the vertical and horizontal dimensions.

     1920x1080→3840x2160

Automatic: Enlarges to full screen.

     1920x1080→3840x2160

Note

•	 In the following cases, the maximum magnification is 200% even if "Automatic" is selected.
-- When "Peaking", "False Color", or "Over Range" is "On"

Anamorphic Set when checking images photographed using an anamorphic lens. Displayed in accordance with 
the set magnification.
x2.0, x1.8, x1.5, x1.33, Off

Note

•	 Settings are invalid in the following cases:
-- When "Peaking", "False Color", or "Over Range" is set to "On"



72 OSD Menu

Item Setting Options (underline indicates factory default)

Scaling Method Sets the interpolation method when "Screen Scaling" is set to "200%" or "Automatic".
Shape Trace: Canon original processing that produces smooth slopes with reduced jagged lines.

Bicubic: General interpolation process that uses neighboring pixel information to create interpolated pixels.

Nearest Neighbor: Process that uses nearest neighbor pixel information to create (copy) new 
pixels. This is useful as it enlarges the original pixels, thus making any jagged lines visible.

Video Position
(Multi View)

When displaying on two or four screens ("Multi View (Quad)" or "Multi View (Dual)" or "Single Input 
Dual View" display), set the vertical display position for the image.
"Top": Displays at the top of the screen.
"Middle": Displays at the top middle of the screen.
"Center": Displays at the middle of the screen.
Top, Middle, Center
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Item Setting Options (underline indicates factory default)

Zoom Enlarges part of the video image. The zoom function can be used when the resolution is 
"4096x2160", "3840x2160", "2048x1080" or "1920x1080".

Note

•	 The zoom function cannot be used in the following cases:
-- During execution of "Playback File" under "Screen Capture"
-- During display of the test pattern
-- When calibration has been started
-- When "Multi View (Quad)" or "Multi View (Dual)" is selected
-- When "Channel Settings" → "Picture Mode" → "Type" is set to "L/R"
-- When "Picture Function Settings" → "Compare View" → "Enable" is set to "On"

•	 While the zoom function is in use, the following are not displayed: 	
Background Color, various markers

•	 When zoom settings are changed, "Frame Hold" turns "Off".

•	 When "Type" → "Normal" is selected: When the resolution is "2048x1080" or "1920x1080", 
the display position cannot be changed even if "Magnification" is set to "x2".

Zoom Preset Sets the zoom display method. There are three presets. 	
Zoom 1, Zoom 2, Zoom 3, Off

Magnification Sets the display scale of zoom. 
x2, x4, x8

Position The zoom adjustment screen is displayed. Use the jog dial to adjust the display position. 

Type Sets the enlarged image display method.
Normal: Only displays the enlarged image.
Single Input Dual View: Displays the overall image on the left and the enlarged image on the right.

Note

•	 When "Type" → "Single Input Dual View" is selected: For 4K video (3840x2160 or 4096x2160), 
the quality of the enlarged image will be degraded compared to "Normal".
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Item Setting Options (underline indicates factory default)

Frame Hold Pauses the video.
On, Off

Note

•	 Setting is disabled when "Peaking" is set to "On".

•	 If the image quality setting is changed while the video is paused, the setting may not change 
correctly.

Background Color Sets the color of the black band to check the boundary of the black band and video image.
White, Gray, Off

Note

•	 Setting is disabled when "Multi View (Quad)" or "Multi View (Dual)" is selected. 

I/PsF Defines how the interlace signal or PsF signal is displayed.
Automatic: ‌�Automatically determined based on payload and displayed. If there is no payload, the 

signal is displayed as an interlace signal.
Interlace: Displayed as an interlace signal.
PsF: Displayed as a PsF signal.

PsF Defines how the PsF signal is displayed.
Progressive: Interpolates giving preference to image quality by detecting paired fields.
Interlace: Interpolates using two adjacent fields giving priority to speed.

I/P Conversion Sets the interlaced signal I/P conversion method.
Image Priority: ‌�This mode gives priority to image quality. Processing time will be longer than "Speed 

Priority".
Speed Priority: This mode gives priority to speed.

Film Cadence Sets the film cadence mode.
2-2: Displays progressive image after conversion for 2-2 pulldown processed interlaced signal input.
2-3: Displays progressive image after conversion for 2-3 pulldown processed interlaced signal input.
2-3-3-2: ‌�Displays progressive image after conversion for 2-3-3-2 pulldown processed interlaced 

signal input.
Off: Does not perform film cadence mode progressive conversion.

Note

•	 This can be set only when "I/P Conversion" is set to "Image Priority".

•	 Cannot be set in the "Multi View (Quad)" or "Multi View (Dual)" display. The setting is fixed to 
"Off".
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Audio Settings

This menu is used to set audio output from the headphone terminal.

Item Setting Options (underline indicates factory default)

SDI Group Switches the audio group to be input during SDI audio input.
CH1-CH8, CH9-CH16

CH L/R (SDI) Sets the audio to be output from the two channels (L/R) of the headphone respectively. The options differ 
according to the "SDI Group" setting.
When "CH1-CH8" is selected for "SDI Group": CH1-CH8
When "CH9-CH16" is selected for "SDI Group": CH9-CH16

CH L/R (HDMI) Sets the audio to be output from the two channels (L/R) of the headphone respectively.
CH1-CH8

Volume Sets the volume. (Increments of 1)
0 to 100 (30)

Audio Switch Sets the stereo output.
L R, L, R, MIX (L+R)
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Marker Settings

This menu is used to configure various markers.

Item Setting Options (underline indicates factory default)

Marker Preset Customizes markers which are assigned to markers 1 to 5. 
Marker 1 to 5, Off

Aspect Marker "Aspect Marker" displays a range in accordance with the specified aspect ratio.

Note

"Aspect Marker" is not displayed in the following cases:

•	 When there is no signal, unsupported signal, or a channel with "Input Configuration" not set is 
selected

•	 When an enlarged image is displayed

•	 During the execution of "Playback File" under "Screen Capture"

•	 When a "Test Pattern" is displayed

Enable Switches the aspect marker On, Off.
On, Off

Mask Switches the mask color. Mask is the blanking area outside the range of the marker.
Black:

Half (50% gray):

Off: Turns mask off.

Aspect Ratio Sets the aspect ratio of the aspect marker.
16:9, 15:9, 14:9, 13:9, 4:3, 2.39:1, 2.35:1, 1.896:1, 1.85:1, 1.66:1, Variable
The aspect ratio can be entered as a numeric value when you select "Variable" (0.01:1 increments). The 
grayed out slider becomes active and can be used to set the aspect ratio.
1.00:1  to  3.00:1 (1.78:1)

Line Active when "Black" or "Half" is selected for "Mask". Switches lines on mask On, Off.
On, Off

Line Width Sets the thickness of the aspect marker line.
Thick, Normal, Thin
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Item Setting Options (underline indicates factory default)

Line Color Sets the color of the aspect marker line.
White, Red, Green, Blue, Yellow, Cyan, Magenta, Gray

Line 
Brightness

Sets the brightness of the aspect marker line.
High, Low, Half

H Position Changes horizontal position without changing the aspect.
-65  to  65 (0)

V Position Changes vertical position without changing the aspect.
-35  to  35 (0)

Safety Zone Marker 1, 2 There are two types of "Safety Zone Marker": 1 and 2, which share the same settings. A safety zone 
marker is used to set the safe zone of the image (actual displayed area) to check the image.

Note

"Safety Zone Marker" is not displayed in the following cases:

•	 When there is no signal, unsupported signal, or a channel with "Input Configuration" not set is 
selected

•	 When an enlarged image is displayed

•	 During the execution of "Playback File" under "Screen Capture"

•	 When a "Test Pattern" is displayed

Enable Switches the safety zone marker On, Off.
On, Off

Aspect Ratio Sets the aspect ratio of the safety zone marker.
16:9, 15:9, 14:9, 13:9, 4:3, 2.39:1, 2.35:1, 1.896:1, 1.85:1, 1.66:1, Variable
The aspect ratio can be entered as a numeric value when you select "Variable" (0.01:1 increments). The 
grayed out slider becomes active and can be used to set the aspect ratio.
1.00:1  to  3.00:1 (1.78:1)

Note

•	 When "Area Size" is set to "Variable (dot)", you cannot select "Aspect Ratio".

Area Size Sets the safety zone marker area size.
80%, 88%, 90%, 93%, Variable (%), Variable (dot)
When "Variable (%)" is selected, the grayed out "Rate (%)" becomes active. When "Variable (dot)" is 
selected, the grayed out "Width (dot)" and "Height (dot)" become active. This can be set by moving the 
slider.

Rate (%) Becomes active when you select "Variable (%)" under the menu "Area Size". Move the slider to set the 
displayed marker area size without changing the aspect ratio in 1 % increments.
50 to 100 (80)

Width (dot) Becomes active when you select "Variable (dot)" under the menu "Area Size". Move the slider to set the 
area width in 2 dot increment.
360 to 4096 (3276)

Height (dot) Becomes active when you select "Variable (dot)" under the menu "Area Size". Move the slider to set the 
area height in 2 dot increment.
240 to 2160 (1728)
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Item Setting Options (underline indicates factory default)

Shape Sets the area shape of the safety zone marker.
Box:

Brackets:

Enclosure:

Line Width Sets the width of the safety zone marker line.
Thick, Normal, Thin

Line Color Sets the color of the safety zone marker line.
White, Red, Green, Blue, Yellow, Cyan, Magenta, Gray

Line 
Brightness

Sets the brightness of the safety zone marker line.
High, Low, Half

H Position Adjusts the marker horizontal position with the set aspect and size.
-65 to 65 (0)

V Position Adjusts the marker vertical position with the set aspect and size.
-35 to 35 (0)
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Item Setting Options (underline indicates factory default)

Area Marker "Area Marker" is used to check a specific area using a rectangular box.

Note

"Area Marker" is not displayed in the following cases:

•	 When there is no signal, unsupported signal, or a channel with "Input Configuration" not set is 
selected

•	 When an enlarged image is displayed

•	 During the execution of "Playback File" under "Screen Capture"

•	 When a "Test Pattern" is displayed

Enable Switches the area marker On, Off.
On, Off

H Position Sets the start position (x-coordinate) to draw the rectangle (in increments of 2).  
0 to 4086 (240)

V Position Sets the start position (y-coordinate) to draw the rectangle (in increments of 2).  
0 to 2150 (120)

Width (dot) Sets the width of the rectangle (in increments of 2).
10 to 4096 (240)

Height (dot) Sets the height of the rectangle (in increments of 2).
10 to 2160 (120)

Mask Switches the mask color (in the marker).
Black, Half, Off

Line Turns On/Off the outlines of the rectangular box.
On, Off

Line Width Sets the width of the area marker line.
Thick, Normal, Thin

Line Color Sets the color of the area marker line.
White, Red, Green, Blue, Yellow, Cyan, Magenta, Gray

Line 	
Brightness

Sets the brightness of the area marker line.
High, Low, Half
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Item Setting Options (underline indicates factory default)

Center Marker "Center Marker" shows the center of the image.

Note

•	 "Center Marker" is not displayed when an enlarged image is displayed.

Enable Switches the center marker On, Off.
On, Off

Size Sets the size of the center marker.
Large, Middle, Small

Line Width Sets the width of the center marker line.
Thick, Normal, Thin

Line Color Sets the color of the center marker line.
White, Red, Green, Blue, Yellow, Cyan, Magenta, Gray

Line 
Brightness

Sets the brightness of the center marker line.
High, Low, Half

Grid Marker "Grid Marker" is marker used to check the horizontal and vertical position.

Note

•	 "Grid Marker" is not displayed when an enlarged image is displayed.  

Enable Switches the grid marker On, Off.
On, Off

Distance Sets the horizontal and vertical line distance.
160 dots, 240 dots, 320 dots

Line Width Sets the width of the grid marker line.
Thick, Normal, Thin

Line Color Sets the color of the grid marker line.
White, Red, Green, Blue, Yellow, Cyan, Magenta, Gray

Line 
Brightness

Sets the brightness of the grid marker line.
High, Low, Half
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Function Settings

This menu is used to set the image signal information display and the cinema camera link function.

Item Setting Options (underline indicates factory default)

Time Code Display the time code superimposed on the signal.

VITC  01:23:45.05

Note

•	 Settings of the video display that cannot be displayed, or input signal status ( 93)

•	 When "Multi View(Dual)" is displayed, the "H Offset" setting is invalid.

Enable Switches the time code display On, Off.
On, Off

Type Selects the type.
VITC, LTC

Note

•	 This setting becomes invalid when HDMI signal is input and is fixed to "VITC".

Size Selects the size.
Large, Small

Position Selects the display position.
Top Left, Top Right, Bottom Left, Bottom Right

Note

•	 This setting becomes invalid in the "Multi View (Dual)" display.

H Offset Adjusts the display position of the time code.
0 to 1460 (0)

Type String Display Sets display of VITC/LTC strings.
On, Off

Brightness Sets the Brightness of the strings.
Normal, Half
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Item Setting Options (underline indicates factory default)

Audio Level Meter Configures various settings for the audio level meter. Displays the audio level of the selected channel 
number.

 When using dual or quad screens, setting "Channel Settings" → "Audio Input" to "Automatic" 
will display multiple audio level meters. You can display up to eight channels on the screen overall.

Note

•	 Settings of the video display that cannot be displayed, or input signal status ( 93)
•	  When "Channel Settings" → "Audio input" is set to "Automatic":

-- When displaying as "Multi View (Quad)", "Channel No." becomes "2CH".
-- When displaying as "Multi View (Dual)", "Channel No." becomes "4CH".

Enable Switches the audio level meter On, Off.
On, Off

Channel Number 
(SDI)

Sets the number of channels displayed when SDI signal is input. Options change according to the 
setting for "SDI Group" under "Audio Settings".
When "CH1-CH8" is selected for "SDI Group": �2CH (CH1-CH2), 4CH (CH1-CH4), 

 6CH (CH1-CH6), 8CH (CH1-CH8), 
 8CH (1-4, 5-8) (CH1-CH8)

When "CH9-CH16" is selected for "SDI Group": �2CH (CH9-CH10), 4CH (CH9-CH12),
 6CH (CH9-CH14), 8CH (CH9-CH16), 
 8CH (1-4, 5-8) (CH9-CH16)

Note

•	 When "Channel Number (SDI)" is set to "8CH (1-4, 5-8)", if "Size" is set to "Large", the 
resulting display will be the same as for "8CH".

Channel Number 
(HDMI)

Sets the number of channels displayed when HDMI signal is input.
2CH (CH1-CH2), 4CH (CH1-CH4), 6CH (CH1-CH6), 8CH (CH1-CH8)

Size Sets the size of the display.
Large, Middle, Small

Peak Hold When set to "On", one second of audio signal at the peak is kept. 
On, Off

Reference Level Sets the reference level.
-40 to 0 (-20)

Brightness Sets brightness for the audio level meter.
Normal, Low, Half

Wave Form Monitor Configures various settings for the wave form monitor. On the wave form monitor, the horizontal axis 
shows the horizontal resolution of the video and the vertical line shows the signal level. To the right of 
the wave form monitor, "Color Range" and "HDR Range" information (vertical line) is displayed.

1023

-4%
0%

50 %

100 %

0

Signal level

IRE

Horizontal resolution of video

Note

•	 Settings of the video display that cannot be displayed, or input signal status ( 93)

Enable Switches the wave form monitor On, Off.
On, Off
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Item Setting Options (underline indicates factory default)

Select Signal Sets the waveform to be displayed.
Y, Cb, Cr, R, G, B

Display Type Sets the display type. When "Line" is selected, data for one line is displayed.
All, Line
  Selects the line to be displayed when "Line" is selected.
  Select Line: 1 to 2160

Scale Sets the scale of the wave form monitor.
Automatic: Sets in accordance with the "Gamma/EOTF" and "Color Range" settings.
IRE, ST 2084 (PQ) Full, ST 2084 (PQ) Limited, Hybrid Log-Gamma, Canon Log, Canon Log 
2, Canon Log 3, S-Log2, S-Log3, ARRI (Rec2100-PQ-1K-100), ARRI (Rec2100-HLG-1K-200): 
Select the scale.

Reference Line A guide is displayed at the specified position. "Reference Line" is not displayed when "1023" is 
selected.
4 to 1023

Reference Level Sets the range of the reference level. Tints the outside of the range of the reference level.
•	 In the case of "Gamma/EOTF" corresponding to the HDR range, parts that exceed the HDR range 
are tinted.

•	 When "Color Range" → "Limited", outside the limited range is tinted.

Automatic: Sets in accordance with the "Gamma/EOTF" and "Color Range" settings.
Manual: When you select "Manual", sets the reference level.
      Reference Level High: ‌�Sets the reference display level (high). "Reference Level High" is not 

displayed when "1023" is selected.	
468 to 1023

      Reference Level Low: ‌�Sets the reference display level (low). "Reference Level Low" is not 
displayed when "0" is selected.	
0 to 468

Color Sets the signals to be displayed and the color of signals exceeding the reference level.
Y, Cb, Cr, R, G, B: Selects the signal.
   Selects the color of the selected signal.
      White, Red, Green, Blue, Yellow, Cyan, Magenta
      Default value of each signal is shown below.
      Y (White), Cb (White), Cr (White), R (Red), G (Green), B (Blue)
Reference Level High, Reference Level Low: Selects the reference level.
      White, Red, Green, Blue, Yellow, Cyan, Magenta
      Default value of each reference level is shown below.
      Reference Level High (Magenta), Reference Level Low (Cyan)

Brightness Sets the Brightness of the wave form monitor.
Automatic: ‌�Brightness is automatically adjusted according to the contrast value and average 

brightness value of the input signal.
Normal, Low

Position Selects the display position.
Bottom Left, Bottom Right

Note

•	 This setting becomes invalid in the "Multi View (Dual)" display.

Size Sets the size of the display.	
Large, Middle, Small
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Item Setting Options (underline indicates factory default)

Vector Scope Configures various settings for the vector scope. Vector scope displays the intensity of color signals 
and hue with the horizontal axis showing the color difference signal Cb and the vertical line showing 
Cr.

Red

Green

Yellow Blue

Cyan

Magenta

(Cb, Cr) = (255, 255)

(Cb, Cr) = (0, 0)

Cr

Cb

Note

•	 Settings of the video display that cannot be displayed, or input signal status ( 93)

Enable Switches the vector scope On, Off.
On, Off

Target Sets the target.
75%, 100%, 75%+100%

Position Selects the display position.
Bottom Left, Bottom Right

Note

•	 This setting becomes invalid in the "Multi View (Dual)" display.

Size Selects the display position.
Large, Middle, Small

Histogram Displays the luminance distribution of the video.

Luminance Distribution
SDR Ratio

HDR Ratio

Average luminance

Peak luminance

Beyond HDR range

Enable Switches between displaying or hiding "Histogram".
On, Off
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Item Setting Options (underline indicates factory default)

Color Automatic: Unless "Picture Function Settings" → "False Color" → "Enable" is set to "Off", it will 
automatically adjust the display to match the "False Color" settings.

Normal: Displays in monochrome.
False Color: When "Gamma/EOTF" is set to "SMPTE ST 2084 (PQ)" or "Hybrid Log-Gamma", then 

it will adjust the display to match the "False Color" settings.	
When "False Color" → "Enable" is "False Color 1" or "Off": Match the "False Color 1" settings.
When "False Color" → "Enable" is "False Color 2": Match the "False Color 2" settings.

Gain Increases the displayed graph size.
x1, x2, x3

HDR Range On: Areas that exceed the HDR range will be tinted.
On (Clip): Areas that exceed the HDR range and areas that exceed the HDR range and are clipped 

will be tinted.
Off: Areas that exceed the HDR range will not be tinted.

HDR/SDR Ratio Switches between displaying or not displaying the "HDR/SDR Ratio" when "Gamma/EOTF" is set to 
"SMPTE ST2084 (PQ)" or "Hybrid Log-Gamma". The ratio calculation for HDR/SDR uses the "False 
Color" → "HDR/SDR Border" settings.
On, Off

Peak/Ave. 
Luminance

Switches between displaying or not displaying the "Peak/Ave. Luminance" when "Gamma/EOTF" is 
set to "SMPTE ST2084 (PQ)" or "Hybrid Log-Gamma".
On, Off

Size Sets the size of the display.
Large, Small

Note

•	 Fixed to "Small" during "Single Input Dual View".
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Item Setting Options (underline indicates factory default)

Frame Luminance Monitor When "Gamma/EOTF" is set to "SMPTE ST 2084 (PQ)" or "Hybrid Log-Gamma", "Max./Ave. 
Luminance" for the entire screen (frame) is displayed. For other conditions, "Max./Ave. Gradation 
Values" is displayed. The frame luminance monitor can be used when the resolution is "4096x2160", 
"3840x2160", "2048x1080" or "1920x1080".

Current value for peak luminance 	
(cumulative maximum value)

Current value for average luminance 	
(cumulative maximum value)

Peak luminance

Average luminance

•	 Luminance graph

Average luminance

Current value for peak luminance 	
(cumulative maximum value)

Current value for average luminance 	
(cumulative maximum value)

Peak luminance

Luminance 
distribution graph

•	 Ratio graph

HDR Ratio SDR Ratio

Note

•	 Settings of the video display that cannot be displayed, or input signal status ( 93)

•	 The update time for "Frame Luminance Monitor" may take a long duration, or graph indication 
of "Frame Luminance Monitor" may be reset when displaying the "Frame Luminance Monitor" 
and operating the OSD menu.
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Item Setting Options (underline indicates factory default)

Enable Sets "Frame Luminance Monitor" on or off. Obtains the luminance value when valid.
On, Off

Display Sets whether each graph is displayed.
All: Displays "Luminance Graph (Including luminance value)" and "HDR/SDR Ratio Graph".
Luminance Graph: Displays "Luminance Graph".
HDR/SDR Ratio Graph: Displays "HDR/SDR Ratio Graph (Including luminance value)".
Luminance Value: Displays the peak and average luminance values.
Off: Does not display any graphs.

Luminance Graph 
Settings

Sets "Luminance Graph" display method.

Luminance Distribution:	�Switches between displaying and not displaying the luminance distribution 
graph. 	
On, Off

Color
  Automatic:	 �Unless "Picture Function Settings" → "False Color" → "Enable" is set to "Off", it will 

automatically adjust the display to match the "False Color" settings.
  Normal: Displays in monochrome.
  False Color:	 �When "Gamma/EOTF" is set to "SMPTE ST 2084 (PQ)" or "Hybrid Log-Gamma", 

then it will adjust the display to match the  "False Color" settings.	
When "False Color" → "Enable" is "False Color 1" or "Off": Match the "False Color 1" 
settings.	
When "False Color" → "Enable" is "False Color 2": Match the "False Color 2" settings.

Reference Luminance Level - Peak
  Automatic:	 �Works in conjunction with the "HDR Range" settings to automatically tint the areas 

that exceed the peak luminance.
  Manual:	�Sets the upper limit for peak luminance. Areas that exceed the set value will be tinted. 

(400 to 4000: increments of 100, 4000 to 10000: increments of 1000)	
400 to 10000 (1000)

Reference Luminance Level - Ave.:	 �Areas that exceed the set value will be tinted. 
(Increments of 100)	
100 to 1000 (400)

Reference Lum. Rise Level - Peak:	 �Sets the peak luminance rise reference value.  (Increments of 
10 cd/m2)
0 to 1000 (400)

Reference Lum. Rise Level - Ave.:	�Sets the average luminance rise reference value.  (Increments 
of 10 cd/m2)
0 to 1000 (200)

HDR/SDR Ratio 
Graph Settings

Sets "HDR/SDR Ratio Graph" display method. The ratios for HDR and SDR use the "False Color" → 
"HDR/SDR Border" settings as well as the settings for each range.
Type
  HDR/SDR: Displays the ratio between the HDR and SDR areas.
  HDR: Displays the ratio of luminance in the HDR area.
Scale: When "Type" is set to "HDR", sets the scale of the luminance value.
  Automatic, 100%, 75%, 50%, 25%

Size Sets the size of the display.
Large, Small

Note

•	 Fixed to "Small" during "Single Input Dual View".

Reset Resets the displayed content.

Export The luminance information obtained when "Frame Luminance Monitor" is valid, is exported to the 
USB memory.
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Item Setting Options (underline indicates factory default)

Pixel Value Check When "Gamma/EOTF" is set to "SMPTE ST 2084 (PQ)" or "Hybrid Log-Gamma", the luminance and 
RGB value of the specified pixel (cursor) position are measured and displayed. The pixel value check 
can be used when the resolution is "4096x2160", "3840x2160", "2048x1080" or "1920x1080".

Note

•	 Settings of the video display that cannot be displayed, or input signal status ( 93)

•	 The update time for "Pixel Value Check" may take a long duration when displaying the "Pixel 
Value Check" and operating the OSD menu.

Enable Switches the "Pixel Value Check" On, Off.
On, Off

H Position Sets the pixel position (horizontal).
1 to 4096 (960)

V Position Sets the pixel position (vertical).
1 to 2160 (540)

Reset Position Sets operation when the RESET button is pressed.
Normal: Resets the value to the default value.
Around Peak Luminance: Moves closer to the area of peak luminance inside the display image.

Test Pattern Sets the test pattern built into the main unit.
White (1023), White (940), Gray, Black (64), Black (0), Ramp, Color Bars, Color Bars (PQ 
Full), Color Bars (PQ Limited), Color Bars (HLG), PLUGE, PLUGE (PQ/HLG), Off

Note

•	 If the power is turned off once and then back on, the test pattern will not be displayed.

•	 The test pattern will be erased in the following cases:
-  When calibration has been started
-  When a channel is changed using the CH button, F button assigned for Channel UP/
Channel DOWN, or "Select Channel" under "Channel Settings"

-  When changing "Input Configuration" or "Select Input Signal" under "Channel Settings"
-  When "Reset All Settings" is executed

Signal Monitoring Monitors the input signal status.

Note

•	 "Signal Monitoring" cannot be used in the following cases: 
-- When "Single Input Dual View" is displayed
-- When an enlarged image is displayed
-- During display of the test pattern
-- During execution of "Playback File" under "Screen Capture"

•	 When an error is displayed, "In Monitor Display" will not be shown.

•	 The position the error is displayed can be adjusted with "In Monitor Display" → "Position".

Control Sets whether "Signal Monitoring" is used or not. 	
On, Off

Error Hold Sets the length of time for displaying errors, when they are detected.
On (No time out):	�Errors continue to be displayed. To hide the displayed error, press the RESET 

button when closing the OSD menu.
On (5 sec.): �The displayed error will disappear 5 seconds after the initial detection.
Off: �Only displays errors during the period when they are detected. The displayed error message will

 disappear once the error ends.
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Item Setting Options (underline indicates factory default)

No Signal/
Unsupported Signal

Displays an error when there is no signal or the signal is not supported.
On, Off

2SI Link Order Displays an error when the cables inserted into the input terminals are in the wrong order when using 
signals input via "2 Sample Interleave".
On, Off

 SDI CRC 
Error

Displays an error when an incorrect SDI signal is detected (CRC error).
On, Off

 8K 2SI 
Format

Monitors the input signal status for the four terminals using the SDI signal when "Channel Settings"    
"Select Input Signal" is set to "Automatic".
On, Off

 8K 2SI 
Switching

When there is no "8K 2SI Format" error, displays while switching video between each terminal 
(12G-SDI signal only).
On, Off

Note

•	 Does not operate in the following cases:
-- When "Frame Hold" is "On"

Error Log Displays error history.

Screen Capture Captures the screen.

Capture Captures the screen. The data is saved under the name "YYYYMMDD_hhmmss.bmp" or 
"YYYYMMDD_hhmmss.jpg" in the root folder of the USB memory.

Frame Hold Pauses the video.
On, Off

Capture Source Selects the sources to capture.
All: Everything is captured including video assistance functions such as markers and wave form 

monitor as well as OSD menu.
Video: Only video signals are captured.

File Type Sets the File Type of the image to capture.
Bitmap, JPEG

Create HDR/SDR 
Compare File

Creates a file that lets you compare the brightness of HDR and SDR images on a computer. When 
saving, [_pc] is appended to the file name.
On, Off

Playback File Plays back captured images.
Select File: Selects a file.
Execute: Plays back the image.

Note

•	 When playing back captured images on other DP-V2420/DP-V2421 or PC, color may not be 
played back precisely.

•	 Cannot replay HDR/SDR comparison images with [_pc] in the file names.

Finish Playback File Finishes playback.
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Item Setting Options (underline indicates factory default)

Camera Link Sets the functions to link with Cinema EOS cameras and ARRI / Panasonic cinema cameras.

Automatic 
Adjustment 
(CINEMA EOS)

Sets whether or not to link to the camera's image quality setting when "CINEMA EOS SYSTEM" is 
selected for "Picture Mode". (When "Input Configuration" is "3G/HD-SDI (  12-3G/HD-SDI)" or 
"3G-SDI RAW")
On, Off
When "Color Gamut/Gamma/EOTF", "Color Temperature", and "Color Range" are all set to "On", the 
following settings are configured.

Parameter of Cinema EOS cameras and video display

Cinema EOS cameras DP-V2420 / DP-V2421

Color Space Color Gamut Color Temperature

BT.709 ITU-R BT.709 D65

BT.2020  ITU-R BT.2020 D65

DCI-P3 DCI-P3 DCI-P3

DCI-P3+ DCI-P3+ to 709 D65

DCI-P3+ to DCI-P3 DCI-P3

Cinema Gamut Cinema Gamut to 709 D65

Cinema Gamut to 2020 D65

Cinema Gamut to DCI-P3 DCI-P3

RAW Gamut Cinema Gamut to 709 D65

Cinema Gamut to 2020 D65

Cinema Gamut to DCI-P3 DCI-P3

Cinema EOS cameras DP-V2420 / DP-V2421

Gamma/EOTF Gamma/EOTF HDR Range

Canon Log Canon Log (HDR) —

Canon Log 2 Canon Log 2 (HDR)

RAW Gamma

Canon Log 3 Canon Log 3 (HDR)

ST 2084, PQ  SMPTE ST 2084 (PQ) 1000

Normal (BT.709) 2.2 —

Wide DR

EOS Std.

DCI-P3 2.6

Color Gamut/Gamma/EOTF: ‌�The image quality of the display corresponds to the camera's 
settings.	
On, Off

Color Temperature: ‌�The image quality of the display corresponds to the camera's settings.
On, Off

Display Color Gamut: ‌�Sets the color gamut shown on the display when the camera's "Color 
Space" is set to "Cinema Gamut" or "DCI-P3+".	
ITU-R BT.709, ITU-R BT.2020, DCI-P3
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Item Setting Options (underline indicates factory default)

Automatic 
Adjustment (ARRI)

Sets whether or not to link to the camera's image quality setting when "User 6-7" is selected for 
"Picture Mode". (When "Input Configuration" is "3G/HD-SDI (  12-3G/HD-SDI)")
On, Off

Parameter of ARRI Cinema camera and video display 

ARRI Cinema 
camera

DP-V2420 / DP-V2421

Color Space Display Color 
Gamut

CDL/	
User LUT

Color 
Gamut

Gamma/
EOTF

HDR Range

REC 709 — — ITU-R 
BT.709

2.2 —

REC 2020 — — ITU-R 
BT.2020

2.2 —

Wide Gamut 
Log C

Rec2100-PQ-
1K-100

ARRI (Rec2100-
PQ-1K-100)

ITU-R 
BT.2020

SMPTE ST 
2084 (PQ)

1000

Rec2100-HLG-
1K-200

ARRI (Rec2100-
HLG-1K-200)

ITU-R 
BT.2020

Hybrid Log-
Gamma

—

User LUT 1-8 User LUT 1-8 — — —

User LUT: ‌�Sets the color gamut and gamma/EOTF shown on the display when "Automatic 
Adjustment (ARRI)" is set to "On".	
Rec2100-PQ-1K-100, Rec2100-HLG-1K-200, User LUT 1-8

Automatic 
Adjustment 
(VARICAM)

Sets whether or not to link to the camera's image quality setting when "User 6-7" is selected for 
"Picture Mode". (When "Input Configuration" is "3G/HD-SDI (  12-3G/HD-SDI)")
On, Off

Parameter of Panasonic Cinema camera and video display

Panasonic 
Cinema 
camera

DP-V2420 / DP-V2421

Color Space Display Color 
Gamut

CDL/	
User LUT

Color 
Gamut

Gamma/
EOTF

HDR Range

V-709 — — ITU-R 
BT.709

2.2 —

V-Log V-Log to V-709 VARICAM (V-Log 
to V-709)

ITU-R 
BT.709

2.2 —

User LUT 1-8 User LUT 1-8 — — —

User LUT: ‌�Sets the color gamut and gamma/EOTF shown on the display when "Automatic 
Adjustment (VARICAM)" is set to "On".	
V-Log to V-709, User LUT 1-8
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Item Setting Options (underline indicates factory default)

Anamorphic When a Canon camera is connected, displays in accordance with the settings when anamorphic 
lens display settings are included in the camera metadata.
On, Off

Area Marker When an ARRI cinema camera is connected to this device, the "H Position", "V Position", "Width", 
and "Height" for the "Area Marker" change depending on the metadata.
ARRI Frame line 1A, ARRI Frame line 1B, Off

Note

•	 This cannot be displayed when "Marker Preset" is "Off".

Fan Allows you to link stopping the fan to the camera's recording operation (For Cinema EOS cameras, 
Canon professional-use video cameras, or ARRI cinema cameras that are compatible with this video 
display). When "Fan Control" under "System Settings" is set to "On", the mode changes so that 
the fan can be stopped, and when "Fan" is set to "On", the fan can be stopped by linking with the 
camera's REC signal. At room temperature (25 °C), the fan remains off for approximately one minute. 
The fan operates at a faster speed than usual before and after the fan is stopped to lower the internal 
temperature.
On, Off

Note

•	 If the temperature inside the main unit increases while the fan is off, the message "Fan will be 
rotated as the temperature is high." is displayed and the fan starts rotating approximately ten 
seconds later. Since the temperature of the main unit has increased, the fan rotates faster than 
usual.

•	 The video display's fan may start rotating earlier than the camera because the temperature 
inside the main unit has increased.

•	 The fan may not stop in some conditions, for example when used at a high temperature.

Camera Information Sets conditions to display camera information.
Automatic: Camera information is displayed for 4 seconds when the information has changed.
On: Camera information is always displayed.
Off: Camera information is not displayed.
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The information display functions that can be displayed vary depending on the video display's settings or the input 
signal status.

=: Can view   —: Cannot view

Time
Code

Audio Level
Meter

Wave 
Form

Monitor

Vector
Scope

Histo-
gram

Frame
Luminance

Monitor

Pixel Value
Check

With an SD-SDI signal = = — — — — —

While zooming: When "Zoom" → "Type" is set to 
"Normal"

= = — — — — —

When "Frame Hold" is "On"
(For progressive signals)

— — = = = = =

When "Frame Hold" is "On"	
(For interlaced or PsF signals)

— — — — = = =

When "Peaking" → "Enable" is set to "Peaking 1" or 
"Peaking 2"

= = — — = = =

During execution of "Playback File" under "Screen 
Capture"

— — — — — — —

When the display position and "Audio Level Meter" 
to be displayed is the same

— = = = = =

When "Test Pattern" is displayed — — — — — — —

When "Multi View (Quad)" is displayed = = — — — — —

When "Multi View (Dual)" is displayed = = = = — — —

When "Single Input Dual View" is displayed = = = = = = —

When "Channel Settings" → "Picture Mode" → 
"Type" is set to "L/R": When "Multi View (Dual)" or 
"Single Input Dual View" is displayed

= = = = — — —

When "Channel Settings" → "Picture Mode" → 
"Type" is set to "L/R", and when a single screen is 
being used

= = — — — — —

When "Picture Function Settings" → "Compare 
View" → "Enable" is set to "On": When "Single Input 
Dual View" is set to "Off" and also the resolution is 
4096x2160 or 3840x2160

= = — — — — —

When "Wave Form Monitor" is displayed: When 
"Wave Form Monitor" → "Select Signal" is "R", "G", 
"B"

= = = — = = =

When "Wave Form Monitor" is displayed and "Wave 
Form Monitor" → "Size" is "Large": When the 
"Position" settings for "Wave Form Monitor" and 
"Vector Scope" are the same, or when using "Multi 
View (Dual)" / "Single Input Dual View" display

= = = — = = =

When an I/PsF 4K signal is displayed on one screen 
and when the "Wave Form Monitor" and "Vector 
Scope" "Position" settings are the same

= = = — = = =

When there is no signal or the input signal is not 
supported

= = = = — — —

When displaying video at resolutions other than 
4096x2160 / 3840x2160 / 2048x1080 / 	
1920x1080

= = = = — — —
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Picture Function Settings

This menu is used to set video assistance functions, for example.

Item Setting Options (underline indicates factory default)

Peaking The outline is displayed in a color, used to check the focus. Customizes "Peaking" and sets it to 
"Peaking 1" or "Peaking 2".

Note

•	 "Peaking" cannot be displayed during the execution of "Playback File" under "Screen Capture".

•	 Cannot set when "Compare View" → "Enable" is "On".

Enable Switches the peaking display mode and also sets peaking to Off.
Peaking 1, Peaking 2, Off

Note

•	 "Enable" changes to "Off" when the power is turned on again.

Monochrome Displays video in monochrome.	
Peaking 1 (On, Off), Peaking 2 (On, Off)

Frequency Sets the central frequency of contour enhancement signals.	
Peaking 1 (Low, Middle, High), Peaking 2 (Low, Middle, High)

Range Sets the width of the range to be colored.	
-3 ~ 3 (0)

Color Sets the color to be used.	
White, Red, Green, Blue, Yellow, Cyan, Magenta

False Color Displays different colors for the video's brightness levels to make it easier to check the exposure and 
brightness distribution. Customizes "False Color" and sets it to "False Color 1" or "False Color 2".

Note

•	 "False Color" cannot be displayed during the execution of "Playback File" under "Screen Capture".

•	 Cannot set when "Compare View" → "Enable" is "On".

Enable Switches between False Color display mode and non-display.
False Color 1, False Color 2, Off

Note

•	 "Enable" changes to "Off" when the power is turned on again.

Type Sets the tint color display method.
Automatic: Sets in accordance with the "Gamma/EOTF" settings.
IRE, SMPTE ST 2084 (PQ), Hybrid Log-Gamma

Note

•	 When "IRE" in "Type" is selected, "HDR Range" settings become invalid.

HDR/SDR 
Border

Sets whether to tint the SDR/HDR areas.
100, 200
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Item Setting Options (underline indicates factory default)

Range - SDR Sets the upper limit for the SDR area.
False Color 1 (On, Off), False Color 2 (On, Off)
When "On" is selected, sets the size of the area to be colored. (increments of 10)
   Monochrome/Brown: 10 to 190 (90*) (40)
   Brown/Monochrome: 20 to 200 (100*) (80)
			*	When	"HDR/SDR	Border"	is	"100"

Range - HDR Sets the tint color range.
False Color 1 (Automatic, Automatic (Over Range), Manual), False Color 2 (Automatic, 
Automatic (Over Range), Manual)
Automatic: Sets the upper limit automatically in accordance with the "Gamma/EOTF" settings.

When "Manual" or "Automatic (Over Range)" is selected, sets the size of the area to be colored.
SMPTE ST 2084 (PQ): The settings are as follows. (100 to 1000: 10 increments, 1000 to 4000: 
100 increments, 4000 to 10000: 1000 increments)
Blue/light blue: 250 (150*) to 400
Light blue/green: 400 to 1000
Green/yellow: 600 to 4000
Yellow/orange: 800 to 8000 
Orange/red: 1000 to 10000 (Only when using "Manual")
Hybrid Log-Gamma: The settings are as follows. (10 increments)
Blue/light blue: 250 (150*) to 300
Light blue/green: 300 (200*) to 500
Green/yellow: 400 (300*) to 700
Yellow/orange: 500 (400*) to 900 
Orange/red: 600 (500*) to 1000 (Only when using "Manual")

			*	When	"HDR/SDR	Border"	is	"100"

Over Range Displays video in monochrome, with the areas where the set range is exceeded are shown tinted.

Note

•	 Cannot set when "Compare View" → "Enable" is "On".

Enable Switches the "Over Range" On, Off.
On, Off

Note

•	 "Enable" changes to "Off" when the power is turned on again.

Range (HDR) Automatic: ‌�When "Gamma/EOTF" → "SMPTE ST 2084" or "Hybrid Log-Gamma", only the areas 
that exceed the "HDR Range" setting are tinted.

Manual: ‌�Only areas that exceed the range set at "SMPTE ST 2084 (PQ)" or "Hybrid Log-Gamma" 
are tinted.

When you select "Manual", sets the reference level.
SMPTE ST 2084 (PQ): ‌�Sets the tint color range. (100 to 1000: 10 increments, 1000 to 4000: 100 

increments, 4000 to 10000: 1000 increments)	
100 to 10000 (1000)

Hybrid Log-Gamma: ‌�Sets the tint color range. (10 increments)
100 to 1000 (1000)

Range (SDR) Sets the tint color range. (1 increments)
512 to 1023 (940)
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Item Setting Options (underline indicates factory default)

2020 Outside of Gamut 
View

When "ITU-R BT.2020" is selected for "Picture Mode" or "Color Gamut", displays video in 
monochrome, with the areas where the color gamut exceeds the selected color gamut shown in red.

Note

•	 Cannot set when "Compare View" → "Enable" is "On".

Enable Switches between On and Off for "2020 Outside of Gamut View".
On, Off

Note

•	 "Enable" changes to "Off" when the power is turned on again.

Color Gamut Sets the "Color Gamut" to be set as out of color gamut.
ITU-R BT.709, Native

Range Sets the range when tinting dark areas. (1 increments)
0 to 512
0: Tints all dark areas.
512: Dark areas at the set values or less are not tinted.

Monochrome Video is displayed in monochrome.
On, Off

Note

•	 Cannot set when "Compare View" → "Enable" is "On".

•	 When the power is turned off and on, becomes "Off".

Blue Only Cuts red and green signals, and displays only blue signals in monochrome.
On, Off

Note

•	 "Blue Only" cannot be set when "CDL/User LUT" is a setting other than "CDL 1-8" or "Off".

•	 Cannot set when "Compare View" → "Enable" is "On".

•	 When the power is turned off and on, becomes "Off".

Red Off Video is displayed with red signals cut.
On, Off

Note

•	 Cannot set when "Compare View" → "Enable" is "On".

•	 When the power is turned off and on, becomes "Off".  

Green Off Video is displayed with green signals cut.
On, Off

Note

•	 Cannot set when "Compare View" → "Enable" is "On".

•	 When the power is turned off and on, becomes "Off".

Blue Off Video is displayed with blue signals cut.
On, Off

Note

•	 Cannot set when "Compare View" → "Enable" is "On".

•	 When the power is turned off and on, becomes "Off".
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Item Setting Options (underline indicates factory default)

Compare View Images having different image quality settings are displayed on the left and right screens for 
comparison. (When "Picture Mode" for left and right screens is the same)

Note

•	 "Compare View" cannot be set in the following cases:
-- When "Channel Settings" → "Picture Mode" → "Type" is "L/R"
-- When "Peaking", "False Color", "Over Range" or "2020 Outside of Gamut View" → "Enable" 

→ "On"

-- When "Monochrome", "Blue Only", "Red Off", "Green Off" or "Blue Off" → "On"
-- For SD-SDI signals

•	 When a signal with a resolution of 2K or smaller is displayed on a single screen, changes to 
"Single Input Dual View".

Enable Sets Comparison mode On or Off.
On, Off

Type Sets the type of the image to compare.
Automatic:	�"HDR/SDR" when "Adjustment" → "CDL/User LUT" is "Off", otherwise set at "CDL/User 

LUT".
HDR/SDR: HDR and SDR images are displayed.
CDL/User LUT: ‌�The image on which "CDL" or "User LUT" is applied is displayed only in the left 

screen.

HDR/SDR 
Convert 
Method

Sets the display method for the screen set in SDR when "Type" is set to "HDR/SDR" or "Automatic 
("HDR/SDR" settings)".
2020 HDR to 709 SDR, 2020 HDR to 2020 SDR: Setting differs according to the "Gamma/EOTF" 
settings.
"SMPTE ST 2084 (PQ)": The "User LUT" corresponding to each setting is applied.
"Hybrid Log-Gamma": The "User LUT" corresponding to each setting is applied.
"Canon Log(HDR)", "Canon Log 2(HDR)", "Canon Log 3(HDR)": "Canon Log", "Canon Log 2" or 
"Canon Log 3" is applied.
"S-Log2 (HDR)", "S-Log3 (HDR)": "HDR Range" setting "100" is set.

User LUT 1-8: �The specified "User LUT" is applied. After applying "User LUT" the adjustment inside
 the display fixes "Color Gamut" at "ITU-R BT.709" and "Gamma/EOTF" at "2.4".

Off: Only brightness is lowered.

Adjusts the SDR image quality when "Type" is set to "HDR/SDR" or "Automatic ("HDR/SDR" 
settings)".
Contrast (SDR): Sets the contrast on the SDR side.
  500 to 2000 (1000)
Color Temperature (SDR): Sets the color temperature on the SDR side.
  Normal, D93, D65, D65 Custom, DCI-P3
Gain (SDR): Sets the gain on the SDR side.
  -15 to 15 (0)
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Item Setting Options (underline indicates factory default)

User LUT  
Target 1

Sets the comparison target when "Type" is set to "CDL/User LUT" or "Automatic ("User LUT" 
settings)".
User LUT 1 to User LUT 8, Off

 User 
LUT Target 2 
(Quad)

Sets the comparison target when "Type" is set to "CDL/User LUT" or "Automatic ("User LUT" 
settings)".
User LUT 1 to User LUT 8, Off
User LUT 1-8: �Applies the User LUT separately for each quarter screen and displays comparisons

 when displaying "Multi View (Quad)".
  User 

LUT Target 3 
(Quad)
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Network/IMD Settings

Make the settings for networking of the main unit and remote operation by external devices.

Item Setting Options (underline indicates factory default)

LAN Configures video display's network settings.

Note

•	 Setting is disabled when "Power on Setting" is set to "User 1-3".

Configure an IP 
Address

Automatic: Configures an IP address automatically with DHCP/Automatic IP.
Manual: Configure an IP address and subnet mask manually.

Display 192.168.0.1

Subnet Mask 255.255.255.0

Wi-Fi This is used to connect the video display to a network using Wi-Fi and control it from an external 
control device. ( 36)

Control Sets the Wi-Fi connection method.
Infrastructure: This method connects to Wi-Fi via an access point.
Access Point: �This device acts as an access point, and this method connects the device directly to

 the Wi-Fi device.
Off: Does not connect to Wi-Fi.

Infrastructure Sets the access point to connect to. At factory settings, the access point to connect to is not 
configured.
Password: �You may specify a password if needed by using up to 24 alpha-numerical characters

 and symbols. The default password is blank.

Access Point Configures the access point.
SSID: Enter the SSID. This can be set using up to 24 alpha-numerical characters and symbols.
Frequency: Sets the communication mode.
  2.4 GHz, 5.0 GHz
Channel: Sets the channel to use for communication.
  When set to "2.4 GHz": 1 to 13 (increments of 1)
  When set to "5.0 GHz": 36, 40, 44, 48
Password: �Enter the password. This is set using between 8 and 24 alpha-numerical characters and

 symbols.
Remember to change the default password. The default password is the serial number. The serial 
number is the individual 12-digit number assigned to your product, and can be checked on the 
"System Information" screen.

Web Settings for operating this device remotely using a Web browser. ( 38)

Control ‌�Set whether or not to receive control signals from an external device, connected using network 
connection or Wi-Fi connection, in order to operate the video display remotely from the device's web 
browser.	
On, Off

User ID Enter the user ID. This is set using up to 16 alpha-numerical characters and symbols. The default 
user ID is "user".

Password ‌�Enter the password. This is set using between 8 and 16 alpha-numerical characters and symbols. 
The default password is the serial number. The serial number is the individual 12-digit number 
assigned to your product, and can be checked on the "System Information" screen.
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Item Setting Options (underline indicates factory default)

Display Setting Link Settings are linked between displays connected via LAN. This device's setting values are applied to 
all linked displays.
Adjustment, Channel, Adjustment/Channel, Off 
* Before linking settings, check that the following conditions are met.
a Turn on the power to this display and the display(s) to link with, and check that they are all 
recognized on the network

b Change the adjustment or channel and check that the other display(s) also change

The devices and firmware versions that can be linked are shown below.
DP-V2410: Version 1.4 or higher
DP-V2420 / DP-V2421: Version 1.3 or higher
DP-V1710 / DP-V1711: Version 1.3 or higher
DP-V2411: Version 1.2 or higher
Displays not connected can be removed with the RESET button.

Note

•	 Operating the buttons on this display will reflect setting value changes in all. Linked operations 
using Payload ID, HDMI, Camera, etc. will not reflect the settings changes.

•	 If a display model has functions with different menu settings or setting ranges, some settings 
will not be correctly exported (settings will not be changed, will revert to factory defaults, etc.)

•	 In an environment where communication cannot be done properly, such as when the network 
environment is unstable or the bandwidth is insufficient, settings may not link properly. Only 
connect displays to be controlled to the LAN. If a Display Controller is connected, it may not 
operate properly.

•	 Up to 32 displays can have their settings linked.

In Monitor Display The video display supports Television Systems Ltd.’s "TSL UMD Protocol Ver. 5.0". You can operate 
the video display using an external device connected to the LAN terminal and display characters and 
tally lights on the screen. You can input any characters you like directly from this video display. ( 35)

Control Sets whether or not to receive the control signal from the connected device.
   TSL Ver. 5.00, Off
   Manual: ‌�Select to input the characters on this video display. Does not receive a control signal from 

the connected device.

Position This sets whether the characters and tally lights will be displayed at the top or the bottom.
   Top, Bottom

Manual Display 
Type

Automatic: Changes display in accordance with the Input Configuration.
Single: Single-screen display.
Dual A,B, Dual C,D: Dual-screen display.
Quad A,B,C,D: Quadruple-screen display.

Note

•	 When "Function Settings" → "Signal Monitoring" → "Control" is set to "On" then "Manual 
Display Type" is fixed to "Automatic".

Manual String Manual String (Single, Dual/Quad A, Dual/Quad B, Dual/Quad C, Dual/Quad D,  
Single Dual L, Single Dual R): With "Control” set to "Manual", select "Manual String" and set the 
characters to display. You can input up to 16 alphanumeric characters.
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System Settings

This menu is used to configure settings related the system of the video display.

Item Setting Options (underline indicates factory default)

Function/Channel Button Sets the function or channel to assign to the F buttons or CH button.

Display 
Function/
Display 
Function 
(CDL)

Sets the function to assign to the F buttons of the main unit. Select an F button and assign a 
function from the following list ( 106). The factory defaults for the main unit F buttons is as follow:
 Normal mode

F1: Picture Mode
F2: Brightness
F3: TC/ALM
F4: WFM/VEC
F5: Histogram/Frame Luminance
F6: Pixel Value Check
F7: Zoom Preset
F8: Boost Contrast 

 CDL mode
F1: CDL/User LUT
F2: CDL SOP/SAT
F3: CDL/User LUT Bypass
F4: Single Input Dual View
F5: False Color
F6: Over Range
F7: 2020 Outside of Gamut View
F8: Compare View

Note

•	 When changing channels with "Channel UP/DOWN", the channels with "Input Configuration" 
( 64) set to "–" are skipped.

•	 When any marker settings are changed using an F button, those changes will be applied to 
"Enable" under the currently selected "Marker Preset".

•	 "Hide OSD" is a function to hide all OSD. When "On" is selected, OSD, "Background Color" 
and "Separator" are hidden but the menu can be used.

Display 
Channel

Sets the channel to assign to the CH button on the display.
Select a CH button and register a channel number. A list of settings under the menu "Channel 
Settings" ( 64) is displayed.

Language Sets the language of the OSD menu and messages.
English, , 

Date/Time Sets the year/month/date/hour/minute.
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Item Setting Options (underline indicates factory default)

Display Name Sets the name of the main unit. You can input up to 16 alphanumeric characters.

OSD Settings

Banner Sets the banner display method for the channel name, signal information, and status of the video 
display.
Automatic Display: �Automatically displays the banner when the input signal or picture mode are

 changed.	
 On, Off

Picture Mode: �Sets whether to display "Picture Mode".
 On, Off

Time Out: �The banner automatically disappears.
 On, Off

Function 
Button Guide

On: ‌�You can display the list of functions assigned to an F button on the video display by pressing the 
jog dial while OSD is closed.

Off: �Function Button Guide is not displayed.

OSD Position Mode 1 (4096x2160): OSD is displayed in a 4096x2160 area.
Mode 2 (3840x2160): OSD is displayed in a 3840x2160 area.

OSD Size Sets the size of the OSD menu.
Large, Small

OSD 
Brightness

Sets the brightness of the OSD.
The brightness is automatically adjusted to suit the screen contrast when "Automatic" is selected. 
You can choose between "High - Low" and "Hight - Middle" adjustment ranges.
Automatic (High - Middle), Automatic (High - Low), High, Middle, Low

Protect Settings Locks the settings so they cannot be changed. When you press the MENU button, "Signal/System 
Information" appears, but other operations are grayed out because they are locked.

Password Set a password to protect settings. Use a four-digit number (0000 to 9999). The initial password is 
blank.

Protect Target You can remove Picture Mode and Select Channel from the items to be protected.
Picture Mode: ‌�Select "On" to protect or "Off" to exclude settings for "Picture Mode". 

On, Off
Select Channel: ‌�Select "On" to protect or "Off" to exclude settings for "Select Channel". 

On, Off
Function Settings: ‌�Select "On" to protect or "Off" to exclude settings for "Function Settings". 

On, Off

Protect Select "OK" to protect. When a password has been set, enter the password and select "OK".

•	 Unlocking Protect Settings

Move the selection frame to "Protect" and press the Jog dial for approximately 3 seconds. When a 
password has been set, enter the password and select "OK".



103OSD Menu

Item Setting Options (underline indicates factory default)

Power Indicator/Button LED Settings

Power 
Indicator 
Brightness

Adjusts the brightness of the power indicator on the main unit. The greater the number is, the greater 
the brightness.
Off, 1 to 5 (3)

Display Button 
LED

Sets the F buttons and the lamp on the face.
On, Off
Off (Luminance Warning On): ‌�When "Peak Luminance Control" is set to "On", the F button assigned 

with this function will flash when display luminance is restricted, while 
the other F buttons and the lamp on the face will go out.

Button Name 
Lighting Time 
(sec.)

Sets the time (sec) until the lamp on the face goes out if no operation is performed.
60, 30, 10, 5

Fan Settings Sets the operation of internal fan.

Fan Control Fan noise can be eliminated when the main unit is used during shooting or when silent operation is 
needed.
Set this in advance to stop the fan either manually or by linking it with the camera during 
photography ( 92). When this is set to "On", the mode changes so that the fan can be stopped.
On, Off

Fan Stop If "Fan Stop" is set to "On" and when "Fan Control" is set to "On", the fan can be stopped. At room 
temperature (25 °C), the fan remains off for approximately one minute. The fan operates at a faster 
speed than usual before and after the fan is stopped to lower the internal temperature.
On, Off

Note

•	 If the message "Invalid operation due to high temperature." is displayed, the fan cannot be 
stopped even when "On" is selected for this item. Wait until the internal temperature lowers.

•	 If the temperature inside the main unit increases while the fan is off, the message "Fan will be 
rotated as the temperature is high." is displayed and the fan starts rotating approximately ten 
seconds later. Since the temperature of the main unit has increased, the fan rotates faster than 
usual.

•	 Select "Off" to restart the fan. The fan rotates faster than usual.

•	 The fan may not stop in some conditions, for example when used at a high temperature.
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Item Setting Options (underline indicates factory default)

Compatible Settings Sets compatibility with HDMI devices and operation of functions that differ according to the version 
of the video display’s firmware.

HDMI Normal: All formats are supported.
Compatible 1: ‌�Set this option when video is not played correctly in "Normal". HDR signals of a 

luminance higher than that of the display main unit are not supported.
Compatible 2: ‌�Set this option when video is not played correctly in "Normal" or "Compatible 1". 

"4K50.00P/60.00P" and HDR signals are not supported.

Color Range Normal: ‌� Sets the "Color Range" setting to new types in firmware Version 1.2 or later for this video display.
Compatible: ‌�Sets the "Color Range" setting to conventional types in firmware Version 1.1 or earlier 

for this video display.

Backlight 
Control

Normal: ‌�Increases HDR video visibility compared with the firmware earlier than Version 1.1.
Compatible: The displayed image is equivalent to that from firmware earlier than Version 1.1.

Reduce 
Backlight Flash

When "Adjustment" → "Backlight Control" is set to an option other than "Off", the screen may exhibit 
a flash in cases such as switching between scenes with a large difference in luminance. You can use 
"Reduce Backlight Flash" to reduce this phenomenon.
On, Off

 
User LUT

Normal: �Information display for videos such as waveform monitors depends on the status following 
 application of User LUT.

Compatible: �Information display for videos such as waveform monitors depends on the status 
 before application of User LUT

Note

•	 When "Picture Function Settings" → "Compare View" → "Enable" is set to "On", fixes as 
"Normal".

Firmware/License Update This function is used to update the video display firmware. Refer to the Canon website for detailed 
information.

Export/Import Sets the export/import main menu settings.

Note

•	 The following settings cannot be exported or imported. 	

Adjustment Target values of Calibration (including calibration results)

Display Settings Zoom Preset, Frame Hold

Picture Function 
Settings

Peaking (Enable), False Color (Enable), Over Range (Enable), 	
2020 Outside of Gamut View (Enable), Test Pattern, Monochrome, 	
Blue Only, Red Off, Green Off, Blue Off, Compare View (Enable)

Network/IMD 
Settings

LAN, Wi-Fi, Display Setting Link
(LAN and Wi-Fi: only export/import via network)

System Settings Date/Time, Fan Stop, Export/Import, Power on Setting

•	 User LUT data cannot be exported or imported to "User 1-3" under "Target".

•	 Data exported from this product may not be imported to products of which firmware version 
is earlier than the version of this product. To import data, update the firmware to the latest 
version.
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Item Setting Options (underline indicates factory default)

Export Target: Select the export destination. 
USB: Export to a USB memory.
User 1-3: Export to the built-in memory of the main unit.
LAN: Exports to a display connected with a LAN.

Filename: ‌�Changes the file name when "Target" is set to "USB" or "User 1-3". 
Factory default is "dinfo_dpv2420.dat (  dinfo_dpv2421.dat)". You can change 
the name of the file to be exported to the USB memory within 16 one-byte characters 
including alphabetical characters, numbers, and symbols.

Display: �Selects the display with the settings to export from the displays connected via LAN when
 "Target" is set to "LAN".

Execute: Performs export.

Import Target: Specify the destination to save the file to be imported. 
USB, User 1-3

Filename: Displays files with the extension ".dat" so you can select from among them.
Settings (All, Adjustment, Channel Settings, Display Settings, Audio Settings, 
Marker Settings, Function/Network/System Settings): Select the settings to import.
Execute: Performs import.

Power on Setting You can select the state of the display when the power is turned on.
Last memory: ‌�Launches with the same settings as when the power was turned off the previous 

time.

User 1-3: It starts up with the settings saved in "User 1-3" under "Export".

Reset All Settings Returns all settings to factory default. When selected, the message "Reset all settings to factory 
defaults?" appears.
OK: Performs reset.
Cancel: Returns to the previous screen without resetting.
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The following functions can also be assigned to an F button ( 101).

Item Options Item Options

Adjustment Picture Mode Channel Settings Channel UP

Contrast Channel DOWN

Brightness Select Input Signal

Chroma Audio Input

Chroma Up Single Input Dual View

Sharpness CH1 to CH20

Backlight Control Display Settings Screen Scaling

Gamma/EOTF Anamorphic

HDR Scaling Method

HDR Range Zoom Preset

Peak Luminance Control Zoom 1

HDR/SDR View Zoom 2

Gain Zoom 3

Bias Frame Hold

xy Background Color

Picture Mode SMPTE-C Audio Settings SDI Group

EBU CH L

ITU-R BT.709 CH R

ITU-R BT.2020 Volume

Adobe RGB Audio Switch

DCI-P3 Marker Settings Marker Preset

User 1 (2020 PQ) Marker 1

User 2 (2020 HLG) Marker 2

User 3 (DCI PQ) Marker 3

User 4 (DCI PQ D65) Marker 4

User 5 ~ User 7 Marker 5

CINEMA EOS SYSTEM Aspect Marker

ACESproxy (ver. 1.0.1) Safety Zone Marker 1

CDL/User LUT CDL /User LUT Safety Zone Marker 2

CDL RGB Area Marker

CDL R Center Marker

CDL G Grid Marker

CDL B

CDL SOP/SAT

CDL Slope

CDL Offset

CDL Power

CDL Saturation

CDL/User LUT Bypass

CDL Export/Import
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Item Options

Function Settings TC/ALM

Time Code

Audio Level Meter

WFM/VEC

Wave Form Monitor

WFM Select Signal

Vector Scope

Histogram/Frame Luminance

Histogram

Frame Luminance Monitor

Pixel Value Check

Signal Monitoring Log

Capture

Camera Information

Picture Function 
Settings

Peaking

Peaking 1

Peaking 2

False Color

False Color 1

False Color 2

Over Range

2020 Outside of Gamut View

Monochrome

Blue Only

Red Off

Green Off

Blue Off

Compare View

System Settings Signal Information

Hide OSD

Fan Stop
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Signal Information

Shows the signal information. When "Select Input Signal" is "Quad Input", information for the entire signal and each 
input is displayed. Select a signal with the jog dial according to the guide at top right corner of the menu. When signal 
information has been obtained although it is not displayed on the screen, the content of the information is grayed out.

SDI Signal HDMI Signal

Item Display Example Item Display Example

Channel
Input Configuration
Select Input Signal
Image Division
Format
Resolution
Picture Rate, I/P/PsF*
SDI Payload ID
   Video Standard
   Sampling Structure, Bit Depth
   Picture Rate
   Scanning Method

   Link Number
   Colorimetry
   Transfer Characteristics

CH1
3G/HD-SDI (3G-A)
Quad Input
Automatic
Automatic
4096x2160
24.00P
89 C3 46 01
3G-SDI
4:4:4:4 GBRA 10-bit
24.00
Progressive/Progressive
(Transport/Picture)
Single/Link_1
UHD
SDR-TV

Channel
Input Configuration
Format
Resolution
Picture Rate, I/P/PsF
Pixel Encoding, Color Depth
Matrix
Range
EOTF
Max Luminance (Peak/Avg.)
Display Luminance (Max/Min)
   White Point
   Primary Color Red
   Primary Color Green
   Primary Color Blue

CH4
HDMI
Automatic
4096x2160
60.00P
4:2:2 YCbCr 10-bit
ITU-R BT.709
Full
SMPTE ST 2084 (PQ)
1000 / 500 cd/m2

1000 - 0.005 cd/m2

x=0.313, y=0.329
x=0.640, y=0.330
x=0.300, y=0.600
x=0.150, y=0.060

* When a content is grayed out, an asterisk "*" may be displayed indicating low "Picture Rate" accuracy such as "24.00P *".

System Information

Shows the video display status and network information.

Item Display Example

Display DP-V2420

  Serial No. 000000000000

  Firmware/License Ver. 1.3

  Usage Time* 5 h

  IP Address 192.168.0.1

  Subnet Mask 255.255.255.0

  MAC Address FF:FF:FF:FF:FF:FF

  Wi-Fi IP Address 192.168.0.1

  Wi-Fi Subnet Mask 255.255.255.0

* The "Usage Time" is not always "0" when you purchase the display due to factory inspection.
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Main specifications/Performance

Panel

Panel Type IPS LCD panel

Screen Size 24 inch (61.1 cm)

Aspect Ratio 17:9

Resolution 4096x2160 (8.8 megapixels)

Active Display Area Approximately 540.7 x 285.1 mm

Pixel Pitch 132 µm/193 ppi

Panel Driver 1024 gradations, 10-bit for each RGB color

Image quality

Brightness (Standard) 100 cd/m2

View Angle (Up, Down, Left, Right) 89° (contrast ratio 10 : 1 or higher)

Surface Treatment Anti-glare coating

General

Backlight Type RGB LED, direct down type

Power Rated Voltage: 100 – 240 V AC    Rated Frequency: 50/60 Hz

Power consumption At maximum load (including change in brightness through aging): Approximately 510 W
At factory shipment: Approximately 180 W

Environmental 
Conditions

Operating Temperature and humidity: �0 – 40 °C (32 – 104 °F), 20 – 85 %RH (no condensation)
 recommended: 15 – 30 °C (59 – 86 °F)

Pressure: 700 – 1060 hPa

Storage/Transporting Temperature and humidity: �-20 – 40 ˚C (-4 – 104 °F), 20 – 85 %RH (no condensation) 
 41 – 60 ˚C (105 – 140 °F), 20 – 30 %RH (no condensation)

Pressure: 700 – 1060 hPa

Dimensions (width x height x depth) Including stands: Approx. 594×399×235 mm (23.4×15.7×9.3 in.)
Main unit only, excluding protrusions: Approx. 594×378×195 mm (23.4×14.9×7.7 in.)

Weight Approximately 19 kg (41.8 lb)

Mounting Hole Pitch VESA standard 200 x 100 mm (7.9 x 3.9 in.)
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Interface

Input
3G/HD/SD-SDI

12G/6G/3G/HD/SD-SDI

4 (1 systems)    BNC (75Ω) receptacle terminal
  12G-SDI: Compliant with SMPTE 2082
  6G-SDI: Compliant with SMPTE 2081

3G-SDI: �Compliant with SMPTE 2048-2/274M/296/372/425-5/425-3/425-1/	
428-19/428-9

HD-SDI: Compliant with SMPTE 2048-2/274M/292-1/296/428-19/428-9
SD-SDI: Compliant with SMPTE 259M

HDMI 1 (1 system) type A terminal     Contents protection standard: HDCP 2.2

Output
3G/HD-SDI

12G/6G/3G/HD-SDI

4 (1 pass-thru systems)

Head phone 1 stereo mini jack, Supported impedance: 32 Ω to 64 Ω

Control USB 1 USB A receptacle terminal
Universal Serial Bus Specification Revision 2.0 compliant LS (Low Speed)/FS (Full 
Speed)/HS (High Speed) mode compatible
Compliant with Enhanced Host Controller Interface Specification for Universal Serial 
Bus Revision 1.0

LAN 1 RJ-45 terminal
Compliant with IEEE802.3 10BASE-TX/IEEE802.3u 100BASE-TX

Weight and dimensions are approximate. Error and omissions excepted.
The information in this manual is verified as of May 2019. It is subject to change without notice.
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Dimensions

■■ Main Unit
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Appendix
Supported Signal Format

■■ SDI

 : Formats with "*" support audio signals.
 : Formats with "**" do not support audio signals.

Transmission method Signal format Color format Color depth Standards

SD-SDI 720x487i  59.94/60.00 Hz** 4:2:2 YCbCr 10-bit SMPTE-259M

720x576i  50.00 Hz**

HD-SDI 1280x720P  59.94/60.00 Hz* 4:2:2 YCbCr 10-bit SMPTE 292-1
SMPTE 2961280x720P  50.00 Hz*

1280x720P  29.97/30.00 Hz

1280x720P  25.00 Hz*

1280x720P  23.98/24.00 Hz*

1920x1080i  59.94/60.00 Hz* SMPTE 292-1
SMPTE 274M1920x1080i  50.00 Hz* 

1920x1080P  29.97/30.00 Hz*

1920x1080PsF  29.97/30.00 Hz*

1920x1080P  25.00 Hz*

1920x1080PsF  25.00 Hz*

1920x1080P  23.98/24.00 Hz* 

1920x1080PsF  23.98/24.00 Hz*

2048x1080i  59.94/60.00 Hz

2048x1080i  50.00 Hz

2048x1080P  29.97/30.00 Hz SMPTE 292-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

2048x1080PsF  29.97/30.00 Hz

2048x1080P  25.00 Hz 

2048x1080PsF  25.00 Hz

2048x1080P  23.98/24.00 Hz

2048x1080PsF  23.98/24.00 Hz

3G-SDI 
(Level A)

1280x720P  59.94/60.00 Hz* 4:4:4 RGB
4:4:4 YCbCr

10-bit SMPTE 425-1
SMPTE 296

1280x720P  50.00 Hz* 4:4:4 RGB
4:4:4 YCbCr

10-bit

1280x720P  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

10-bit

1280x720P  25.00 Hz* 4:4:4 RGB
4:4:4 YCbCr

10-bit

1280x720P  23.98/24.00 Hz* 4:4:4 RGB
4:4:4 YCbCr

10-bit

1920x1080P  59.94/60.00 Hz* 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 274M
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Transmission method Signal format Color format Color depth Standards

3G-SDI 
(Level A)

1920x1080i  59.94/60.00 Hz 4:4:4 RGB*
4:4:4 YCbCr*

12-bit/10-bit SMPTE 425-1
SMPTE 274M

4:2:2 YCbCr 12-bit

1920x1080P  50.00 Hz* 4:2:2 YCbCr 10-bit

1920x1080i  50.00 Hz 4:4:4 RGB*
4:4:4 YCbCr*

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080P  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080PsF  29.97/30.00 Hz 4:4:4 RGB* 10-bit

12-bit

4:4:4 YCbCr* 12-bit

4:4:4 YCbCr* 10-bit SMPTE 425-1
SMPTE 274M4:2:2 YCbCr 12-bit

1920x1080P  25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080PsF  25.00 Hz 4:4:4 RGB* 10-bit

12-bit

4:4:4 YCbCr* 12-bit

4:4:4 YCbCr* 10-bit SMPTE 425-1
SMPTE 274M4:2:2 YCbCr 12-bit

1920x1080P  23.98/24.00 Hz 4:4:4 RGB*
4:4:4 YCbCr*

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080PsF  23.98/24.00 Hz 4:4:4 RGB 10-bit

12-bit

4:4:4 YCbCr 12-bit

4:4:4 YCbCr 10-bit SMPTE 425-1
SMPTE 274M4:2:2 YCbCr 12-bit

2048x1080P  59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

2048x1080i  59.94/60.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:2:2 YCbCr 

2048x1080P  50.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 2048-2
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Transmission method Signal format Color format Color depth Standards

3G-SDI
(Level A)

2048x1080i  50.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:2:2 YCbCr 

2048x1080P  47.95/48.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 2048-2

2048x1080P  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

2048x1080PsF  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

2048x1080P  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

2048x1080PsF  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

2048x1080P  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

2048x1080PsF  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit
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Transmission method Signal format Color format Color depth Standards

3G-SDI
(Level B)

1920x1080P  59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 274M1920x1080i  59.94/60.00 Hz 4:4:4 RGB

4:4:4 YCbCr
12-bit/10-bit

4:2:2 YCbCr* 12-bit

1920x1080P  50.00 Hz 4:2:2 YCbCr 10-bit

1920x1080i  50.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr* 12-bit

1920x1080P  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080PsF  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080P  25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080PsF  25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080P  23.98/24.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

1920x1080PsF  23.98/24.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

2048x1080P  59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

2048x1080i  59.94/60.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr 

12-bit

2048x1080P  50.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

2048x1080i  50.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr 

12-bit
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Transmission method Signal format Color format Color depth Standards

3G-SDI 
(Level B)

2048x1080P  47.95/48.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

2048x1080P  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

2048x1080PsF  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

2048x1080P  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

2048x1080PsF  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

2048x1080P  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit
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Transmission method Signal format Color format Color depth Standards

3G-SDI 
(Level B)

2048x1080PsF  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

Dual Link 3G-SDI	
(Level A)

1920x1080P 59.94/60 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit SMPTE 425-3	
SMPTE 274M 

4:2:2 YCbCr 12-bit

1920x1080P 50 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

2048x1080P 59.94/60 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit SMPTE 425-3	
SMPTE 428-9	
SMPTE 428-19	
SMPTE 2048-2

4:4:4 X'Y'Z'	
4:2:2 YCbCr

12-bit

2048x1080P 50 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:4:4 X'Y'Z'	
4:2:2 YCbCr

12-bit

2048x1080P 47.95/48 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:4:4 X'Y'Z'	
4:2:2 YCbCr

12-bit

Dual Link 3G-SDI	
(Level B)

1920x1080P 59.94/60 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit SMPTE 425-3	
SMPTE 372	
SMPTE 274M4:2:2 YCbCr 12-bit

1920x1080P 50 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

2048x1080P 59.94/60 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit SMPTE 425-3	
SMPTE 372	
SMPTE 428-9	
SMPTE 428-19	
SMPTE 2048-2

4:4:4 X'Y'Z'	
4:2:2 YCbCr

12-bit

2048x1080P 50 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:4:4 X'Y'Z'	
4:2:2 YCbCr

12-bit

2048x1080P 47.95/48 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:4:4 X'Y'Z'	
4:2:2 YCbCr

12-bit
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Transmission method Signal format Color format Color depth Standards

Dual Link 3G-SDI 	
Square Division 	
(Level B)

3840x2160P 29.97/30 Hz 4:2:2 YCbCr 10-bit SMPTE 425-3	
SMPTE 372	
SMPTE 274M

3840x2160PsF 29.97/30 Hz

3840x2160P 25 Hz 

3840x2160PsF 25 Hz

3840x2160P 23.98/24 Hz

3840x2160PsF 23.98/24 Hz

4096x2160P 29.97/30 Hz SMPTE 425-3	
SMPTE 372	
SMPTE 2048-2

4096x2160PsF 29.97/30 Hz

4096x2160P 25 Hz

4096x2160PsF 25 Hz

4096x2160P 23.98/24 Hz

4096x2160PsF 23.98/24 Hz

Dual Link 3G-SDI	
2 Sample Interleave	
(Level B)

3840x2160P 29.97/30 Hz 4:2:2 YCbCr 10-bit SMPTE 425-3	
SMPTE 372	
SMPTE 274M

3840x2160P 25 Hz

3840x2160P 23.98/24 Hz

4096x2160P 29.97/30 Hz SMPTE 425-3	
SMPTE 372	
SMPTE 2048-2

4096x2160P 25 Hz

4096x2160P 23.98/24 Hz

Quad Link HD-SDI 3840x2160i  59.94/60.00 Hz* 4:2:2 YCbCr 10-bit SMPTE 292-1
SMPTE 274M3840x2160i  50.00 Hz*

3840x2160P  29.97/30.00 Hz*

3840x2160PsF  29.97/30.00 Hz*

3840x2160P  25.00 Hz*

3840x2160PsF  25.00 Hz*

3840x2160P  23.98/24.00 Hz* 

3840x2160PsF  23.98/24.00 Hz*

4096x2160i  59.94/60.00 Hz

4096x2160i  50.00 Hz

4096x2160P  29.97/30.00 Hz SMPTE 292-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4096x2160PsF  29.97/30.00 Hz

4096x2160P  25.00 Hz 

4096x2160PsF  25.00 Hz

4096x2160P  23.98/24.00 Hz

4096x2160PsF  23.98/24.00 Hz
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Transmission method Signal format Color format Color depth Standards

Quad Link 3G-SDI
(Level A)

3840x2160P  59.94/60.00 Hz 4:2:2 YCbCr* 10-bit SMPTE 425-1
SMPTE 274M

3840x2160i  59.94/60.00 Hz 4:4:4 RGB*
4:4:4 YCbCr*

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P  50.00 Hz 4:2:2 YCbCr* 12-bit

3840x2160i  50.00 Hz 4:4:4 RGB*
4:4:4 YCbCr*

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160PsF  29.97/30.00 Hz 4:4:4 RGB* 10-bit

12-bit

4:4:4 YCbCr* 12-bit

4:4:4 YCbCr* 10-bit SMPTE 425-1
SMPTE 274M4:2:2 YCbCr 12-bit

3840x2160P  25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160PsF  25.00 Hz 4:4:4 RGB* 10-bit

12-bit

4:4:4 YCbCr* 12-bit

4:4:4 YCbCr* 10-bit SMPTE 425-1
SMPTE 274M4:2:2 YCbCr 12-bit

3840x2160P  23.98/24.00 Hz 4:4:4 RGB*
4:4:4 YCbCr*

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160PsF  23.98/24.00 Hz 4:4:4 RGB 10-bit

12-bit

4:4:4 YCbCr 12-bit

4:4:4 YCbCr 10-bit SMPTE 425-1
SMPTE 274M4:2:2 YCbCr 12-bit

4096x2160P  59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4096x2160i  59.94/60.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr 

12-bit
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Transmission method Signal format Color format Color depth Standards

Quad Link 3G-SDI
(Level A)

4096x2160P  50.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 2048-2

4096x2160i  50.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr 

12-bit

4096x2160P  47.95/48.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 2048-2

4096x2160P  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

4096x2160PsF  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

4096x2160P  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

4096x2160PsF  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

4096x2160P  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit

4096x2160PsF  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 2048-24:2:2 YCbCr 12-bit
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Transmission method Signal format Color format Color depth Standards

Quad Link 3G-SDI
2 Sample Interleave
(Level A)

3840x2160P 59.94/60 Hz 4:2:2 YCbCr 10-bit SMPTE 425-5	
SMPTE 274M3840x2160P 50 Hz 4:2:2 YCbCr 10-bit

3840x2160P 29.97/30 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P 25 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P 23.98/24 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 59.94/60 Hz 4:2:2 YCbCr 10-bit SMPTE 425-5	
SMPTE 428-9	
SMPTE 428-19	
SMPTE 2048-2

4096x2160P 50 Hz 4:2:2 YCbCr 10-bit

4096x2160P 47.95/48 Hz 4:2:2 YCbCr 10-bit

4096x2160P 29.97/30 Hz 4:4:4 RGB 12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 25 Hz 4:4:4 RGB 12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 23.98/24 Hz 4:4:4 RGB 12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit

4:2:2 YCbCr 12-bit

Quad Link 3G-SDI
(Level B)

3840x2160P  59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 274M

3840x2160i  59.94/60.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr* 12-bit

3840x2160P  50.00 Hz 4:2:2 YCbCr 10-bit
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Transmission method Signal format Color format Color depth Standards

Quad Link 3G-SDI
(Level B)

3840x2160i  50.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 274M4:2:2 YCbCr* 12-bit

3840x2160P  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160PsF  29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P  25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160PsF  25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P  23.98/24.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160PsF  23.98/24.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P  59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4096x2160i  59.94/60.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr 

12-bit

4096x2160P  50.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4096x2160i  50.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr 

12-bit

4096x2160P  47.95/48.00 Hz 4:2:2 YCbCr 10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2
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Transmission method Signal format Color format Color depth Standards

Quad Link 3G-SDI
(Level B)

4096x2160P  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

4096x2160PsF  29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

4096x2160P  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

4096x2160PsF  25.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

4096x2160P  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit

4096x2160PsF  23.98/24.00 Hz 4:4:4 RGB 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 428-9
SMPTE 428-19
SMPTE 2048-2

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit SMPTE 425-1
SMPTE 372
SMPTE 2048-2

4:2:2 YCbCr 12-bit
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Transmission method Signal format Color format Color depth Standards

Quad Link 3G-SDI
2 Sample Interleave
(Level B)

3840x2160P 59.94/60 Hz 4:2:2 YCbCr 10-bit SMPTE 425-5	
SMPTE 372	
SMPTE 274M

3840x2160P 50 Hz 4:2:2 YCbCr 10-bit

3840x2160P 29.97/30 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P 25 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P 23.98/24 Hz 4:4:4 RGB	
4:4:4 YCbCr 

12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 59.94/60 Hz 4:2:2 YCbCr 10-bit SMPTE 425-5	
SMPTE 372	
SMPTE 428-9	
SMPTE 428-19	
SMPTE 2048-2

4096x2160P 50 Hz 4:2:2 YCbCr 10-bit

4096x2160P 47.95/48 Hz 4:2:2 YCbCr 10-bit

4096x2160P 29.97/30 Hz 4:4:4 RGB 12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 25 Hz 4:4:4 RGB 12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 23.98/24 Hz 4:4:4 RGB 12-bit/10-bit

4:4:4 X'Y'Z' 12-bit

4:4:4 YCbCr 12-bit/10-bit

4:2:2 YCbCr 12-bit

 6G-SDI 3840x2160P 29.97/30.00 Hz 4:2:2 YCbCr 10-bit SMPTE 2081-10

3840x2160P 25.00Hz

3840x2160P 23.98/24.00 Hz

4096x2160P 25.00Hz

4096x2160P 23.98/24.00 Hz

 
Dual Link 6G-SDI
Square Division, 
2 Sample Interleave

3840x2160P 59.94/60.00 Hz 4:2:2 YCbCr 10-bit SMPTE 2081-11

3840x2160P 50.00 Hz
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Transmission method Signal format Color format Color depth Standards

 12G-SDI 3840x2160P 29.97/30.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit SMPTE 2082-10

4:2:2 YCbCr 12-bit

3840x2160P 25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

3840x2160P 23.98/24.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:2:2 YCbCr 12-bit

4096x2160P 25.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr

12-bit

4096x2160P 23.98/24.00 Hz 4:4:4 RGB
4:4:4 YCbCr

12-bit/10-bit

4:4:4 X'Y'Z'
4:2:2 YCbCr

12-bit

3840x2160P 59.94/60.00 Hz 4:2:2 YCbCr 10-bit

3840x2160P 50.00Hz

4096x2160P 47.95/48.00 Hz

4096x2160P 59.94/60.00Hz

4096x2160P 50.00Hz
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■■ RAW

Signal format

3840x2160P 59.94 Hz, 50.00 Hz, 29.97 Hz, 25.00 Hz, 24.00 Hz, 23.98 Hz

4096x2160P 59.94 Hz, 50.00 Hz, 29.97 Hz, 25.00 Hz, 24.00 Hz, 23.98 Hz

■■ HDMI

Signal format Color format/Color depth

640x480P 59.94/60.00 Hz 4:4:4 RGB 8-bit

800x600P 60.00 Hz

1024x768P 60.00 Hz

720x480P 59.94/60.00 Hz 4:4:4 RGB 12-bit/10-bit/8-bit
4:4:4 YCbCr 12-bit/10-bit/8-bit
4:2:2 YCbCr 12-bit

720x576P 50.00 Hz

1280x720P 59.94/60.00 Hz

1280x720P 50.00 Hz

1920x1080P 59.94/60.00 Hz

1920x1080i 59.94/60.00 Hz

1920x1080P 50.00 Hz

1920x1080i 50.00 Hz

1920x1080P 29.97/30.00 Hz

1920x1080P 25.00 Hz

1920x1080P 23.98/24.00 Hz

2048x1080P 59.94/60.00 Hz

2048x1080P 50.00 Hz

2048x1080P 29.97/30.00 Hz

2048x1080P 25.00 Hz

2048x1080P 23.98/24.00 Hz

3840x2160P 59.94/60.00 Hz 4:4:4 RGB 8-bit
4:4:4 YCbCr 8-bit
4:2:2 YCbCr 12-bit
4:2:0 YCbCr 12-bit/10-bit/8-bit

3840x2160P 50.00 Hz

3840x2160P 29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit/8-bit 
4:4:4 YCbCr 12-bit/10-bit/8-bit
4:2:2 YCbCr 12-bit

3840x2160P 25.00 Hz

3840x2160P 23.98/24.00 Hz

4096x2160P 59.94/60.00 Hz 4:4:4 RGB 8-bit
4:4:4 YCbCr 8-bit
4:2:2 YCbCr 12-bit
4:2:0 YCbCr 12-bit/10-bit/8-bit

4096x2160P 50.00 Hz

4096x2160P 29.97/30.00 Hz 4:4:4 RGB 12-bit/10-bit/8-bit 
4:4:4 YCbCr 12-bit/10-bit/8-bit
4:2:2 YCbCr 12-bit

4096x2160P 25.00 Hz

4096x2160P 23.98/24.00 Hz
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Image/Frame Display

■■ SDI

Signal system Display Method

720x487 59.94/60.00 i 59.94/60.00 P

720x576 50.00 i 50.00 P

1280x720 23.98/24.00 P 47.96/48.00 P*

25.00 P 50.00 P*

29.97/30.00 P 59.94/60.00 P*

50.00 P 50.00 P

59.94/60.00 P 59.94/60.00 P

1920x1080 50.00 i 50.00 P

59.94/60.00 i 59.94/60.00 P

23.98/24.00 PsF 47.96/48.00 P*

25.00 PsF 50.00 P*

29.97/30.00 PsF 59.94/60.00 P*

23.98/24.00 P 47.96/48.00 P*

25.00 P 50.00 P*

29.97/30.00 P 59.94/60.00 P*

50.00 P 50.00 P

59.94/60.00 P 59.94/60.00 P

2048x1080 50.00 i 50.00 P

59.94/60.00 i 59.94/60.00 P

23.98/24.00 PsF 47.96/48.00 P*

25.00 PsF 50.00 P*

29.97/30.00 PsF 59.94/60.00 P*

23.98/24.00 P 47.96/48.00 P*

25.00 P 50.00 P*

29.97/30.00 P 59.94/60.00 P*

47.95/48.00 P 47.95/48.00 P

50.00 P 50.00 P

59.94/60.00 P 59.94/60.00 P

3840x2160 50.00 i 50.00 P

59.94/60.00 i 59.94/60.00 P

23.98/24.00 PsF 47.96/48.00 P*

25.00 PsF 50.00 P*

29.97/30.00 PsF 59.94/60.00 P*

23.98/24.00 P 47.96/48.00 P*

25.00 P 50.00 P*

29.97/30.00 P 59.94/60.00 P*

50.00 P 50.00 P

59.94/60.00 P 59.94/60.00 P
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Signal system Display Method

4096x2160 50.00 i 50.00 P

59.94/60.00 i 59.94/60.00 P

23.98/24.00 PsF 47.96/48.00 P*

25.00 PsF 50.00 P*

29.97/30.00 PsF 59.94/60.00 P*

23.98/24.00 P 47.96/48.00 P*

25.00 P 50.00 P*

29.97/30.00 P 59.94/60.00 P*

47.95/48.00 P 47.95/48.00 P

50.00 P 50.00 P

59.94/60.00 P 59.94/60.00 P

	 * : Displaying same frame
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■■ HDMI

Signal system Display Method

640x480 59.94/60.00 P 59.94/60.00 P

800x600 60.00 P 60.00 P

720x480P 59.94/60.00 P 59.94/60.00 P

720x576 50.00 P 50.00 P

1024x768 60.00 P 60.00 P

1280x720 59.94/60.00 P 59.94/60.00 P

1280x720 50.00 P 50.00 P

1920x1080 59.94/60.00 P 59.94/60.00 P

1920x1080 59.94/60.00 i 59.94/60.00 P

1920x1080 50.00 P 50.00 P

1920x1080 50.00 i 50.00 P

1920x1080 59.94/60.00 i 59.94/60.00 P

1920x1080 29.97/30.00 P 59.94/60.00 P*

1920x1080 25.00 P 50.00 P*

1920x1080 23.98/24.00 P 47.96/48.00 P*

2048x1080 59.94/60.00 P 59.94/60.00 P

2048x1080 50.00 P 50.00 P

2048x1080 29.97/30.00 P 59.94/60.00 P*

2048x1080 25.00 P 50.00 P*

2048x1080 23.98/24.00 P 47.96/48.00 P*

3840x2160 59.94/60.00 P 59.94/60.00 P

3840x2160 50.00 P 50.00 P

3840x2160 29.97/30.00 P 59.94/60.00 P*

3840x2160 25.00 P 50.00 P*

3840x2160 23.98/24.00 P 47.96/48.00 P*

4096x2160 59.94/60.00 P 59.94/60.00 P

4096x2160 50.00 P 50.00 P

4096x2160 29.97/30.00 P 59.94/60.00 P*

4096x2160 25.00 P 50.00 P*

4096x2160 23.98/24.00 P 47.96/48.00 P*

	 * : Displaying same frame
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Error Messages

Message Description and Action

Calibration Failed to initialize the external sensor. See CA-310 and CA-210 instruction manual.

Calibration error. •	 Check the installation and connection of the 
external sensor and retry ( 27).

•	 Perform matrix calibration of CA-310 and CA-210 
( 27).

Calibration is completed.
(Brightness setting is lower than target brightness.)

Set the "Luminance" in calibration again ( 59).

Failed to detect the external sensor.
Please check the connection with the sensor.

Correctly connect the external sensor to the USB 
port of this main unit.

Network Communication error. IP address may be in conflict or there may be a 
network communication error. Check the network 
environment.

Invalid IP Address. Enter the correct IP address.

Invalid Subnet Mask. Enter the correct subnet mask.

Display is not connected. Check that the Canon display to which you wish to 
export this video display's settings and this video 
display are correctly connected with a LAN cable.

Various settings, 	
CDL export

The USB memory is full. Use another USB memory or delete the content of 
the memory.

Failed to write file. The USB memory may be defective or protected. 
Check the USB memory.

LUT, Various settings, 
CDL import

(LUT Import) "LUT Type" is different.
(CDL Import) "File Type" is different.

Select the correct file format.

Failed to read file. The USB memory may be defective or protected. 
Check the USB memory.

Failed to import. There is an error in the file to be imported. Check the 
file.

No import file. Check and ensure that the file has been saved to the 
USB memory or imported to "User 1-3".
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Message Description and Action

Screen Capture Failed to capture. The USB memory may be defective or protected. 
Check the USB memory.

Invalid Signal. A screen displaying no video is being captured for 
example there is no signal or an unsupported signal 
is being input. Check the signal, input it again, and 
capture it.

Copy protected signal. The signal you tried to capture may be protected by 
HDCP 2.2 which is a copy prevention standard for 
HDMI. In this case, the signal cannot be captured. 
Check the HDMI signal.

Failed to playback file. The USB memory or the file may be defective or 
protected. Check the USB memory or the file.

No capture file. Check and ensure that the file has been saved to the 
USB memory.

Hardware error Backlight error. Disconnect the power cord, reconnect it, and then 
turn on the power.
If the message persists, contact Canon Customer 
Center.

Fan error.

Panel error.

I/F error.

System error.

Invalid operation due to high temperature. The temperature inside the main unit is high. Turn off 
the power and wait until the fan stops.

Input signal No Signal Displayed when there is no video signal input.

Unsupported Unsupported video signal is input. Check the 
supported signal format ( 112).

Operation Invalid operation. Operation is disabled. Check the setting items.

"Protect Settings" is on. To use the OSD menu, move the selection frame 	
to "Protect" and press the jog dial for approximately 
3 seconds.

"CDL/User LUT Bypass" is on. When "CDL/User LUT Bypass" is turned "On", you 
cannot adjust "Power", "Saturation", "Offset", or 
"Slope".

Invalid Password. Enter the correct password.

USB memory USB memory is not connected. Correctly connect the USB memory to the USB port 
of this main unit.

Unsupported USB memory. Check the USB memory format and make sure it is 
not protected.

Wi-Fi adapter Wi-Fi Adaptor is not connected. Correctly connect the Wi-Fi adapter to the USB 
terminal of the video display.

Failed to connect Wi-Fi Access Point. The password may be wrong, or there may be a 
network communication error. Check the network 
environment.
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Message Description and Action

Firmware Update No update file. Firmware update files are not saved on USB memory 
or other media.

Failed to read update file. There is an error in the file. Check the file.

The firmware/license has been already updated. This is the file that is updated on the video display.
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Troubleshooting

Symptom Cause and Action

Power does not turn on.
(Power indicator does not turn on.)

•	 Press the  button.

•	 Check that the AC power cord is connected correctly.

•	 Brightness of the power indicator may be turned off. Turn it on and 
check once more.

12

21

103

The screen is dark. When the power indicator does not turn on:
•	 Press the  button.

•	 Check that the AC power cord is connected correctly.

12

21

When the power indicator is lit orange:
•	 Press the  button.

12

When the power indicator is flashing orange:
•	 Flashing once every 3 seconds	:	 Contact Canon Customer Center.

•	 Flashing twice every 3 seconds	:
- Turn on the power with the  button.
- The temperature of the display rises (or falls) depend on operation 
environment. Check the environmental conditions ( 109) and do not use 
in direct sunlight.
- If the power still does not turn on, contact Canon Customer Cente.

12

109

The image does not display. •	 Set each item in "Channel Settings" according to input signa. 64

The 3G-SDI RAW signal image does not 
display.

•	 At times the 3G-SDI RAW signal image may not display, depending on 
the type of the Cinema EOS camera. Refer to the Canon website for a 
list of supported products.

—

There is a blank area when set to Quad 
Input/Dual Input.

•	 There may be no input signal. Look at the display area icon in the 
interface area and check that the input area and signal cables are 
properly connected.

•	  Signals with different resolution or frequency may be input from 
each terminal. Check the signal.

•	  Some combinations are not supported. Check the signal.

19

65, 108

The image appears to be delayed. When "Reduce Backlight Flash" is set to "On", the displayed image may be 
delayed depending on the scene. In such case, change the setting to "Off.

104

Video paused temporarily The screen may pause when running "Capture" via a web browser. When 
"Capture" is complete, or turning "Web" → "Control" to "Off" will return to 
normal scree.

38

Screen is too bright/dark. •	 Adjust the "Contrast" on the OSD menu.

•	 There is a limit on the service life of LCD backlight. If the screen 
becomes dark or starts flickering, contact Canon Customer Cente.

49

Burn-in image appears. •	 This is a characteristic of the LCD panel and you should avoid displaying 
stationary image for a long time.

—
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Symptom Cause and Action

There is an unlit or red, blue, green, or 
white dot on screen. 

•	 LCD display is made of very high precision technology. It has effective 
pixels of 99.99% or more, but there may be black dots or red, blue, or 
green dots that may be always on. This is not a failure.

—

There is an interference pattern or trace
that remains when the LCD panel is 
pressed.

•	 The symptom may be resolved by displaying a white or black image on 
the entire screen. —

OSD menu cannot be used. •	 Check that "Protect Settings" is not set. 102

The F button on the main unit is flashing. •	 When "Peak Luminance Control" is set to "On", the F button assigned 
with this function flashes when display luminance is restricted.

•	 When "Peak Luminance Control" is assigned to two or more F buttons, 
one of the buttons flashes. 

57

"Aspect Marker", " Safety Zone Marker " or 
"Area Marker" does not appear.

•	 A channel with no signal, unsupported signal, or with "Input 
Configuration" not set may be selected. Check the signal.

108

The fan starts to rotate even when "Fan" 
under "Camera Link" is set to "On" or 
"Fan Stop" is set to "On".

•	 The fan operates to lower the temperature inside the main unit. The fan 
stops operating when the temperature inside has lowered.

•	 When "Fan" under "Camera Link" is set to "On", the down time may not 
match the camera.

92	

103

The fan does not stop even when "Fan" 
under "Camera Link" is set to "On" or 
"Fan Stop" is set to "On".

•	 The fan does not stop if the temperature inside the main unit is high. 
Configure settings after the internal temperature has lowered.

•	 The fan may not stop in some conditions, for example when used at a 
high temperature. Use the video display at the operating temperature 	
( 109) or lower.

92	

103

Loud fan noise •	 The fan operates at a faster speed than usual to lower the internal 
temperature if "Fan Control" is set to "On" and when the temperature 
inside the main unit has increased. The fan operates at normal speed 
when "Fan Control" is set to "Off".

•	 When high-luminance content is displayed continuously, the temperature 
inside the main unit rises even if the operating temperature is within 
the recommended range, and the fan operates at a faster speed than 
usual to lower the internal temperature. It is recommended to lower the 
brightness of the video display.

103

You forgot the password for "Protect 
Settings".

•	 Press the jog dial and the  button while the video display is in standby. 
The configuration will be reset to the state where no password is set.

12

The video display does not start up in the 
condition that the power was turned off 
last time.

•	 Check the "Power on Setting" on the OSD menu. Set "Last memory" 
to start up the video display in the condition that the power is turned off 
last time.

105

The image quality for the User mode in 
"Picture Mode" differs from the image 
quality of presets.

•	 Select the preset mode by "Copy Picture Mode" and copy the settings. 60

Image quality on the left and right screens 
is different.

•	 Check the "Channel Settings" → "Picture Mode" settings. 26

67

Image quality is automatically changed.

The same image is displayed in two 
screens.

•	 Check the "Channel Settings" → "Single Input Dual View" settings. 68
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Software Used in This Product
Software installed with this product includes software modules from Canon or third parties.

Software Developed by Canon and Free Software

Software developed or created by Canon and accompanying document is protected by copyright law, terms of an 
international convention and any other governing laws.
This product uses software modules under copyright by third parties and distributed as free software. Some of these 
software modules are subject to the GNU General Public License v2 (GPL), GNU Lesser General Public License v2.1 
(LGPL) or any other license.

Free software modules installed with this product

• linux kernel	 • busybox	 • glibc	 • JFFS2 
• SquashFS	 • FUSE	 • libfuse	 • libupnp 
• avahi-autoipd	 • libxml	 • zlib	 • libpng
• Newlib(libc)	 • Newlib(libm)	 • wireless_tools	 • wpa_supplicant
• openssl	 • libnl	 • RealTek_WiFi_linux driver
• dhcpd	 • hostapd

Acquiring Source Code for Free Software

Some free software requires the acquirement of the source code of modules in order to distribute the executable form 
of those software modules. For information on how to acquire the source code for free software such as these and 
confirming terms of the GPL, LGPL and other license agreements, please check with the distributor from whom the 
product was purchased.

License Agreement for this Product

Obligation to Present License Agreement

The copyright holders of software modules installed with this product require its license agreement to be displayed. 
This license agreement is as follows:

■libupnp License

Copyright (c) 2000-2003 Intel Corporation All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

*	 Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 

*	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution. 

*	 Neither name of Intel Corporation nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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■libxml License

Copyright (C) 1998-2003 Daniel Veillard.  All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT.  IN NO EVENT SHALL THE DANIEL VEILLARD BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR 
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of Daniel Veillard shall not be used in advertising or otherwise to promote 
the sale, use or other dealings in this Software without prior written authorization from him.

■Newlib(libc) License

Copyright (c) 1990 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this 
paragraph are duplicated in all such forms and that any documentation, and other materials related to such distribution 
and use acknowledge that the software was developed by the University of California, Berkeley.  The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.

Copyright (c) 1991, 2000 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:
1. ‌�Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.

2. ‌�Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

3. ‌�All advertising materials mentioning features or use of this software must display the following acknowledgement: 
          ‌�This product includes software developed by the University of California, Berkeley and its contributors.
4. ‌�Neither the name of the University nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE REGENTS 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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■Newlib(libm) License

Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunPro, a Sun Microsystems, Inc. business.
Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is preserved.

■openssl

Copyright (C) 1998-2017 The OpenSSL Project.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:
1. ‌�Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 

2. ‌�Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

3. ‌�All advertising materials mentioning features or use of this software must display the following acknowledgment:
          ‌�"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.  (http://

www.openssl.org/)"
4. ‌�The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived 
from this software without prior written permission.  For written permission, please contact openssl-core@openssl.
org.

5. ‌�Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names 
without prior written permission of the OpenSSL Project.

6. ‌�Redistributions of any form whatsoever must retain the following acknowledgment:
          ‌�"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.

openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT 
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to.  The 
following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the 
SSL code.  The SSL documentation included with this distribution is covered by the same copyright terms except that 
the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.  If this package 
is used in a product, Eric Young should be given attribution as the author of the parts of the library used.  This can be 
in the form of a textual message at program startup or in documentation (online or textual) provided with the package.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:
1. ‌�Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. ‌�Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

3. ‌�All advertising materials mentioning features or use of this software must display the following acknowledgement:
          ‌�"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" 	

The word 'cryptographic' can be left out if the rouines from the library being used are not cryptographic related :-).
4. ‌�If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you 
must include an acknowledgement:

          ‌�"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed.  i.e. 
this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

■wpa_supplicant, hostapd

Copyright (C) 2002-2016, Jouni Malinen <j@w1.fi> and contributors
All Rights Reserved.

This software may be distributed, used, and modified under the terms of BSD license:

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:

1. ‌�Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.

2. ‌�Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

3. ‌�Neither the name(s) of the above-listed copyright holder(s) nor the names of its contributors may be used to endorse 
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

 Copyright (c) 2004-2014 by Internet Systems Consortium, Inc. ("ISC")
 Copyright (c) 1995-2003 by Internet Software Consortium

 Permission to use, copy, modify, and distribute this software for any
 purpose with or without fee is hereby granted, provided that the above
 copyright notice and this permission notice appear in all copies.
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 THE SOFTWARE IS PROVIDED "AS IS" AND ISC DISCLAIMS ALL WARRANTIES
 WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS.  IN NO EVENT SHALL ISC BE LIABLE FOR
 ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
 WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN
 ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT
 OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

   Internet Systems Consortium, Inc.
   950 Charter Street
   Redwood City, CA 94063
   <info@isc.org>
   https://www.isc.org/
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Index
Number

2 Sample Interleave.................................................... 65

3G-SDI RAW.............................................................. 64

200% (Screen Scaling)............................................... 71

2020 Constant Luminance......................................... 58

2020 Gamut Mapping................................................ 58

2020 Outside of Gamut View...................................... 96

A

ACESproxy................................................................. 49

Adjustment................................................................. 49

Adobe RGB................................................................ 49

Anamorphic.......................................................... 71, 92

Anchor Adjustment............................................... 25, 60

Area Marker................................................................ 79

Area Marker (Camera Link)......................................... 92

Aspect Marker............................................................ 76

Audio Input................................................................. 66

Audio Level Meter....................................................... 82

Audio Settings............................................................ 75

Automatic Adjustment (ARRI)...................................... 91

Automatic Adjustment (CINEMA EOS)........................ 90

Automatic Adjustment (VARICAM).............................. 91

B

Background Color...................................................... 74

Backlight Control (Adjustement).................................. 49

Backlight Control (Compatible Settings).................... 104

Banner..................................................................... 102

Bias R/G/B................................................................. 50

Bicubic....................................................................... 72

Black (Test Pattern)..................................................... 88

Blue Off...................................................................... 96

Blue Only.................................................................... 96

Brightness.................................................................. 49

Button Name Lighting Time...................................... 103

C

Calibration............................................................ 27, 59

Camera Information.................................................... 92

Camera Link............................................................... 90

Canon Log, CanonLog 2, Canon Log 3...................... 51

CDL Export/CDL Import............................................. 31

CDL/User LUT............................................................ 56

CDL/User LUT Bypass............................................... 56

Center Marker............................................................ 80

Channel Name............................................................ 67

Channel Settings........................................................ 64

Chroma...................................................................... 49

CINEMA EOS SYSTEM (Picture Mode)....................... 49

Cinema Gamut to 709................................................ 50

Cinema Gamut to 2020.............................................. 50

Cinema Gamut to DCI................................................ 50

Color Bars (Test Pattern)............................................. 88

Color Gamut............................................................... 50

Color Range....................................................... 55, 104

Color Temperature...................................................... 50

Compare View............................................................ 97

Compatible Settings................................................. 104

Contrast..................................................................... 49

Copy Picture Mode..................................................... 60

Custom (xy) (Color Temperature)................................. 50

D

Date/Time.......................................................... 31, 101

DCI-P3....................................................................... 49

DCI-P3+ to 709.......................................................... 50

DCI-P3+ to DCI.......................................................... 50

Detail Settings

Adjustment............................................................. 57

CDL/User LUT........................................................ 56

Display Button LED.................................................. 103

Display Channel........................................................ 101

Display Function/Display Function (CDL)................... 101

Display Name..................................................... 32, 102

Display Setting Link.................................................. 100

Display Settings.......................................................... 71

Dual Input................................................................... 64

Dual Link 3G-SDI........................................................ 65

E

EBU............................................................................ 49

Export/Import..................................................... 30, 104

F

False Color................................................................. 94

Fan (Camera Link)...................................................... 92

Fan Settings............................................................. 103
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USA

    CANON PROFESSIONAL DISPLAY LIMITED WARRANTY FOR PRODUCTS PURCHASED 
    IN THE UNITED STATES

The limited warranty set forth below is given by Canon U.S.A., Inc. ('Canon USA') with respect to Canon Professional 
Display Equipment (the 'Equipment') accompanying this limited warranty in the Equipment’s original container, when 
purchased in the United States. This limited warranty is only effective upon presentation of your Bill of Sale or other 
proof of purchase. 
Canon USA warrants to the original end-user purchaser, when delivered in new condition in its original container, that 
the Equipment will be free from defects in materials and workmanship under normal use and service for a period of 
ONE-YEAR from the date of original purchase. When returning Equipment under this warranty, you must pre-pay 
the shipping charges, and you must enclose a copy of the Bill of Sale or other proof of purchase with a complete 
explanation of the problem. Equipment returned to a Canon USA factory service facility, and proven to be defective 
upon inspection, will be, without charge,:
(a) repaired utilizing new or comparable refurbished parts, or
(b) exchanged for refurbished or new Equipment
as determined in the Canon USA’s repair facility’s sole discretion. The repaired or exchanged Equipment will be shipped 
back free of charge. Warranty exchange or replacement does not extend the original warranty period of the Equipment. 
For repairs after the warranty period has expired, an estimate of the cost of repair and an opportunity to approve or 
reject the repair expense before it is incurred will be provided. If you approve, repairs will be made and the Equipment 
will be returned at your risk and expense. If you reject, the Equipment will be returned to you at no charge to you to an 
address within the United States.

This limited warranty only applies if the Equipment is used in conjunction with compatible computer 
equipment, compatible peripheral equipment and compatible software, as to which items Canon USA will 
have no responsibility. Canon USA shall have no responsibility under this limited warranty for use of the 
Equipment in conjunction with incompatible peripheral equipment and/or incompatible software. Non-
Canon brand peripheral equipment and software which may be distributed with, or be factory loaded on, 
the Equipment, are sold 'AS IS' without warranty of any kind by Canon USA, including any implied warranty 
regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such non-
Canon brand items is given by the manufacturer or producer thereof. If the Equipment contains a hard disk 
drive, Canon USA recommends that data stored on that drive be duplicated or backed up to prevent its loss 
in the event of failure or other malfunction of such drive.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the 
Equipment or contact the CANON INFORMATION CENTER AT 855-4K-CANON (855-452-2666) or on the internet at 
pro.usa.canon.com/support. You will be directed to the nearest service facility for your Equipment.

Technical support program specifics subject to change without notice.

This Limited Warranty covers all defects encountered in normal use of the Equipment and does not apply in the 
following cases:

A.	 Loss or damage to the Equipment due to abuse, neglect, mishandling, electric current fluctuation, accident, 	
	 improper maintenance, use of non-Canon accessories or failure to follow operating, maintenance or 	
	 environmental instructions prescribed in Canon USA’s user’s manual;
B.	 If the Equipment is defective as a result of sand, dirt or water damage;
C.	 If defects or damages are caused by the use of parts or supplies (other than those sold by Canon USA) that 	 	
	 cause damage to the Equipment or that cause abnormally frequent service calls or service problems;
D.	 If defects or damages are caused by service other than Canon USA's factory service centers or authorized 	 	
	 service facilities;
E.	 Any internal modification to product hardware or firmware;
F.	 Any maintenance of the Equipment, including any fees for such Maintenance;
G.	 If the Equipment has had its serial number or dating altered or removed.
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This Limited Warranty does not apply to Equipment purchased outside the United States. This Limited Warranty does 
not apply to accessories or consumables for the Equipment, which are sold “AS IS”, without warranty of any kind by 
Canon USA. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This card 
ensures that you are contacted promptly should there be a safety inspection, modification or product recall under 
applicable laws or regulations.This card ensures that you are contacted promptly should there be a safety inspection, 
modification or product recall under applicable laws or regulations.

NO IMPLIED WARRANTY, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
APPLIES TO THIS EQUIPMENT AFTER THE APPLICABLE PERIOD OF EXPRESS WARRANTY OR 
GUARANTY UNDER THIS WARRANTY (EXCEPT AS MENTIONED ABOVE).  (SOME STATES DO NOT 
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU). CANON USA SHALL NOT BE LIABLE FOR LOSS OF REVENUES 
OR PROFITS, EXPENSE FOR SUBSTITUTE EQUIPMENT OR SERVICE, STORAGE CHARGES, LOSS OR 
CORRUPTION OF DATA, INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED 
ON THE EQUIPMENT’S HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE EQUIPMENT, REGARDLESS OF THE 
LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON USA BE 
GREATER THAN THE PURCHASE PRICE OF THE EQUIPMENT SOLD BY CANON USA AND CAUSING THE 
ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR 
LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY 
ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE EQUIPMENT NOT CAUSED DIRECTLY BY 
THE NEGLIGENCE OF CANON USA (SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).
THIS WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THIS 
EQUIPMENT OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

CANON U.S.A., INC
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CANADA

    CANON PROFESSIONAL DISPLAY LIMITED WARRANTY FOR PRODUCTS PURCHASED IN  
    CANADA

The limited warranty set forth below is given by Canon Canada Inc. ('Canon Canada') with respect to Canon 
Professional Display Equipment (the 'Equipment') accompanying this limited warranty in the Equipment’s original 
container, when purchased in Canada. This limited warranty is only effective upon presentation of your bill of sale or 
other proof of purchase. 
Canon Canada warrants to the original end-user purchaser, when delivered in new condition in its original container, 
that the Equipment will be free from defects in materials and workmanship under normal use and service for a period 
of ONE YEAR from the date of original purchase. When returning Equipment under this limited warranty, you must pre-
pay the shipping charges, and you must enclose a copy of the bill of sale or other proof of purchase with a complete 
explanation of the problem. Equipment returned to a Canon Canada factory service facility and proven to be defective 
upon inspection will be, without charge:
(a) repaired utilizing new or comparable refurbished parts, or
(b) exchanged for refurbished or new Equipment,
as determined by the Canon Canada factory service center, in its sole discretion. The repaired or exchanged Equipment 
will be shipped back free of charge. Warranty exchange or replacement does not extend the original warranty period of 
the Equipment. For repairs after the warranty period has expired, an estimate of the cost of repair and an opportunity 
to approve or reject the repair expense before it is incurred will be provided. If you approve the proposed repairs, 
repairs will be made and the Equipment will be returned at your risk and expense. If you reject the proposed repairs, 
the Equipment will be returned to you at no charge to you to an address within Canada.

This limited warranty only applies if the Equipment is used in conjunction with compatible computer 
equipment, compatible peripheral equipment and compatible software, as to which items Canon Canada 
will have no responsibility. Canon Canada shall have no responsibility under this limited warranty for use 
of the Equipment in conjunction with incompatible computer equipment, peripheral equipment and/or 
incompatible software. Non-Canon brand peripheral equipment and software which may be distributed 
with, or be factory loaded on, the Equipment, are sold 'AS IS' without warranty or condition of any kind 
by Canon Canada, including any implied warranty or condition regarding merchantability or fitness for 
a particular purpose. The sole warranty with respect to such non-Canon brand items is given by the 
manufacturer or producer thereof. If the Equipment contains a hard disk drive, Canon Canada recommends 
that data stored on that drive be duplicated or backed up to prevent its loss in the event of failure or other 
malfunction of such drive.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the 
Equipment or contact the CANON INFORMATION CENTER at 800-667-2666 or on the internet at www.canon.ca/
pro. 

Technical support program specifics are subject to change without notice.

This limited warranty covers all defects encountered in normal use of the Equipment and does not apply in the following 
cases:
A.	 Loss or damage to the Equipment due to abuse, neglect, mishandling, electric current fluctuation, accident, 
	 improper maintenance, use of non-Canon accessories or failure to follow operating, maintenance or 	 	
	 environmental instructions prescribed in Canon Canada’s users manual;
B.	 If the Equipment is defective as a result of sand, dirt or water damage;
C.	 If defects or damages are caused by the use of parts or supplies (other than those sold by Canon Canada) that 
	 cause damage to the Equipment or that cause abnormally frequent service calls or service problems
D.	 If defects or damages are caused by service other than Canon Canada's factory service centers or authorized 	 	
	 service facilities;
E.	 Any internal modification to product hardware or firmware;
F.	 Any maintenance of the Equipment, including any fees for such maintenance; or
G.	 If the Equipment has had its serial number or dating altered or removed.
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This limited warranty does not apply to Equipment purchased outside Canada. This limited warranty does not apply to 
accessories or consumables for the Equipment, which are sold “AS IS”, without warranty or condition of any kind by 
Canon Canada. Please retain this warranty card and your bill of sale or other proof of purchase as a permanent record 
of your purchase. This card ensures that you are contacted promptly should there be a safety inspection, modification 
or product recall under applicable laws or regulations.

NO IMPLIED WARRANTY OR CONDITION, INCLUDING IN RESPECT OF THE MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, APPLIES TO THIS EQUIPMENT AFTER THE EXPIRATION OF 
THE APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTEE UNDER THIS LIMITED WARRANTY 
(EXCEPT AS MENTIONED ABOVE).  (SOME PROVINCES DO NOT ALLOW LIMITATIONS ON HOW LONG 
AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU). CANON CANADA SHALL NOT BE LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE 
FOR SUBSTITUTE EQUIPMENT OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION OF DATA, 
INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE EQUIPMENT’S 
HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY 
THE USE, MISUSE OR INABILITY TO USE THE EQUIPMENT, REGARDLESS OF THE LEGAL THEORY ON 
WHICH THE CLAIM IS BASED, AND EVEN IF CANON CANADA HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON CANADA BE GREATER 
THAN THE PURCHASE PRICE OF THE EQUIPMENT SOLD BY CANON CANADA AND CAUSING THE 
ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR 
LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY 
ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE EQUIPMENT NOT CAUSED DIRECTLY BY THE 
NEGLIGENCE OF CANON CANADA (SOME PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).
THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER 
OF THIS EQUIPMENT OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This limited warranty gives you specific legal rights, and you may also have other rights which vary from province to 
province.

CANON CANADA INC.
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